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INTRODUCTION

Welcome to the Blackbaud FundWare™ accounting application family. FundWare is the 
leading fund accounting software designed in accordance with the most widely accepted 
accounting principles. It is flexible enough to meet your needs without major changes to 
your current accounting systems.
This guide provides instructions for administration tasks that apply to your main 
FundWare system, such as:

• Defining security settings for your users,
• Maintaining your divisions, and
• Performing file maintenance.

This guide also includes importing instructions for each module. 

THE BLACKBAUD FUNDWARE SUITE OF PRODUCTS
Blackbaud FundWare is a Windows-based software application offering a suite of 
modules and features that can be integrated and combined to provide a complete 
solution for your organization (Table 1.1). 

Table 1.1—Blackbaud FundWare Modules and Features

Module/Feature Description

Accounts Payable Provides all of the features you’d expect in a robust, world-class AP package: 
vendor information, payment scheduling, requisition management, integrated 
purchase orders, bank account records, check writing and more. The key to 
AP is its workflow approach to payables management. Each transaction is 
assigned a “stage” which is used to move the obligation through the payables 
cycle until the actual check is written and reconciled. 
Blackbaud, Inc. 1



Blackbaud FundWare System Administration Guide

2

Accounts Receivable Creates, processes, manages, and reports on your organization’s invoices 
and receipts. It records funds deposited to the General Ledger–Project/Grant, 
distributes revenue to multiple funds and/or departments, and posts in 
summary or detail, based on journal settings that you establish. (Note: 
Accounts Receivable module includes Cash Receipts.)

Advanced Financial 
Reporting

Designed as an addition to General Ledger–Project/Grant, AFR offers:
• Multiple levels of detail in the same report, including account summaries 

and/or detailed transactions.
• The ability to specify exactly which accounts appear in a column or row, 

including accounts that are not consecutive in their numbering, or accounts 
that have different attributes.

• Total control over report presentation, including headers, formatting, and 
spacing.

• The ability to filter a column or row by journal and/or by attribute.

Advanced Security Designed as an addition to the system’s basic security, Advanced Security 
allows you to restrict access for your users based on specific segments of 
your account number or account attributes, or based on group assignments.

Allocation 
Management

Integrates with General Ledger–Project/Grant to maximize your cost recovery 
against grants and contracts. Automates the processes of allocating revenue 
earned for pooled investments.

Bank Reconciliation Allows you to balance your bank statements to your transactions in Accounts 
Payable, Accounts Receivable/Cash Receipts, Payroll/Personnel, and 
General Ledger. You import transactions to Bank Reconciliation, complete the 
reconciliation process, then post the reconciled transactions back to their 
originating modules.

Budget Control Works with your General Ledger accounts to monitor the budget on an annual 
(i.e., fiscal year) basis and/or period basis. When you post transactions that 
surpass the budgeted amount for the account, Budget Control compares the 
account total to the budgeted amount and informs you when you approach or 
pass any of the three defined budget levels.

Budget Forecasting Provides you with a “work-area” for creating budget amounts. The system 
pulls actual account amounts from GL–P/G into Budget Forecasting. You can 
then manipulate, change, and update these numbers until your organization 
reaches agreement on what the final budget should be. Once the budget is 
complete, you post the budget amounts to GL–P/G via a budget journal.

Table 1.1—Blackbaud FundWare Modules and Features (Continued)

Module/Feature Description
The BLackbaud FundWare Suite of Products 
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Budget Preparation Provides the tools to manage your budgeting process, from initial set up to 
final posting of budget amounts to General Ledger–Project/Grant. Use this 
module to set up multiple budget cycles (i.e., budget scenarios); create budget 
workbooks and worksheets; calculate costs, revenues, and expenses; export 
and import from Microsoft Excel, and post the budget to General 
Ledger–Project/Grant. 

Cash Receipts Creates, processes, manages, and reports on your organizations cash 
receipts. It records funds deposited to the General Ledger–Project/Grant, 
distributes revenue to multiple funds and/or departments, and posts in 
summary or detail, based on journal settings that you establish.

Financial Institutions The Financial Institutions feature allows you to define bank accounts for 
existing FundWare modules using a central dialog. 

Fixed Assets Asset management and control module that allows you to track an asset 
through its full life-cycle (acquisition, depreciation, and disposal). Fixed Assets 
can post asset transactions to General Ledger–Project/Grant. You can also 
choose to use Fixed Assets without posting transactions to General 
Ledger–Project/Grant.

General 
Ledger–Project/Grant

Provides seamless connectivity with other FundWare modules, as well as the 
most popular third-party programs, giving you a complete, centralized 
financial management tool. Allows you to define an account structure that 
meets the specific reporting needs of your organization, and provides multi-
year reporting, online budget control, advanced security, more than 60 
standard reports, and unlimited user-defined reports.

iData Analysis and reporting tool offered for the FundWare Enterprise Edition. 
Delivers quick access to your financial data without the need for deciphering 
complicated data dictionaries. Allows you to create reports from well-
organized Smart Views, which conform to your unique system configuration 
and allow you to report across divisions. 

Payroll/Personnel Provides detailed cost accounting so that each employee’s efforts are tied to 
the appropriate grant, program or cost center. Labor costs can be distributed 
by percentage, time sheet cost codes, and a number of other flexible 
methods. Offers robust, yet simple functionality for W-2s, direct deposit, and 
taxes. Allows you to track employee data and benefits, including non-taxable 
retirement plans, cafeteria-style benefits and deferred compensation plans.

Table 1.1—Blackbaud FundWare Modules and Features (Continued)

Module/Feature Description
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UNDERSTANDING THE DATABASE STRUCTURE
The core database is a central set of data files that define rules and capture and store data 
for the General Ledger–Project/Grant modules. Within the core database, FundWare 
stores your information in five areas (“ledgers”):

• The general, or actual, ledger maintains account balances for standard reporting. 
• The budget type 1 and 2 ledgers record and report budget information. We offer 

two budget options to allow you to track an original budget and any changes to 
that budget (e.g., GASB reporting).

• The encumbrance ledger allows accounts to be encumbered for purchases 
ordered but not yet received. 

• The commitment ledger allows accounts to be allocated for purchases not yet 
encumbered.

SUPPORT FILES
The FundWare Installation/Upgrade CD includes some files and instructions that can 
help you maintain your FundWare system. Please review the folders and files stored in 
the Support folder of the CD.

SOME FUNDWARE BASICS
The following sections provide you information and instructions for opening and 
working in FundWare.

OPENING FUNDWARE

As you begin using FundWare, certain information is saved by the program and offered 
as a default. This has been designed to help you save time and steps, but you can change 
these defaults at any time by entering new information or selecting from the available 
options (depending on the field).

• User name—The program will enter the user name (or user number) of the last 
person to log into FundWare on that computer.
— For security reasons, your password is not automatically entered. You must 

always enter your FundWare password.
Understanding the Database Structure 
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• Business date—Defaults to the current system date (according to your 
computer’s operating system).

• Division—The program automatically selects the division you were working in 
the last time you were in FundWare. 
— If you have only one division (or have security rights to only one division) 

and do not have security rights to the System Administration area, the 
program will bypass the division selection window. 

— Or, if you only have security rights to the System Administration area, the 
program will bypass the division selection window and open directly to the 
System Administration HomePage.

• HomePage—The program automatically opens to the HomePage of the module 
in which you were working the last time you were in FundWare. 

Use the following instructions to open and log into FundWare.
1.  Double-click the FundWare icon on your desktop or select Blackbaud 

FundWare® Enterprise or Professional from your Windows Start menu. The 
Login window displays. 

Figure 1.1—FundWare Login Window

2. Enter your user name in the User Name text box. You can enter your user 
number instead of your user name, if preferred. 

The User Name field will default to the last entry on this computer and 
the system will move to the Password field.

3. Enter your password in the Password text box. Your password entries will 
display as asterisks (*) as you type to maintain the privacy of your password. 
Blackbaud, Inc. 5
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4. Accept the default business date or enter a new date. You can manually enter the 
date (moving from day to month to year using the arrow key or mouse) or you 
can click the down-arrow to select a date from the calendar.

Figure 1.2—Selecting the Date

5. Click OK. If your User Name, Password, and Business Date are verified, the 
Select Division window displays, defaulting to the division you were working 
with the last time you were in FundWare. 

Figure 1.3—Selecting the Division

If your organization uses the password aging feature, you may receive a 
message indicating that your password will or has expired. You will be 
offered the chance to enter a new password at this time. See Changing 
Your Password During Login on page 7.

If you have only one division (or have security rights to only one 
division) and do not have security rights to System Administration, the 
program will bypass the Select Division window. Or, if you only have 
Some FundWare Basics 
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security rights to System Administration, the program will bypass the 
division selection window and open directly to the System 
Administration HomePage.

6. If necessary, select a different division (or System Administration) from the list. 

7. Click OK. FundWare opens to the HomePage of the module that you last 
accessed.

For users upgrading from earlier versions of FundWare, please note that you can only 
have one division open at a time in each instance of FundWare (a change in 
functionality). However, you can open the program multiple times for the same or 
different divisions and/or business dates.

CHANGING YOUR PASSWORD DURING LOGIN

If your organization uses the password aging feature (defined through System 
Administration), you may receive a message indicating that your password will or has 
expired. 

Figure 1.4—Password Expiring

Use the following instructions to change the password at this time.
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1.  Click Yes to the password expiration message. The Change Password window 
displays. 

Figure 1.5—Changing Your Password During Login 

2. Enter your password in the Old Password text box.

3. Enter the new password in the New Password text box.

4. Retype your password in the Confirm New Password text box.

5. Click OK. Your password is changed. The next time you log into FundWare, 
you must use the new password or you will receive an error message.

You can also change your password from within the software. See Changing Your 
Password From the Software on page 11.

OPENING FUNDWARE MULTIPLE TIMES

Each “instance” of FundWare (i.e., each time you open the program) represents a single 
division on a single business date. However, you can open as many instances of 
FundWare as necessary to meet your needs. 
When dealing with multiple instances of FundWare, keep the following rules in mind:

• Each instance of FundWare represents a single user, division, and business date, 
or represents access to the System Administration features by a single user. 

• You can open as many instances of FundWare as necessary (i.e., for different 
users, business dates, or divisions).
Some FundWare Basics 
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• You can still change the business date for the current instance of FundWare 
without opening a new instance. See Changing the Business Date on page 10 
for more information.

OPENING ADDITIONAL INSTANCES—FROM THE DESKTOP/START MENU

If you have one or more instances of FundWare open already, you can open additional 
instances of the program from your desktop or the Windows Start menu. You will be 
asked to identify the user, password, business date, and division (the same steps as 
opening the first instance of FundWare).

OPENING ADDITIONAL INSTANCES—FROM THE PROGRAM

You can also open a new division or a new instance of the same division from within 
FundWare. Because you are opening this division from the program, the system applies 
the same user and password to the new instance and allows you to select a new division 
or business date.

If you want to open a new instance of FundWare for a new division or a new 
business date, you can open the program from the desktop or Windows Start 
menu or from the Change Business Date task. For instructions on changing the 
business date, or opening a second instance of the program with a different 
business date, see Changing the Business Date on page 10.

Use the following instructions to open a new instance of FundWare for the current user 
and business date.

1.  Select File > Open FundWare from the menu bar. The Open New Instance 
window displays, automatically selecting the division you were working with 
the last time you were in FundWare. 

Figure 1.6—Opening a New Instance of FundWare

2. If necessary, select a different division (or System Administration) from the list. 
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3. Accept the default business date or enter a new date. You can manually enter the 
date (moving from day to month to year using the arrow key or mouse) or you 
can click the down-arrow to select a date from the calendar.

4. Click OK. FundWare opens to the HomePage of the module that you last 
accessed.

CHANGING THE BUSINESS DATE

You can change the business date for your current instance of FundWare or open a new 
instance of the same division with a different business date using the Change Business 
Date task. When you choose to open a new instance of the same division, the system 
applies the same user and password to the new instance and takes you directly to the 
HomePage for the module in which you were last working in that division.

1.  Select Edit > Change Business Date from the menu bar. The Change Business 
Date window displays. 

Figure 1.7—Changing the Business Date 

1 Accept the default business date or enter a new date. You can manually enter the 
date (moving from day to month to year using the arrow key or mouse) or you can 
click the down-arrow to select a date from the calendar.

2 Select the applicable option for applying the new business date:
• Current Instance of FundWare—Changes the business date for the current 

instance of FundWare. This option does not apply any changes to other 
instances of FundWare and does not open a new instance of the program.

The “Classic” windows will not accept a changed business date. If you 
have any of the Classic screens open when you attempt to change the 
business date for the current instance of FundWare, the system will 
return a message and not allow you to proceed. Close the Classic 
windows and try again.
Some FundWare Basics 
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• New Instance of FundWare—Opens a new instance of FundWare to the 
HomePage for the module in which you were last working, applying the 
same user, password, and division but using the new business date.

1.  Click OK. The program applies your selection.

CHANGING YOUR PASSWORD FROM THE SOFTWARE

Use the following instructions to change the password for the current user.
1.  Select Edit > Password from the menu bar. The Change Password window 

displays. 

Figure 1.8—Changing the Current User’s Password

2. Enter your password in the Old Password text box.

3. Enter the new password in the New Password text box.

4. Retype your password in the Confirm New Password text box.

5. Click OK. Your password is changed. The next time you log into FundWare, 
you must use the new password or you will receive an error message.

If your organization uses the password aging feature (defined through System 
Administration) and your password is nearing or has passed the expiration date, you can 
also change your password during the login process. See Changing Your Password 
During Login on page 7.
Blackbaud, Inc. 11
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USING THE MENU BAR

Each module for which your organization is licensed and to which you have security 
rights displays in the menu bar. From these menu options, you can access all module-
specific tasks (e.g., General Ledger > Journal Entries > New). In addition, you will 
use the menu bar to access specific program tasks (e.g., changing the business date):

• File—Open divisions; access Print Manager, Report Manager, or Financial 
Institutions.

• Edit—Change the business date or your password.
• View—View or close Navigator bar; view full or abbreviated menu names; 

view logged in users.
• Window—See all currently open windows, switch between these windows.
• Help—Access online help for the current module and program information. 

KEYBOARD NAVIGATION

To help you navigate quickly through the program, FundWare allows you to use your 
keyboard instead of your mouse to access program tasks.

• Menu bar—You can access any task listed on the menus using a combination of 
the ALT key and a letter and the arrow keys.
— Press the ALT key.
— Press the underlined letter of the item to display the menu. The menu 

displays.
— Use the arrow key and press ENTER to select a task.

• Shortcut menus—Access any applicable shortcut menus (normally displayed 
when you right-click your mouse) from the keyboard by pressing either 
SHIFT+F10 or the Application key (offered on many newer keyboards, located 
between the WINDOWS key and the CTRL key, to the right of the spacebar).

• Shortcut keys—Shortcut keys combine the CTRL key with a letter to give you 
direct access to certain tasks. These shortcuts are listed on the menus with the 
applicable tasks. 

• Drop-down lists—You can access any drop-down list when focus is on the 
associated field by using a combination of the ALT key and the down arrow key. 
Some FundWare Basics 



Chapter 1—Introduction
IS YOUR MENU BAR TOO CROWDED?

If your organization is licensed for a number of FundWare modules, your menu bar may 
be too wide to use conveniently. You can change the module names that are listed in the 
menu bar to display as acronyms, which will decrease the width of the bar:

• Select View > Abbreviated Menu Names from the menu bar. To change back, 
select View > Full Menu Names from the menu bar.

HOW YOUR SECURITY RIGHTS IMPACT THE MENU BAR

Your individual security rights may impact the modules and tasks that you see on the 
menu bar. 

• If your organization is licensed for a module, but your individual security 
settings do not allow you to access any tasks in that module, the module will not 
be listed in the menu bar.

• If your security settings allow you to access some, but not all, tasks in a module, 
the restricted tasks will not be listed in the menu bar.

USING THE NAVIGATOR BAR

The Navigator bar provides you with quick, mouse-driven access to your modules, 
module tasks, and currently open windows through two areas:

• Module navigator, and
• Open windows navigator.

You can resize the Navigator bar to meet the needs of your display by using your mouse 
to click on the right frame of the bar and drag the frame to the position you want. You 
can also hide or show the Navigator bar using the options on the View menu. Select the 
option to hide or show the bar, as applicable. These settings will be retained by the 
system when you close FundWare.

MODULE NAVIGATOR

The module navigator lists the modules for which your organization is licensed (unless 
your individual security settings do not allow you to access a module). When you click a 
module (it just takes a single click), the module expands to display all of the associated 
module tasks. 
Blackbaud, Inc. 13
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Accessing any of the tasks within the module takes another single click on the specific 
item. Some tasks are “nested” below a title. A single click will expand the title, 
displaying the related tasks below. 

Figure 1.9—Module Navigator—Expanded Menus

If your security settings restrict your access to specific tasks, those tasks will not 
be listed in the menu bar. 
Some FundWare Basics 
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OPEN WINDOWS NAVIGATOR

The open windows navigator lists the windows that are currently open in this instance of 
FundWare, highlighting the window currently displayed. A single click of an entry in 
the open windows navigator redisplays the window in your workspace. 

Figure 1.10—Open Windows Navigator

As with all Windows applications, the more FundWare windows that you open 
concurrently, the greater impact to your processor speed. You can use the Open 
Windows Navigator to monitor how many windows you have open at any one 
time.

HOW YOUR SECURITY RIGHTS IMPACT THE NAVIGATOR BAR

There is no security impact to the open windows navigator. If your security rights 
allowed you to open a task, then that window will display in the open windows 
navigator. However, your individual security rights may impact the modules and tasks 
that you see on the module navigator. 

• If your organization is licensed for a module, but your individual security 
settings do not allow you to access any tasks in that module, the module will not 
be listed in the module navigator.

• Any tasks within a module from which you are restricted will not be listed in the 
menu bar. 

CUSTOMIZING YOUR DISPLAY

Throughout FundWare, you will encounter forms (similar to a table or spreadsheet) that 
allow you to customize the display through the shortcut menu (accessed by right-
clicking your mouse) or through direct manipulation with your mouse. Most of these 
settings are retained with your user name. Therefore, the forms display according to 
your settings wherever you log in to FundWare. (In other words, the program 
remembers how the form displayed when you closed FundWare. This is how it will 
display the next time you open the program.)
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Not all forms provide these options. If you attempt one of the customization 
options described here and are unsuccessful, it is likely that the option is not 
offered on that form.

HIDING AND DISPLAYING COLUMNS

To add or remove a column from a form, hover your mouse over the pane and right-
click. A shortcut menu displays, which allows you to hide or display columns from the 
form. 

Figure 1.11—Example Shortcut Menu for the GL New Journal Entry Form

The columns currently displayed in the form are indicated with a check mark. Select a 
column from the shortcut menu to add or remove that column to the detail pane.

If you have disabled fields through the module setup (e.g., the Accounts 
Payable parameter or stage settings), the associated column will not be listed on 
the shortcut menu.

RE-ORDERING THE COLUMNS

To re-order the columns in a form, “drag and drop” the column by clicking the column 
heading and moving the column to the desired position (holding the mouse button 
down).

In this example, the Account column is disabled 
because this column must always display. 

The remaining columns are currently displayed in the 
New Journal Entry form.
Some FundWare Basics 
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RESIZING THE COLUMNS

To resize a column, hover your mouse over the column border until the icon changes. 
Figure 1.12—Mouse Icon

Click your mouse button and drag the column border until it is the desired width.

SORTING THE ENTRIES IN A FORM

To resort the entries in a form, click the heading of the column on which you want the 
sort based. To reverse the sort order, click the column heading again. 

Figure 1.13—Sorting the Detail Pane

Sort order is not retained when you close FundWare.

HELP

If you encounter questions or problems while you are working in the program, you can 
access the online help from the Help menu (on the menu bar) or by clicking F1 to access 
the online help for the current module.

Original display.

Entries resorted 
based on Obligation 
number.

Entry order reversed.
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You can also access PDF files (portable document format) of the guides from your 
server:

• FundWare\Data\User Documentation
You must have Adobe Acrobat Reader installed to view the files. This program is 
available from the FundWare CD or as a free download from www.adobe.com.

TRAINING AND CONSULTING SERVICES

Blackbaud, Inc. offers a number of options to help you improve your use of FundWare.
• Regional classes—Training classes held several times per month in various 

cities across the nation. These one- to five-day classes provide a hands-on 
learning environment and low student-to-instructor ratio.

• eClasses—Interactive training classes offered over the Internet provide you and 
your staff the opportunity to receive training from FundWare experts without 
leaving your desk.

• Onsite custom training sessions and consulting—Our training/consulting group 
offers you onsite services, including:
— Training your staff using your data.
— Installing/upgrading and configuring the software to meet the specific needs 

of your organization.
For more information about any of our training or consulting services, please explore 
our Web site (http://www.blackbaud.com) or contact our Client Sales department (800-
551-4458).

USING THIS DOCUMENT

This manual is organized to reflect the most common uses of the module. It provides 
you with overview information of FundWare, followed by specific features and 
functions of the module.
Some FundWare Basics 
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CONVENTIONS

Use Table 1.2 as a reference for conventions used in this document. 

GETTING SUPPORT

The following table provides a quick reference for getting the support you need for 
FundWare modules.

Table 1.2—Icon Conventions
Indicator Description

A caution or warning that must be heeded. Information contained in a warning should be care
reviewed to avoid adverse affect on software operation.
An example, used to clarify an issue.

ENTER Keyboard directions are indicated in small capital letters (e.g., Press ENTER).
demo user Specific text entries are indicated with italics (e.g., Type demo user for User Name).
Click OK An item on the screen that requires user interface is indicated in bold.

Table 1.3—Getting Support
Department Contact Description

Business 
Office

800-551-4458 Obtain general information or contact a sta
member.

Technical 
Support

800-227-7575
e-mail: FWSupport@blackbaud.com

Get help resolving technical issues with th
product. Please have the following informa
ready when you call:
• Blackbaud Site ID
• FundWare version number
• Error message details

Knowledgebase
www.blackbaud.com

A searchable database where you can typ
your questions and get a list of possible 
answers.
• Requires your license number and Black

Site ID.
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Training 800-551-4458
Ask for the Client Sales department.

www.blackbaud.com

Contact us for more information on our trai
options:
• Regionals—Classes from 1 to 5 days in 

length; held in cities around the country.
• eClasses—Two- to three-hour classes of

over the Internet.
• Onsite custom training and consulting—O

consulting staff can implement FundWar
and/or train your employees using your 
organization’s data.

Product 
Management

www.blackbaud.com Contact our Product Management departm
with any suggestions for improving FundW

All other 
information

www.blackbaud.com Links are available for all other FundWare 
information including replacement software
user guides and software updates.

Blackbaud, Inc.
6430 S. Fiddler’s Green Circle, Suite 200
Greenwood Village, CO 80111
800-551-4458
303-756-3030

Table 1.3—Getting Support (Continued)
Department Contact Description
Some FundWare Basics 
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BLACKBAUD FUNDWARE SYSTEM ADMINISTRATION

The System Administration tasks can encompass all divisions. Therefore, to work with 
these tasks, you must open a separate instance of FundWare (i.e., you cannot have an 
instance of a division open and access these tasks from that instance). Instead, System 
Administration is treated as its own division when you log into the system. 
Once System Administration opens, you can access a number of tasks:

• HomePage—The System Administration HomePage displays each time you 
open System Administration and includes four areas of interest:
— FundWare License and Version Information on page 22,
— Password Aging on page 22, 
— Logged in Users on page 24, and 
— Useful Links on page 25

• Security—Define and maintain your basic security settings (i.e., workgroups 
and users). Because of the complexity of this task, Security instructions are in 
their own chapter (Chapter 3—Defining User Security on page 35 for 
instructions).

• Division maintenance—Define and maintain your divisions. Because of the 
complexity of this task, Division Maintenance instructions are in their own 
chapter (Chapter 4—Maintaining Your Divisions on page 77 for instructions).

• System Utilities—Process error logs and execute programs. See System Utilities 
Tasks on page 31 for more information.

• File information—View field lengths and the record numbers for FundWare 
data files. See Viewing File Information on page 25 for more information.

• Registration management—Review or modify your organization and/or 
registration information. See Maintaining Your Blackbaud FundWare 
Registration on page 28 for more information.
Blackbaud, Inc. 21
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SYSTEM ADMINISTRATION HOMEPAGE
The System Administration HomePage includes four areas of interest:

• License and version information—Provided for your information only, you 
cannot edit this information.

• Password aging—Allows you to define a specific length of time that users’ 
passwords are valid.

• Logged in users—Provided for your information only, you cannot edit this 
information.

• Links—Phone numbers, e-mail addresses, and the FundWare Web address. 
Provided for your information only, you cannot edit this information.

FUNDWARE LICENSE AND VERSION INFORMATION

The license and version information is provided for you information only (Figure 2.1). 
You cannot edit this information. 

Figure 2.1—Example License Information

Refer to this area when you contact the FundWare Support department to 
facilitate a faster resolution.

PASSWORD AGING

The Password Aging feature allows you to determine a specific number of calendar days 
that your users’ passwords are valid. When each user’s password is nearing expiration, a 
warning will display offering the user the opportunity to change their password at that 
time. For more information on changing passwords, see Changing Your Password 
During Login on page 7 and Changing Your Password From the Software on page 11.
Use the following instructions to enable Password Aging.

1.  Open an instance of FundWare.
System Administration HomePage 
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2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Select the Enable Password Aging check box to enable the feature (Figure 2.2). 

Figure 2.2—Password Aging

4. Enter the required number of calendar days for the options, according to the 
following table 

DISABLING THE PASSWORD AGING FEATURE

Use the following instructions to disable (or turn off) Password Aging.
1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays. 

Table 2.1—Password Aging Fields

Field Description

Expiration (days) Enter the number of calendar days that each user’s password will be valid.
• Each time a user changes this password, this system will begin counting 

towards this number.
• When the password has expired, the user will not be able to log into 

FundWare until they change their password.

Warning Message (days) Enter the number of days prior to expiration that a warning message will 
display.
• When a user receives a warning message, he or she is given the 

opportunity to change their password.
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3. Select the Enable Password Aging check box to remove the check box and 
disable the feature (Figure 2.2). 

Figure 2.3—Disabling Password Aging

LOGGED IN USERS

You can view logged in users from two locations in the software:
• The System Administration HomePage (Figure 2.4)—If you have a user that is 

incorrectly listed as logged in to FundWare (e.g., a power outage closed down 
the program but the user is still listed as logged in), click Delete to remove the 
entry. 

Figure 2.4—Logged In Users—System Administration HomePage

• The View > Logged In Users task (Figure 2.5)—Click Refresh to update this 
information (e.g., you have had this window open for a while and users may 
have logged on or off). 

Figure 2.5—Logged In Users—View Task

Even if there are days defined for the Expiration and Warning settings, the feature 
is not in force if there is no check mark in the Enable Password Aging check box.
System Administration HomePage 
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For certain tasks, you may be required to ensure that all users are logged out of the 
software. In these cases, you should check the list of logged in users before proceeding.

Refer to this area when you must complete tasks that require no users logged 
into the system.

USEFUL LINKS

The Useful Links area provides helpful phone numbers, e-mail addresses, and the 
FundWare web address (Figure 2.6). This information is provided for your information 
only. You cannot edit this information. 

Figure 2.6—Useful FundWare Links

VIEWING FILE INFORMATION
The File Information task allows you to view field lengths and the record numbers for 
FundWare data files. Use the following instructions to view file information.

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.
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3. Click File Information on the module navigator or select System 
Administration > File Information from the menu bar. The Workgroup 
summary window displays, showing all workgroups defined for all divisions in 
your system (Figure 2.7). 

Figure 2.7—File Information

4. Complete the required fields according to Table 2.2. 

Table 2.2—File Information Field Definitions

Field Entry Description

Function 1—One file Shows information for one file only.

2—One entire 
division

Displays information for all files in a division. 

3—Wildcard Use a combination of question marks and alphanumeric characters to 
display information for a range of files. 

Division Division 
number

Enter a valid division number. Press F1 to see a list of valid divisions.
• This field is not valid when you select Function option 3—Wildcard.

Single File 3-letter file 
name

Enter a three-letter file name in this field, e.g. CSJ or SYP.
• This field only valid when you select Function option 1—One file.
Viewing File Information 
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5. When you have defined the file information fields, type E to end the entry task 
and display the selected files (Figure 2.8). 

Figure 2.8—Example SYP File Display

6. When complete, press ENTER to end the task and close the window.

File 
Wildcard

File mask Enter a mask for the files you want to display. 
• This field only valid when you select Function option 2—Wildcard.
Data file names begin with a two-digit division number, e.g. 95, and end 
with a three-digit file name, e.g. CSB. For example:
• If you want to see file information for all cost core files in division 95, 

enter the following mask: 95CS?. 
• If you want to see cost core files for all divisions, enter ??CS?.

Audit 
Process

Y
N

Select whether or not you want to generate a report.
• Y—Print audit of process. The generated report also includes the 

number of records in a file.
• N—Don’t audit process
When you’re finished setting the parameters of the search, press E to 
E)nd. FundWare displays the file information, one screen per file. Press 
ENTER to see information for the next file.

Table 2.2—File Information Field Definitions (Continued)

Field Entry Description
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MAINTAINING YOUR BLACKBAUD FUNDWARE REGISTRATION
The Registration Management option of System Administration maintenance allows 
you to:

• Review or modify your organization information—You probably entered 
information about your organization (e.g., name, address) when you installed 
FundWare. This information is displayed here, and you can change it at any 
time. 
— You can also view (but not modify) your FundWare license number.

• Review or modify your registration information—If you add or remove a 
module, you will use information provided by your FundWare sales contact to 
register your changes here.

You must have an Administrator-level security setting to access this feature.

YOUR ORGANIZATION INFORMATION

Use the following steps to review or modify your organization information.
1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.
Maintaining Your Blackbaud FundWare Registration 
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3. Click Registration Management on the module navigator or select System 
Administration > Registration Management from the menu bar. The 
Registration Management window displays, open to the Organization tab 
(Figure 2.9). 

Figure 2.9—Registration Management—Organization Tab

4. Review or modify your information, as necessary.

You cannot modify your license number. 

5. Click Apply to save your changes and remain in the Registration Management 
window, or click OK to save your changes and close the window.

YOUR REGISTRATION INFORMATION

The Registration tab of the Registration Management feature will show those modules 
that are currently registered for your organization. You can also use this feature to add or 
remove modules (with information from your FundWare sales contact).

1.  Open an instance of FundWare.
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2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Registration Management on the module navigator or select System 
Administration > Registration Management from the menu bar. The 
Registration Management window displays, open to the Organization tab 
(Figure 2.9). 

4. Click the Registration tab (Figure 2.10). 

Figure 2.10—Registration Management—Registration Tab

5. If you are adding or removing a module, you should have a new 25-character 
registration key. Enter that number in the text boxes.

6. Click Test New Key. The added and/or removed modules will display below. 

No changes have been made to your system at this point. The changes 
will only be completed when you click Apply or OK.

Note: For security purposes, this figure 
shows a 20-character registration key. 

You will have a 25-character 
registration key.
Maintaining Your Blackbaud FundWare Registration 
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7. If this information is not accurate, click Cancel and contact your FundWare 
sales representative.

If this information is correct, click Apply to save your changes and remain in 
the Registration Management window, or click OK to save your changes and 
close the window.

SYSTEM UTILITIES TASKS
There are two tasks available from the System Utilize menu option (Figure 2.11):

• Process error logs, and 
• Execute programs. 

Figure 2.11—System Utilities

PROCESSING ERROR LOGS

The Process Error Log task appends existing error information to the ERRLOG.WS file 
(found in the FundWare > Data folder). You only need to complete this task if you are 
receiving an “Error Log Exists” message.
Once you have processed the error log, print and review the ERRLOG.WS file. 
Suggestions for resolving common problems can be found on the Web site 
(www.fundware.com), or contact the Support department.
Use the following instructions to process an error log.

1.  Open an instance of FundWare.
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2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 2.12). 

Figure 2.12—System Utilities—Processing the Error Log

4. Click Process Error Log. When the process is complete, a message displays.

5. Click OK. You can view the ERRLOG.WS file through any word processing 
program.
System Utilities Tasks 
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EXECUTING PROGRAMS

There are a number of small programs that allow you to complete specific restricted 
tasks (e.g., defining the system scramble checks). You will use the Execute Programs 
task to run these programs (Figure 2.13). Instructions for these programs appear 
throughout the guides (e.g., because you can scramble AP and Payroll checks, those 
instructions are found in the Accounts Payable and Payroll/Personnel guides). 

Figure 2.13—System Utilities—Execute Program

LICENSE AND DATABASE INFORMATION
If you select Help > About FundWare, the program displays a summary of your 
system (Figure 2.14), including:

• Organization name, address, and phone number (entered during installation),
• License number,
• Registration key,
• Version information,
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• Database (i.e., core) and division backup information. 

Figure 2.14—Example About FundWare

Click the Registered Items button to view the modules for which your organization is 
licensed (Figure 2.15). Click OK to close the display. 

Figure 2.15—Example Registered Items

 

License and Database Information 
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DEFINING USER SECURITY

The FundWare basic security feature uses workgroups and user-specific settings to limit 
user access on a task basis. (For these instructions, a task includes all individual security 
settings, e.g., tasks, AP stages, reports.) For example:

• Joe Miller only works in AP to enter invoices.
— You add him to the Data Entry workgroup, which defines default security 

settings for Joe.
— You customize his security settings to allow him to open only the Accounts 

Payable module.
— Within that module, you allow him to add obligations to stage 30 (i.e., 

invoices). All other AP tasks are denied.
• Jenny Mendoza must create reports for all modules.

— You add her to the Inquiry Only workgroup, which defines default security 
settings for Jenny.

— You customize her security settings in each module to allow her to create 
reports.

— She is denied assess to all other module-specific tasks.

WHAT ARE WORKGROUPS?
Before your users can begin working in the system, you must create workgroups and 
assign each user to at least one workgroup. Workgroups are division-specific templates 
for your security settings. From the workgroup definition, each user is granted default 
security settings. However, you can customize each user’s settings. 
When a user belongs to more than one workgroup, FundWare consolidates the 
workgroup settings to define the user’s default settings (see Assigning a User to 
Multiple Workgroups on page 63). Again, you can always customize a user’s settings 
from the workgroup defaults. 
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ADMINISTRATOR WORKGROUPS

For each division, FundWare creates a workgroup named “Administrator.” This group 
has full rights to all functions, tasks, reports, and stages for all modules in the division. 
This group is designed so that certain users can always access all parts of FundWare.
The following rules apply to the Administrator workgroups:

• One user must always be assigned to each Administrator workgroup. 
• You cannot edit the Administrator workgroup settings.
• You cannot delete the Administrator workgroup.

WHAT ARE USERS?
Each employee who will work in FundWare should have his or her own user record. 
This record defines the specific tasks in each module and each division that the user can 
or cannot access.

DEMO USER

The default FundWare user, Demo User (password: pcfund), has full rights to all 
systems. Use this user name when you first open the program and have yet to define 
your users.
You can modify or delete the Demo User. However, because the system requires at least 
one Administrator-level user at all times, you cannot delete the Demo User until you 
define your own Administrator. For security purposes, we recommend that you change 
the password for the Demo User once you have configured your security system. 

WHAT ARE SECURITY LEVELS?
Earlier versions of the FundWare used security levels (e.g., 0–9) to define a menu-driven 
security setting (e.g., allow a user to access the Maintain Vendors menu). When the 
menu-driven system was replaced by the task-driven system (e.g., allow a user to create 
journal entries), the only use of security levels is to distinguish between administrators 
and users.
What Are Users? 
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• Level 1—Administrators. FundWare will acknowledge any basic security 
settings but ignore Advanced Security settings. Your system must always have 
at least one user defined with level 1 security.

• Level 2—Users. FundWare will acknowledge any basic and advanced security 
settings.

When you define a user, FundWare assigns the user a security level of 1. 

CHANGING A USER’S SECURITY LEVEL

The fields 1–3 of the Classic user security record store information that is either obsolete 
or better maintained in the basic security task (Table 3.1). While you can modify the 
information in fields 1–3, we strongly recommend that you do not change the 
information in these fields. (If your organization uses the Advanced Security feature, 
you may change the security level.)
Use the following instructions to modify fields 1–3. (Note: If your organization is 
licensed for the Advanced Security feature, you will see additional fields. For more 
instructions on these fields, see the Blackbaud FundWare Advanced Security Guide.)

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Security > Users on the module navigator or select Security > Users 
from the menu bar. The Security–Users window displays.

4. In the Define Basic Security or Advanced Security Settings area (Figure 3.1), 
select a business date and division. 

Figure 3.1—Define Basic Security or Advanced Security Settings

5. Click Define User Security. The Advanced Security option menu displays.
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6. Type C to enter Advanced Security settings for an existing user. 

7. Enter the user number and press ENTER. The first page of the user’s security 
settings displays (Figure 3.2). 

Figure 3.2—Define User Security—Fields 1–3

8. Edit the information according to Table 3.1. 

Table 3.1—User Security Fields 1–3

Field Description Impact if Modified Through Advanced Security

Name 35 characters The user’s name.

Password 15 characters The user’s password and a confirmation.
• The current version of FundWare does not use this 

field. Please do not enter information here.

Division range 1–99 The division or range of divisions that the user can 
access.
• The default range is 1–99. Your basic security 

settings are an easier way to limit the user’s access 
to specific divisions.
What Are Security Levels? 
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9. When complete, press ESC to display the option menu.

10. Type 0 to accept your entries for this user.

11. Press ESC and type E to close the window.

ADDING WORKGROUPS
Use the following instructions to define a workgroup.

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

Security level 1–9 The user’s menu security level. For more information 
on security levels, see What Are Security Levels? on 
page 36. 
• Current versions of FundWare only use levels 1 and 

2.
• Level 1 will cause FundWare to ignore any Advanced 

Security setting except report path and group name. 
• Level 2 indicates that the user has Advanced 

Security settings that should be respected.

Display type A, B, C, D The user’s monitor type.
• Almost all current monitors should be D–Color, 

extended characters.
• You should not need to change this setting from it’s 

default.

Table 3.1—User Security Fields 1–3 (Continued)

Field Description Impact if Modified Through Advanced Security
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3. Click Security > Workgroups on the module navigator or select System 
Administration > Security > Workgroups from the menu bar. The 
Security–Workgroup window displays, showing all workgroups defined for all 
divisions in your system (Figure 3.3). 

Figure 3.3—Security–Workgroup (List of Workgroups)

4. Click New. The New Workgroup window displays (Figure 3.4). 

Figure 3.4—New Workgroup
Adding Workgroups 
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5. Select the division for which you are defining this workgroup from the Division 
drop-down list. Your licensed modules display in the Workgroup security area 
(Figure 3.5). 

Figure 3.5—Selecting the Division

6. Enter the workgroup name. This name can be up to 25 alphanumeric characters.
Blackbaud, Inc. 41



Blackbaud FundWare System Administration Guide

42
7. Select the check box for one or more module for which you are defining 
security settings (Figure 3.6). 

Figure 3.6—Selecting the Modules

The number of tasks allowed and denied display in the Security Access Status 
column. You can increase the width of this column if necessary.

Once defined, a group must always be associated with at least one 
module.
Adding Workgroups 
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8. Click the module name. The Edit Workgroup Security window displays. All 
categories for the module may be collapsed (Figure 3.7). 

Figure 3.7—Edit Workgroup Security—Categories Collapsed
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9. Click the plus sign to expand one or more categories. As you expand categories, 
associated items display and will need to be expanded to display the specific 
tasks or reports (Figure 3.8). 

Figure 3.8—Expanding the Categories and Items

Tip: Right-click and select Expand All from the shortcut menu to 
display all tasks. You can also select Collapse All to collapse all items.

10. Select the applicable radio button to Allow or Deny workgroup members access 
to each task (Figure 3.9). 

• Allow—Task will default as an allowed task for each user assigned to the 
group.
Adding Workgroups 
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• Deny—Task will default as an excluded task for each user assigned to the 
group. 

Figure 3.9—Granting Task-Specific Security Rights

Certain tasks are dependent on the View task (e.g., how can you delete 
a transaction if you are denied rights to view transactions). Therefore, if 
you deny access to the View task for an item, all tasks for that item are 
automatically denied. In contrast, if all tasks for an item are denied and 
you change one to Allow, the View task is also changed to Allow.

11. Click Allow All to grant the workgroup rights to all tasks or click Deny All to 
remove access to all tasks (also available from the shortcut menu). 

Tip: If you want to grant the workgroup access to most tasks, it can save 
you time to click Allow All, then remove access to the tasks that you do 
not want the workgroup to access.

To print the module security settings for the workgroup, click Print 
Grid (also available from the shortcut menu).
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12. When you have correctly assigned access for the module’s tasks, click OK. You 
return to the New Workgroup window and the Security Access Status column 
displays the number of allowed and denied tasks for the module (Figure 3.10). 

Figure 3.10—Allowed and Denied Tasks

13. Continue assigning tasks to all applicable modules.

To print the module-level summary for the workgroup, click Print 
Grid (also available from the shortcut menu).
Adding Workgroups 
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14. Click Assign Users to assign employees to the workgroup (Figure 3.11). There 
are no limits to the number of employees you can assign to each group. 

Figure 3.11—Assigning Users to Workgroup

15. Select the check box next to the employee’s name to assign him/her to the 
workgroup.

Click Select All to assign all users to this group, or click Clear All to 
remove all users from this group.

16. When complete, click OK. The users’ security settings will incorporate the 
workgroup settings when you save the workgroup (i.e., click OK from the New 
Workgroup window).

17. When you have completed the workgroup definition, click OK. 

Only when you Click OK from this screen are your settings saved to the 
FundWare database. The specific module settings defined on the Edit 
Workgroup Security window are only stored temporarily until you save 
the workgroup.

EDITING WORKGROUPS

Use the following instructions to edit a workgroup definition.
1.  Open an instance of FundWare.
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2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Security > Workgroups on the module navigator or select System 
Administration > Security > Workgroups from the menu bar. The 
Security–Workgroup window displays, showing all workgroups defined for all 
divisions in your system (Figure 3.12). 

Figure 3.12—Security–Workgroup (List of Workgroups)
Adding Workgroups 
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4. Select the workgroup and click Edit. The Edit workgroup window displays 
(Figure 3.13). 

Figure 3.13—Editing a Workgroup

5. Edit the workgroup name, assigned users, or module settings, as necessary.

You cannot change the workgroup division.

6. When you have completed your edits, click OK to save these settings.

Only when you Click OK from this screen are your changes saved to 
the FundWare database. Therefore, if you modified any module-
specific settings (i.e., allowed or denied tasks) but click Cancel here, 
you will lose these changes.

BUSINESS RULES FOR EDITING WORKGROUPS

The following rules or behavior apply when you edit workgroups:
• If you remove a module from a workgroup or modify the task-specific settings 

for a module, all users assigned to this group will be impacted. 
— If a user belongs to more than one workgroup, the user may or may not be 

impacted. 
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— Certain tasks are dependent on the View task (e.g., how can you delete a 
transaction if you are denied rights to view transactions). Therefore, if you 
deny access to the View task for an item, all tasks for that item are 
automatically denied. In contrast, if all tasks for an item are denied and you 
change one to Allow, the View task is also changed to Allow.

COPYING WORKGROUPS

FundWare allows you to add a workgroup by the settings for an existing workgroup, but 
only within the same division. This can save you time if you want to add a new 
workgroup that has many similar settings as an existing workgroup.

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Security > Workgroups on the module navigator or select System 
Administration > Security > Workgroups from the menu bar. The 
Security–Workgroup window displays, showing all workgroups defined for all 
divisions in your system (Figure 3.14). 

Figure 3.14—Security–Workgroup (List of Workgroups)
Adding Workgroups 
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4. Select the workgroup to be copied and click Copy. The Copy Workgroup 
window displays (Figure 3.15). 

Figure 3.15—Copying a Workgroup

5. Enter the new workgroup name. This name can be up to 25 alphanumeric 
characters.

6. Modify the assigned users or module settings, as necessary.

You cannot change the workgroup division.

7. When you have completed your edits, click OK to save these settings.

Only when you Click OK from this screen are your changes saved to 
the FundWare database. Therefore, if you modified any module-
specific settings (i.e., allowed or denied tasks) but click Cancel here, 
you will lose these changes.

DELETING WORKGROUPS

Use the following instructions to delete a workgroup. (You cannot delete the 
Administrator workgroup defined for each division.)

1.  Open an instance of FundWare.
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2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Security > Workgroups on the module navigator or select System 
Administration > Security > Workgroups from the menu bar. The 
Security–Workgroup window displays, showing all workgroups defined for all 
divisions in your system (Figure 3.16). 

Figure 3.16—Security–Workgroup (List of Workgroups)

4. Select the workgroup to be deleted and click Delete. A confirmation message 
displays.

5. Click Yes to delete the workgroup. The workgroup is deleted from your system 
and no longer displays in the list of workgroups.

BUSINESS RULES FOR DELETING WORKGROUPS

The following rules apply when you delete a workgroup:
• You cannot delete the Administrator workgroup defined for each division.
• If a user is assigned to only one workgroup and you delete that workgroup:

— The user’s task-specific security settings are also deleted.
— The user cannot work in FundWare until you assign the user to another 

workgroup.
• If a user belongs to multiple workgroups and you delete one, the user’s security 

settings may be impacted. You must review that user’s security settings to 
ensure that all necessary settings are defined.
Adding Workgroups 



Chapter 3—Defining User Security
ADDING USERS
Use the following instructions to define your users.

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Security > Users on the module navigator or select System 
Administration > Security > Users from the menu bar. The Security–Users 
window displays, showing all users defined in your system (Figure 3.17). 

Figure 3.17—Security–Users (List of Users)
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4. Click New. The New User window displays (Figure 3.18). 

Figure 3.18—New User Window

5. Define the user information according to Table 3.2. 

Table 3.2—User Security Fields

Field Valid Entry Definition

User ID Up to 5 
numeric 
characters

Enter up to five numeric characters as the user ID number (i.e., 
1–99999). The user can use this or the Login when opening 
FundWare.
• The user ID is required and must be unique.
• The system will provide the next available number as a default (e.g., 

if you have used 10 and 20, but not 1–9, the system defaults to 1).
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Login Up to 35 
alphanumeric 
characters

Enter the user’s login, which can be used when opening FundWare. 
The following restrictions apply to the login: 
• The login is required and must be unique.
• Cannot begin with a number.
• Can include special characters (e.g., apostrophe).
• Can include blank spaces, but cannot begin or end with a space.

Full name Up to 50 
alphanumeric 
characters

Enter the user’s name. The following restrictions apply: 
• The user’s full name is required and but does not need to be unique.
• Cannot begin with a number.
• Can include special characters (e.g., apostrophe).
• Can include blank spaces, but cannot begin or end with a space.

Password Up to 15 
alphanumeric 
characters

Enter the user’s password. 
• This field is required.
• Characters are encoded to display as asterisks.
• The password cannot include blank spaces.

Confirm 
password

Must match 
Password

Confirm the user’s password by entering it a second time.
• This field is required.
• This entry must match the Password.
• Characters are encoded to display as asterisks.

Report path valid 
directory

Enter the folder to which FundWare will save any reports produced by 
the user or click Browse. (You can add new folders from the Browse 
window.)
• The report path is optional. If you do not enter anything here, all 

reports will be saved to the FundWare\Data folder.
• If you enter a report path, you must include the drive letter.
• The path cannot exceed 24 characters.

— Allowed (24 characters): D:\FundWare\Data\Reports
— Not allowed (31 characters): D:\FundWare\Data\Reports\Miller

• The report path can lead to any folder in your system. You are not 
restricted to folders within the FundWare directory.

User status Active or 
Inactive

Select the applicable radio button to indicate the user’s status.
• Default is Active.

Table 3.2—User Security Fields (Continued)

Field Valid Entry Definition
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A new user’s settings might look like Figure 3.19. 

Figure 3.19—Example New User

6. Click OK to save the user’s settings. 

Workgroups Existing 
workgroups

Select the associated check boxes to assign the user to one or more 
workgroups.
• Display includes all existing workgroups across all divisions.
• Workgroup security settings (i.e., allowed and denied tasks) are 

applied to the user.

Basic 
Security 

The Basic Security tasks allow you to customize the user’s settings from the workgroup 
default settings. See Customizing User Security on page 57.

Table 3.2—User Security Fields (Continued)

Field Valid Entry Definition
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• See Assigning a User to Multiple Workgroups on page 63 to understand 
how multiple workgroup selections define default settings for a user.

• See Customizing User Security on page 57 for instructions to modify the 
default user settings created by the workgroup selections. 

CUSTOMIZING USER SECURITY

By customizing a user’s security, you are taking the default task settings determined by 
the user’s workgroup (or workgroups) and overriding those settings. Use the following 
instructions to customize a user’s settings.

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Security > Users on the module navigator or select System 
Administration > Security > Users from the menu bar. The Security–Users 
window displays, showing all users defined in your system (Figure 3.20). 

Figure 3.20—Security–Users (List of Users)
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4. Select the user and click Edit. The Edit User window displays the user’s 
settings (Figure 3.21). 

Figure 3.21—Editing a User’s Security Settings

5. In the Basic Security area, select the division and module for which you are 
customizing the user’s settings (Figure 3.22). 

Figure 3.22—Selecting a Division and Module to Customize
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6. Click Customize Basic Security. The Customize Basic Security window 
displays with all categories collapsed (Figure 3.23). 

Figure 3.23—Customize Basic Security—Categories Collapsed
Blackbaud, Inc. 59



Blackbaud FundWare System Administration Guide

60
7. Click the plus sign to expand one or more categories. As you expand categories, 
associated items display and will need to be expanded to display the specific 
tasks or reports. In addition, the workgroup default displays in the Workgroup 
Access column (Figure 3.24). 

Figure 3.24—Customize Basic Security—Categories Expanded

Tip: Right-click and select Expand All from the shortcut menu to 
display all tasks. You can also select Collapse All to collapse all items.

8. Select the applicable setting from the Customize User Access drop-down list 
(Figure 3.25). 

• Same as Workgroup—By selecting the Same as Workgroup setting, the 
user’s access to the task will always obey the workgroup setting. For 
example, if you change the workgroup setting for this task from Allow to 
Deny, the user would not longer be able to access the task.

• Always Allow—Allows the user access to the task, regardless of the 
workgroup setting.
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• Always Deny—Denies the user access to the task, regardless of the 
workgroup setting. 

Figure 3.25—Customizing the User’s Security

Certain tasks are dependent on the View task (e.g., how can you delete 
a transaction if you are denied rights to view transactions). Therefore, if 
the user is denied access to the View task for an item, all tasks for that 
item are automatically denied. In contrast, if all tasks for an item are 
denied and you change one to Allow, the View task is also changed to 
Allow.

To print the user’s security settings, click Print Grid (also available 
from the shortcut menu).

9. When complete, click OK. You return to the Edit User window.

10. Click OK to save your settings and close the window.

Only when you Click OK from this screen are your settings saved to the 
FundWare database. The specific customization settings defined on the 
Customize Basic Security window are only stored temporarily until you 
save the user’s settings.
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ASSIGNING USERS TO WORKGROUPS

You can assign users to a group in three ways:
• From the workgroup definition—See Adding Workgroups on page 39 for 

instructions).
• From the workgroup summary window—Assigning Users From the Workgroup 

Summary on page 62.
• From the user’s definition—See Adding Users on page 53.

ASSIGNING USERS FROM THE WORKGROUP SUMMARY

Use the following instructions to assign users to a workgroup from the workgroup 
definition.

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Security > Workgroups on the module navigator or select System 
Administration > Security > Workgroups from the menu bar. The Security–
Workgroup window displays, showing all workgroups defined for all divisions 
in your system (Figure 3.26). 

Figure 3.26—Security–Workgroup (List of Workgroups)

4. Select the workgroup to which you are assigning users.
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5. Click Assign Users. The Assign Users window displays (Figure 3.27). 

Figure 3.27—Assigning Users

The Division and Workgroup fields are disabled. You cannot change 
this information from this window. To select a different workgroup, 
you must close this window (e.g., click Cancel) and begin again from 
the list of workgroups.

6. Select the check box for each employee to assign them to the workgroup. There 
are no limits to the number of employees assigned to each group. 

7. When complete, click OK. The users’ security settings now incorporate the 
workgroup settings.

For more on how security settings for multiple workgroups impact a 
single user’s security, see Assigning a User to Multiple Workgroups on 
page 63.

ASSIGNING A USER TO MULTIPLE WORKGROUPS

When you assign a user to a single workgroup, FundWare applies the workgroup 
settings (i.e., allowed and denied tasks) to the user. These default settings can be 
customized at any time to allow or deny the user access to tasks in contradiction to the 
workgroup settings.
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When you assign a user to multiple workgroups, FundWare consolidates the settings of 
the workgroups to create the user’s default settings. When a task is allowed in one 
workgroup but not allowed in another, the “allow” setting prevails.
For example, we have two workgroups for Division 60: Guide Example 1 and Guide 
Example 2. Guide Example 1 denies access to the four Accounts Payable Vendor 
maintenance tasks (Figure 3.28) 

Figure 3.28—Vendor Maintenance Settings for Guide Examples 1 and 2
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We assign our user to both groups (Figure 3.29). 

Figure 3.29—User Assigned to Two Groups in One Division
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When we select the division (60) and the module (Accounts Payable) and click 
Customize Basic Security, we can see that the allow settings (from Guide Example 2) 
are the default the this user (Figure 3.30). 

Figure 3.30—Consolidated Settings for Example User

EDITING USERS

Use the following instructions to edit a user’s security settings.
1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.
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3. Click Security > Users on the module navigator or select System 
Administration > Security > Users from the menu bar. The Security–Users 
window displays, showing all users defined in your system (Figure 3.31). 

Figure 3.31—Security–Users (List of Users)

4. Select the user and click Edit. The user record displays (Figure 3.32). 

Figure 3.32—Editing a User
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5. Edit the user’s settings, as necessary.

You cannot change the user ID.

6. When you have completed your edits, click OK to save these settings.

Only when you Click OK from this screen are your changes saved to 
the FundWare database. Therefore, if you modified any module-
specific settings (i.e., allowed or denied tasks) but click Cancel here, 
you will lose these changes.

COPYING USERS

FundWare allows you to add a user by copying the settings for an existing user. 
FundWare defaults the report path, status, workgroup assignments, and customization 
settings. This can save you time if the new user requires settings similar to the existing 
user.

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Security > Users on the module navigator or select System 
Administration > Security > Users from the menu bar. The Security–Users 
window displays, showing all users defined in your system (Figure 3.33). 

Figure 3.33—Security–Users (List of Users)
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4. Select the user to be copied and click Copy. The Copy User window displays 
(Figure 3.34). 

Figure 3.34—Copying a User

5. Define the new user information according to Table 3.3. 

Table 3.3—Security Fields for a Copied User

Field Valid Entry Definition

User ID 1–99999 Enter up to five numeric characters as the user ID number. The user 
can use this or the Login when opening FundWare.
• The system will provide the next available number as a default (e.g., 

if you have used 10 and 20, but not 1–9, the system defaults to 1).
• The user ID must be unique.
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6. Modify the report path, status, workgroup assignments, and customization 
settings, as necessary.

7. When you have completed your edits, click OK to save these settings.

Only when you Click OK from this screen are your changes saved to 
the FundWare database. Therefore, if you modified any module-
specific settings (i.e., allowed or denied tasks) but click Cancel here, 
you will lose these changes.

DELETING USERS

You can delete a user from your security system. The user is no longer displayed in the 
system, but related information (e.g., for an audit trail) remains in the database.

1.  Open an instance of FundWare.

Login Up to 35 
alphanumeric 
characters

Enter the user’s login, which can be used when opening FundWare. 
The following restrictions apply to the login: 
• The login must be unique. 
• Cannot begin with a number.
• Can include special characters (e.g., apostrophe).
• Can include blank spaces, but cannot begin or end with a space.

Full name Up to 50 
alphanumeric 
characters

Enter the user’s name. The following restrictions apply: 
• Cannot begin with a number.
• Can include special characters (e.g., apostrophe).
• Can include blank spaces, but cannot begin or end with a space.

Password Up to 15 
alphanumeric 
characters

Enter the user’s password. 
• Characters are encoded to display as asterisks.
• The password cannot include blank spaces.

Confirm 
password

Must match 
Password

Confirm the user’s password by entering it a second time.
• This entry must match the Password.
• Characters are encoded to display as asterisks.

Table 3.3—Security Fields for a Copied User (Continued)

Field Valid Entry Definition
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2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Security > Users on the module navigator or select System 
Administration > Security > Users from the menu bar. The Security–Users 
window displays, showing all users defined in your system (Figure 3.35). 

Figure 3.35—Security–Users (List of Users)

4. Select the user and click Delete. A confirmation message displays.

5. Click Yes to delete the user. The user is removed from the basic security 
system.

SETTING USERS TO “INACTIVE”

If you do not want to delete a user, you can set the user’s status to inactive. The inactive 
status means that the user cannot access any tasks (i.e., all security settings are 
disallowed), but the user record still displays in the basic security system. You can 
reactivate a user, immediately restoring their security rights. 

VIEWING THE USER SUMMARY

You can view a summary of user status and workgroup assignments.
1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.
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3. Click Security > Users on the module navigator or select System 
Administration > Security > Users from the menu bar. The Security–Users 
window displays, showing all users defined in your system (Figure 3.35). 

Figure 3.36—Security–Users (List of Users)

4. Click View Summary…. The View Summary - Users window displays the ID, 
login, status, division, and workgroup assignment for each user (Figure 3.37). 

Figure 3.37—View Summary - Users Window

5. Click Print Grid to print the summary.

6. Click Close to close the window and return to the Security–Users window. 
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PRINTING SECURITY INFORMATION
The Print Grid button appears on a number of windows (or shortcut menus) and allows 
you to print your security information. The report output will reflect the current column 
order and sorting and displays in a preview window, from which you can print the 
information.

• User summary—Click View Summary… to display a summary of user 
workgroup assignments. From the View Summary - Users window, you can 
click Print Grid to print the summary.

• User window (e.g., New User, Edit User)—Prints a list of the workgroups and 
divisions, indicating those workgroups to which the user is assigned.

• Customize Basic Security—Prints a list of the categories, items, tasks/reports, 
and workgroup access. Note: The output will reflect your current expand/
collapse settings.

• List of workgroups—Prints a list of the workgroups and divisions. Output 
reflects the current column order and sorting.

• Workgroup window (e.g., New Workgroup, Edit Workgroup)—Prints a list of 
the modules and task summary (number allowed and denied).

• Edit Workgroup Security—Prints a list of the categories, items, tasks/reports, 
and workgroup access. Note: The output will reflect your current expand/
collapse settings.

CHANGING PASSWORDS
A user can change their own password during login (Changing Your Password During 
Login on page 7) or from the Edit menu (Changing Your Password From the Software 
on page 11). In addition, a user (e.g., someone assigned to the Administrator 
workgroup) with rights to System Administration user security can change anyone’s 
password.

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.
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3. Click Security > Users on the module navigator or select System 
Administration > Security > Users from the menu bar. The Security–Users 
window displays, showing all users defined in your system (Figure 3.38). 

Figure 3.38—Security–Users (List of Users)

4. Select the user and click Edit. The user record displays (Figure 3.32). 

Figure 3.39—Editing a User
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5. Highlight the existing password and delete. The password is removed and the 
Confirm password field is enabled.

6. Enter a new password (up to 15 characters) in the Password field.

7. Confirm the password in the Confirm Password field.

8. Click OK. The user must enter the new password the next time they log onto 
FundWare.
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C H A P T E R  4

MAINTAINING YOUR DIVISIONS

A division is the highest level of segregation in FundWare, and you are allowed to 
define up to 99 divisions. With most organizations, each division represents a company 
or entity. For example, a municipality might have a division for its library and another 
division for its fire department. A non-profit organization might have only one division 
to track all their accounts.
Creating a division is the first task you must complete before configuring your 
FundWare. Once you begin working in the software and have defined your working 
divisions, you can create additional divisions as test divisions. 

You want to define a new Payroll calculation. You “restore” a copy of your 
current division to a test division. Once you have added the calculation to the 
test division and ensured that it works correctly, you add it to your “live” 
division.

The Division Maintenance task allows you to:
• Create and maintain your divisions (e.g., add, copy, and backup divisions),
• Synchronize accounts within a division, and
• Clear AP obligation flags.

ADDING A DIVISION
The first thing you must do to configure your FundWare system is to define at least one 
division. Also, you may add divisions to use as “test” divisions before performing a 
major change to your system. Use the following steps to add a division in FundWare.

1.  Open an instance of FundWare. 

We recommend that you perform any Division Maintenance task from 
the server.
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2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Division Maintenance on the module navigator or select System 
Administration > Division Maintenance from the menu bar. The Division 
Maintenance window displays (Figure 4.1). 

Figure 4.1—Division Maintenance Window
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4. Click New. A line displays below the current divisions and the text boxes are 
cleared (Figure 4.2). 

Figure 4.2—Division Maintenance: New Division

5. Enter the number of the new division (between 1 and 99) in the Division text 
box.

Remember: Numbers 95 and 96 are reserved for FundWare sample 
data.

6. Enter the division name in the Name text box. The division name is printed as 
part of the title for all reports.

The OK and Apply buttons will not be enabled until you enter a 
division number and name.

7. Enter a description of the division in the Description text box (optional).

8. The Blank Page check box, which advances a blank page each time a report is 
printed, is automatically selected. Deselect the check box to disable this option.

9. Click Apply to add this division and continue working in the Division 
Maintenance window, or click OK to add this division and close the Division 
Maintenance window. A confirmation message displays.
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10. Click OK. If you clicked Apply, the new division will display in the data 
window, and you can proceed with other division maintenance tasks. If you 
clicked OK, the new division is created and the Division Maintenance window 
closes.

The copy and backup division options are intended to be used for informal data 
preservation. For example, you are about to perform a major task (e.g., run 
payroll) and want to make sure you can easily return to a specific point in time 
should there be a problem. This option is not intended to replace a formal 
backup procedure. 

When you do any division maintenance, ensure that no users are working in the 
specific division (or divisions).

BACKING UP A DIVISION

To backup your data, you must backup the division. When you do this, a folder is 
created under the Data\Backup folder of your FundWare folder. The folder name is 
determined by the division name (in this case it is division 95, therefore, AFW95) and 
the start time for the backup by year, month, day, hour, and minute. Use the following 
steps to complete a backup.

1.  Open an instance of FundWare.

We recommend that you perform any Division Maintenance task from 
the server.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.
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3. Click Division Maintenance on the module navigator or select System 
Administration > Division Maintenance from the menu bar. The Division 
Maintenance window displays (Figure 4.3). 

Figure 4.3—Division Maintenance

4. Select the division to be backed up. The date and time of the last backup of this 
division displays in the Last Backup column

5. Click Backup. When the backup is complete, a confirmation message displays 
providing the name and location of the backup folder (Figure 4.4). 

Figure 4.4—Backup Confirmation Message
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6. Click OK. The date and time of the backup displays in the Last Backup column 
of the data window (Figure 4.5). 

Figure 4.5—Division Maintenance: Backup Date and Time Stamp

RESTORING A DIVISION

FundWare allows you to automatically restore a division and associated data, if 
necessary. 

Do not attempt to restore a division if the backup was created with an earlier 
version of FundWare. For example, if you created a backup when you were 
using version 7.15, and you currently are using version 7.16, restoring the 7.15 
backup will cause problems with your 7.16 FundWare.

Use the following steps to restore.
1.  Open an instance of FundWare.

We recommend that you perform any Division Maintenance task from 
the server.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.
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3. Click Division Maintenance on the module navigator or select System 
Administration > Division Maintenance from the menu bar. The Division 
Maintenance window displays (Figure 4.6).

Figure 4.6—Division Maintenance: Restoring a Database

4. Select the division to be restored. The date and time of the last backup of this 
division displays in the Last Backup column.
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5. Click Restore. A window displays listing the database backups available for 
restore (Figure 4.7). 

Figure 4.7—Databases Available for Restore

6. Select the specific backup file to be restored. The Delete, OK, and Cancel 
buttons are enabled. 

7. Click OK to restore the data. A confirmation message displays (Figure 4.8). 

Figure 4.8—Restoration Confirmation Message

8. Click OK. The division has been restored with the selected backup.

9. Close the Restore window, or click Cancel. The window closes and you return 
to the Division Maintenance window. 

DELETING A BACKUP

Obsolete backups are deleted during the Restore process. Use the following steps to 
delete a backup.
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1.  Select the division with the backup to be deleted. The date and time of the last 
backup of this division displays in the Last Backup column

2. Click Restore. The Restore window displays.

3. Select the backup to be deleted.

4. Click Delete. A confirmation message displays. 

5. Click Yes. The selected backup is deleted.

6. Close the Restore window, or click Cancel. The window closes and you return 
to the Division Maintenance window. 

RESTORING ONE DIVISION TO ANOTHER DIVISION

You can restore one division to another division, resulting in a backup of the source 
division being copied to the target division, or to a new division, creating the new 
division and restoring the data in one step. Use the following steps to restore one 
division to another division.

This process will delete the security settings of the division to which you are 
restoring. For example, if you restore Division 95 to Division 22, you would 
need to re-enter the security settings for Division 22. If you are restoring to a 
new division, that division will have no security settings.

1.  Open an instance of FundWare.

We recommend that you perform any Division Maintenance task from 
the server.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.
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3. Click Division Maintenance on the module navigator or select System 
Administration > Division Maintenance from the menu bar. The Division 
Maintenance window displays (Figure 4.9). 

Figure 4.9—Division Maintenance: Restoring to Another Division

4. Select the division to be restored. The date and time of the last backup of this 
division displays in the Last Backup column
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5. Click Restore. A window displays listing the database backups available for 
restore (Figure 4.10). 

Figure 4.10—Databases Available for Restore

6. Select the specific backup to be restored. 

7. Select the Restore As check box. The Division, Name, and Description text 
boxes are enabled, as well as the Blank Pages check box.

8. Type the number, name, and description (optional) of the division (either new or 
existing).

9. Select the Blank Page check box to enable this option.

10. Click OK. 

• If the target division is a new division, a confirmation message will display 
when the restore is complete. Click OK. The Restore window closes, and 
the new division is listed in the Division Maintenance data window.

• If the target division is an existing division, a confirmation message will 
display informing you that the existing database will be overwritten. Click 
Yes to proceed. When completed, a confirmation message will display. 
Click OK. The Restore window closes.
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COPYING A DIVISION

You can copy a division, thereby creating a new division with the same data as the 
source division. Use the following instructions to copy a division.

1.  Open an instance of FundWare.

We recommend that you perform any Division Maintenance task from 
the server.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Division Maintenance on the module navigator or select System 
Administration > Division Maintenance from the menu bar. The Division 
Maintenance window displays (Figure 4.11). 

Figure 4.11—Division Maintenance: Copying a Division

4. Select the division to be copied. The date and time of the last backup of this 
division displays in the Last Backup column

5. Click Copy. The Division and Name text boxes are cleared of information. The 
Description text box is populated with “Copy of Division” and the division 
number.
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6. Type the number, name, and description (optional) of the division.

7. Click Apply to copy this division and continue working in the Division 
Maintenance window, or click OK to copy this division and close the Division 
Maintenance window. 

8. When the task is complete, a confirmation message displays (Figure 4.12). 

Figure 4.12—Division Copied Confirmation Message

9. Click OK. 

DELETING A DIVISION

Use the following steps to delete a division.
1.  Open an instance of FundWare.

We recommend that you perform any Division Maintenance task from 
the server.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Division Maintenance on the module navigator or select System 
Administration > Division Maintenance from the menu bar. The Division 
Maintenance window displays. 

4. Select the division to be deleted from the data window.

5. Click Delete. A confirmation message displays. 

6. Click Yes to delete the division. A message displays when the division has been 
deleted.

7. Click OK. The division is deleted and you return to the Division Maintenance 
window.
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When you delete a division, FundWare will also delete any backups related to 
that division.

EDITING DIVISION INFORMATION

You cannot highlight division information and change it unless you are in Edit mode, as 
described in the following steps.

1.  Open an instance of FundWare.

We recommend that you perform any Division Maintenance task from 
the server.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Division Maintenance on the module navigator or select System 
Administration > Division Maintenance from the menu bar. The Division 
Maintenance window displays. 

4. Select the division to be edited.

5. Click Edit. 

6. Edit the division name or description, as necessary.

The division number cannot be changed.

7. Click Apply to save these changes and continue working in the Division 
Maintenance window, or click OK to save these changes and close the Division 
Maintenance window.

ACCESSING THE SAMPLE DIVISIONS

FundWare provides data for two sample divisions: Division 95 and Division 96. You 
can use these divisions to train personnel or test processes, or simply to experiment 
without impacting your own data. 
However, if you are a new FundWare customer, the installation program saved the data 
to your computer, but you must create the divisions.
Use the following instructions to create the sample divisions.
Adding a Division 
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1.  Open an instance of FundWare.

We recommend that you perform any Division Maintenance task from 
the server.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Division Maintenance on the module navigator or select System 
Administration > Division Maintenance from the menu bar. The Division 
Maintenance window displays (Figure 4.13). 

Figure 4.13—Division Maintenance
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4. Click New. A line displays below the current divisions and the text boxes are 
cleared (Figure 4.14). 

Figure 4.14—Division Maintenance: Sample Divisions

5. Enter the number of the sample division (95 or 96) in the Division text box. As 
soon as you click outside the Division text box, a confirmation message 
displays (Figure 4.15). 

Figure 4.15—Sample Division Confirmation Message

6. Click Yes to add the sample division. FundWare enters the division name and 
description in the respective text boxes. 

7. Click Apply to add this division and continue working in the Division 
Maintenance window, or click OK to add this division and close the Division 
Maintenance window. When FundWare has created the division, a completion 
message displays.

8. Click OK.

You can now access the data in the sample division.
Adding a Division 
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SYNCHRONIZING ACCOUNTS
Because the Pro/Enterprise and Classic Editions of FundWare work with different types 
of databases, FundWare updates both sets of data for tasks that exist in both versions. 
For tasks that exist only in the Classic Edition, FundWare has a utility that will manually 
synchronize the databases. Use this utility after tasks such as:

• Maintaining accounts
• Removing unused accounts
• Removing inactive accounts in Project/Grant
• Importing chart of accounts

Also, synchronize your accounts anytime an account appears in the Classic Edition but 
not in the Pro/Enterprise Edition Account Selector.
Use the following steps to synchronize your accounts.

1.  Open an instance of FundWare.

We recommend that you perform any Division Maintenance task from 
the server.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.
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3. Click Division Maintenance on the module navigator or select System 
Administration > Division Maintenance from the menu bar. The Division 
Maintenance window displays (Figure 4.16). 

Figure 4.16—Division Maintenance: Synch Accounts

4. Select the division from the data window.

5. Click Synch Accounts. When complete, a confirmation message displays.

6. Click OK.

CLEARING AP OBLIGATION FLAGS
If your FundWare system shuts down while you are processing Accounts Payable 
obligations (e.g., the power goes out), any obligations that were open at that time will 
have an in-use flag. This in-use flag means that you will not be able to edit or modify the 
obligation until the flag is cleared. Use the following steps to remove in-use flags. 

1.  Open an instance of FundWare.

We recommend that you perform any Division Maintenance task from 
the server.
Clearing AP Obligation Flags 
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2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click Division Maintenance on the module navigator or select System 
Administration > Division Maintenance from the menu bar. The Division 
Maintenance window displays (Figure 4.17). 

Figure 4.17—Division Maintenance: Clear AP Flags

4. Select the division from the data window.

5. Click Remove Flags. When complete, a confirmation message displays.

6. Click OK. The in-use flags are removed.
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C H A P T E R  5

WARNING AND ERROR MESSAGES

Use this chapter as a reference for FundWare-related warning and error messages.
• When and how to call your Certified FundWare Reseller or American 

Fundware, Inc. for assistance.
• Error and system messages:

— Disk Operating System messages
— FundWare system messages

With most FundWare error and system messages, contact FundWare Support or your 
Reseller Partner (see Contacting FundWare Support on page 103 for more information). 
Depending on the complexity of the problem, a Support-provided solution could take 
time, so keep in mind restoring from backup as a possible solution if time is critical.

We cannot help you recover from serious error conditions if you have not 
backed up your data regularly and correctly. It is your responsibility to do 
backups AND to check that they restore successfully!

ERROR OR SYSTEM MESSAGES—WHAT TO DO
Most conditions are minor and easily corrected. The computer may have encountered a 
condition you did not cause. However, never ignore the error and do not continue to 
work. It may appear to you that the system continues to operate. This may not be the 
case. If you ignore an error, it can reappear later with more serious consequences.
When you encounter an error message:

1.  Do not panic! But do not try to continue working.

2. Print the screen to capture the error message.

3. If the message is a “Warning”, review the instructions for the task that triggered 
the message for more information (e.g., review the Blackbaud FundWare 
General Ledger–Project/Grant Guide for a journal entry posting error).
Blackbaud, Inc. 97



Blackbaud FundWare System Administration Guide

98
• Explore the FundWare Support Web site (www.fundware.com/Support/
support.asp), including the Knowledgebase, for more information.

4. If you still need help, complete a problem report (page 104) and call your 
Certified FundWare Reseller or FundWare Customer Support.

FUNDWARE WARNING AND ERROR MESSAGES
FundWare messages fall into three categories:

• Informational—Provides information relevant to the task. You do not need to 
take specific action to correct the system. These messages are not discussed 
further here.

• Warning—May require action on your part to correct the problem or may 
indicate an incorrect keystroke.

• Error—Reported by the program as it attempts to execute your commands. 
These are the most serious error conditions and they require your attention. 

WARNING MESSAGES

Warning messages can occur while you are working in the software or trying to sign on 
to the software. Warning messages returned while you are working in the software 
indicate that the information entered in the field is incorrect in some way (e.g., you 
entered text in a numeric field). These messages are never serious and simply require 
you to re-enter the information.
Warning messages returned when you try to sign on to FundWare (e.g., “Error Log 
Exists, press any key to continue”) require you to correct the problem before trying 
again. These are not true error conditions. Most modules have built in checks to assist 
the operator in completing the normal processing sequence. 

MESSAGE: “ERROR LOG EXISTS”

When you sign on, you may receive the message, “Error log exists, press any key to 
continue.” This indicates that an error message has been logged in a previous instance of 
FundWare. Do not ignore this warning. If you ignore the warning and press any key to 
continue, you are risking damage to your database. Use the following instructions if you 
receive this message.

1.  Open an instance of FundWare.
FundWare Warning and Error Messages 
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2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.) The 
System Administration HomePage displays.

3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 5.1). 

Figure 5.1—System Utilities—Processing the Error Log

4. Click Process Error Log. When the process is complete, a message displays.

5. Click OK. You can view the ERRLOG.WS file through any word processing 
program. The information in this file includes:

• File—The data file involved.
• Open—Whether the file is open or not.
• Stat—The error status code.
• Mode—Normal or delayed processing, or reorganizing data files.
• Pgm—The program detecting the error.
• Rev—The revision of the program.
• From—The program which called the program detecting the error, if any.
• Switches—The switches with which the program was called.
• User—Which user was signed on when the error occurred.
• Div—The division on which the user is signed.
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6. Print and save the ERRLOG.WS file.

7. Review the error messages explained in Example Warning and Error Messages 
on page 100 and take corrective action, if possible.

8. If you need to call FundWare Support, have the error log available and note the 
File and Stat information (Figure 5.2). 

Figure 5.2—Example ERRLOG.WS Highlighting File and Stat

Before calling Support, it is very important to complete a problem report (page 104). 
This will help the Support technician to solve your problem faster by having all relevant 
information available. 

ERROR MESSAGES

Error messages are reported by the program as it attempts to execute your commands. 
These are the most serious error conditions and they require your attention. Many 
different conditions can cause a given error message, and there are no standard solutions 
for these types of errors. 
Whenever you receive an error message, do not continue working without contacting 
your system administrator for help to correct the problem. The information in Example 
Warning and Error Messages on page 100 may provide some assistance for common 
error messages.

EXAMPLE WARNING AND ERROR MESSAGES

Review the following FundWare warning and error messages to troubleshoot problems 
within your software.

• Error Log Exists—See Message: “Error Log Exists” on page 98.
• Error -- Notify software support (filename 22) Press ENTER.

— Explanation—A duplicate record or key has been detected in the file 
“filename.”

— Correcting action—This error should only happen if files have become 
damaged or files from different backups have been mixed together. Contact 
your Reseller Partner or FundWare Support.

• Error -- Notify software support (filename 23) Press ENTER.
FundWare Warning and Error Messages 
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— Explanation—A missing record or key has been detected in file 
“filename”. The record is something that the system expected to already 
exist.

— Correcting action—This error most often occurs on the SYP data file. If 
the SYP file is implicated, check that the module parameters have been 
defined for the subsystem you were in. Contact your Reseller Partner or 
FundWare Support for further help.

• Error -- Notify software support (filename 9007) Press ENTER.
— Explanation—The data file “filename” is corrupted. You may also receive 

this message when your hard disk drive is full.
— Correcting action—Make sure you have enough free space on your hard 

drive. If you were posting, contact your Reseller Partner or FundWare 
Support. Make sure you have write-access to the network and.

• Error -- Notify software support (LPT1 9027) Press ENTER.
— Explanation—An attempt was made to print when the printer was off line 

or nonexistent. This typically is the result of printing a file to a printer 
which is off line or not connected.

— Correcting action—Turn the printer on if it is off. Put it on-line if it is off 
line. If that doesn’t work, sign off and make sure your printer works for 
other software applications. You may need to consult your hardware dealer 
for assistance.

• Error -- Notify software support (00SYP 9043) Press ENTER.
— Explanation—The FundWare license data file, 00SYP is either missing or 

damaged.
— Correcting action—Contact your Reseller Partner or FundWare Support.

• Error -- Notify software support (00SYT 9043) Press ENTER.
— Explanation—This error usually occurs immediately after typing UP after 

a previous abnormal exit from FundWare. The 00SYT file, which keeps 
track of terminals signed on, is corrupted.

— Correcting action—Make sure no one is currently signed on. Then, use the 
PRINT AND SAVE ERROR LOG task from the Special Processing menu 
to print and save the error log. Then delete the 00SYT file pair.

• Error -- Notify software support (filename 9043) Press ENTER.
— Explanation—The index portion of file “filename” is corrupted.
— Correcting action—Rebuild the index for the data file using the 

instructions in Appendix C—FundWare File Maintenance on page 329. Test 
the file by running the task that failed after the rebuild is complete.

• Error -- Notify software support (filename 9139) Press ENTER.
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— Explanation—The version of data files do not match the version of 
program files. This is likely to happen after a conversion; for example from 
FundWare 5.0 to 5.5.

— Correcting action—Make sure that all data files have been converted and 
that the correct version of programs have been installed.
— You may receive this message if your hard disk drive is full.
— Contact your Reseller Partner or FundWare Support.

• Program_name Segment RT: Error 153 at COBOL PC 0DAA
— Explanation—This is usually an internal program error rather than data file 

corruption. The program has either been damaged, is a bad copy, or contains 
internal logic conflicts.

— Correcting action—Contact your Reseller Partner or FundWare Support.
• That keystroke has no meaning here.

— Explanation—A key is pressed which is not allowed for data entry into the 
field. This usually happens if a non-numeric key is pressed when entering 
data for a numeric field.

• There is no field beyond here.
— Explanation—This message usually results if an arrow key is pressed or 

too many keystrokes are pressed during data entry.
• You are at the end of the field.

— Explanation—This message may be displayed if too many characters are 
entered for the field.

• You have lost data from the end of the field
— Explanation—This message is most likely to happen if the <INS> key is 

used while entering data into an alphameric field. The field size has been 
exceeded and characters are dropping off the right side.

OPERATING SYSTEM ERROR MESSAGES
These error messages are reported from your workstation or network operating system 
(OS). You have an OS error message if you executed a system command and 
encountered a problem. Usually, operating system messages occur outside the 
application. Contact your system or network administrator for assistance.
Operating System Error Messages 
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CONTACTING FUNDWARE SUPPORT
You may be able to correct the problem by following the procedures outlined in the 
section, Error Messages—What to do? If you find you still need to call for help, follow 
these procedures: 

• Complete a Problem Report (Completing a Problem/Trouble Report on page 
104). You will need to know your license number.

• Attach your Computer System Configuration Data Sheet (Computer System 
Configuration Data Sheet on page 106).

• Complete these forms regardless of whom you call for support.
• If you have a service contract with an Certified FundWare Reseller, please call 

the number you have been furnished. Your Certified FundWare Reseller may 
contact American FundWare, Inc.

• If you have a support agreement with American Fundware, Inc., please call the 
Support department:
— 800-227-7575
— e-mail: FWSupport@Kintera.com

Please make sure you give your Support technician complete information regarding 
your problem or question, as well as your license number and current version (available 
from the Registration Management task [Maintaining Your Blackbaud FundWare 
Registration on page 28] or the Help menu [License and Database Information on page 
33]). This will help us determine how best to handle your request for assistance. See 
Completing a Problem/Trouble Report on page 104 for more information.

SUPPORT AGREEMENTS

Blackbaud Fundware, Inc. strongly believes that selling our product to your 
organization is just the beginning of a continuing relationship. We are committed to 
providing necessary services to install, implement, and maintain your computerized 
accounting system.
We have a nationwide reseller network who provide installation, implementation, 
training, and maintenance services. If you purchased your system from a Certified 
FundWare Reseller, please contact them for information regarding their available 
services.
American Fundware, Inc. also stands ready to assist you. We offer a full-service Support 
department, available with the purchase of a Support Agreement. If you would like more 
information about the FundWare Support Agreement or the name of the Certified 
FundWare Reseller nearest you, please contact our us (800-551-4458).
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In addition to our Support department, the Professional Services department is available 
on an hourly basis for specific tasks that can be crucial in configuring a solution to meet 
your specific needs. Some common services provided by Professional Services include:

• Recovering damaged files
• Writing reports
• Modifying FundWare’s Payroll/Personnel
• Developing a chart of accounts
• On-site visits
• Training
• Installing hardware or operating systems

This list is by no means complete. Please contact us for more information how our 
Professional Services department can assist you.

COMPLETING A PROBLEM/TROUBLE REPORT

Use this form every time you call for help. (You can print fresh copies from the PDF of 
this guide stored in your FundWare > Data > User Documentation folder.) Attach a 
completed copy of the Computer System Configuration data sheet (page 106) to this 
report before you call for help. 

Table 5.1—Problem/Trouble Report

Required Information Your Entry

Identification Information

• Date and Time

• Response number
(if this is an open call)

• Organization name

• License number

• Number of users

• Is this a problem or question
Contacting FundWare Support 
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Your Computer System Environment (see Maintaining Your Blackbaud FundWare Registration on 
page 28)

• Operating system and version

• Service packs installed

The Problem/Question

• Module

• Task

• Error message
• Write the message down or create a 

print screen of the message. 
• Print the ERRLOG.WS, if applicable.

• Sequence of events just before the 
problem occurred. 

• Please be specific. For example, what 
keystrokes did you enter.

• What have you done since the error
• Please be specific. 

Table 5.1—Problem/Trouble Report (Continued)

Required Information Your Entry
Blackbaud, Inc. 105



Blackbaud FundWare System Administration Guide

106
COMPUTER SYSTEM CONFIGURATION DATA SHEET

You may want to ask your hardware distributor or resident technician for specific data. 
Be as complete as possible. 

 

Table 5.2—Problem/Trouble Report

Required Information Your Entry

Background Information

• FundWare installed since: ___/___/___

• This sheet last updated: ___/___/___

• License number

System Information

• RAM

• Hard drives (size and drive letters)
• If partitioned, the size of each

• Are you using Windows Terminal 
Server or Citrix?

• Data was last purged: ___/___/___

Software Information

• Workstation Operating System and 
version
Contacting FundWare Support 
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IMPORTING/EXPORTING GL–P/G INFORMATION

FundWare allows you to import two types of information:
• Additions or changes to account records, and 
• Transactions. 

Additionally, you can create a file containing the net or detail transactions posted to a 
fiscal period (e.g., for use as an import file at another FundWare site).
Create your text files for importing data using any text editor, database or word 
processor, or any other software application. However you create text files, they must 
have a specific format to be imported into FundWare modules. 
To access imported batches in FundWare, click Journal Entries > Imported on the 
module navigator (if the module is not expanded, click General Ledger first) or select 
General Ledger > Journal Entries > Imported from the menu bar.

GENERAL INSTRUCTIONS FOR IMPORTING FILES
Files are imported through different programs using the Execute Programs task. The 
following section provides the basic instructions for this task. Each import task has a 
section defining the specific requirements for these programs.

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)
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3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 6.1). 

Figure 6.1—System Utilities—Executing a Program

4. In the Execute Program area, enter the required information according to the 
requirements defined in each import section.

5. Click Run. When complete, you return to the Execute Program screen.

IMPORTING NEW OR MODIFIED ACCOUNT INFORMATION
Using the import account information task, you can import new accounts or 
modifications to your existing accounts.

IMPORTING ACCOUNT INFORMATION—IMPORT FILE FORMAT

The text files cannot contain special characters. Special characters, such as tabs and 
form-feeds, are typically characters that are not printable. Each line of text must be 
terminated with the line terminator for the operating system. For example, in MS-DOS 
the line terminator is a carriage return/new line sequence.
Importing New or Modified Account Information 
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KEYWORD RECORD

The keyword record is the first line of the import text file and identifies the division and 
may also identify the separator character. If no separator character is defined here, the | 
(pipe sign) is used as the default.The format is: 

The remaining lines of the file identify the information that you are importing to your 
General Ledger or Project/Grant system. Each line is broken into three units:

• The first two characters indicate the type of information (e.g., account number) 
and is a number between 00 and 06. 

• The third character is the separator character. (Again, the pipe sign is the default 
separator character.)

• The next characters are the values for the field. If there are multiple values, use 
the separator character, without any additional spaces, between each value. 

IMPORTING ACCOUNT INFORMATION—IMPORT FILE FIELD DEFINITIONS

Table 6.1 provides definitions for the account import fields. 

DIV = nn SEP = x

where

• nn is the division number

• x is the separation character

Table 6.1—Import Account Information—Field Definitions

Type # Field Values Maximum Field Size

00 Account number 30 Characters

01 Description 30 Characters

02 Status 1 Character

03 Alias 1|Alias 2 30 Characters|30 Characters

04 Att1|Att2|... 2 Characters|2 Characters
At least one is required and up to 15 attributes may be used.

05 Req ID’s|1 of Req ID’s 15 Characters|15 Characters

06 Data item Field size is dependent on the data item type. Refer to the data 
item definition.
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IMPORTING ACCOUNT INFORMATION—IMPORT FILE EXAMPLE 1
In division 96, we add account A01 01-00 6010 and change the attributes for account 
A02 01-00 7000. Additionally, we do not define any special separator character, so the 
import text uses the pipe sign (|).

DIV=96
00|A01 01-00 6010
01|Travel Expenses
02|A
03| |Not used
04|EX| |FA| | | | | | | |
05| B| |
00|A02 01-00 7000
04|EX| |CB| | | | | | | |

IMPORTING ACCOUNT INFORMATION—IMPORT FILE EXAMPLE 2
In division 20, we add account P000-00-30009-0000, which includes a number of data 
items. Additionally, we do not define any special separator character, so the import text 
uses the pipe sign (|). 

DIV=20
00|P000-00-30009-0000
01|HEAD START 2002-2003
02|D
03|8-21113
04|DS|
06|.YEAR END|05/31/2003
06|ADDL REC 1|
06|ADDL REC 2|
06|AWARD/WO#|WO# 666
06|CFDA #|KLKJHDF
06|COLLEGE/AD|EXECUTIVE
06|DEPT/SCHOOL|SAN FRANCISCO URBAN INSTITUTE
06|DIR. EMAIL|JVKSPED@SFSU.EDU
06|END DATE|05/31/2003
06|FINAL RPT|06/01/2002
06|FUNDING AG|SFSU
06|INDIR COST|5
06|INTERIM RP|MONTHLY
06|PROJ DIREC|VAN KEULEN, JEAN
06|PROJ TITLE|HEAD START 2002-2003
06|RELATED PR|54687
06|START DATE|06/01/2002
Importing New or Modified Account Information 
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IMPORTING ACCOUNT INFORMATION—IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

For example, you are ready to import the file, so you log onto your computer and check 
the TTY number, which is 864. Therefore, the line number is 0864 and the import name 
must be:

• CS0864.Z 
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

IMPORTING ACCOUNT INFORMATION—IMPORTING THE FILE

To import the account information file from the Execute Programs task (see General 
Instructions for Importing Files on page 107), enter the required information according 
to Table 6.2. 

You can also go to your DOS prompt, type AFWRUN, and enter the program 
name to run the program from outside FundWare. 

CS + Line number
(Line number is 0 + your TTY number)

+ .Z

Table 6.2—Importing Account Information—Importing the File

Field Entry

Program Name CUSCS10

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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IMPORTING ACCOUNT INFORMATION—IMPORT FILE ERRORS

When you run the import task, the system checks the file for errors. If errors are found, 
the error report is saved to the FundWare > Data folder with the following name: 

For example, you are ready to import the file to Division 95, so you log onto your 
computer and check the TTY number, which is 864. Therefore, the line number is 0864 
and the error file for a Division 95 import is:

• CSX0864.L95
If there are errors, review the error report to determine their causes. Correct the import 
file and run the program again.

IMPORTING TRANSACTIONS
Using the transaction import task, you can import General Ledger or Project/Grant 
transactions to FundWare. You can post your transactions as they are imported or save 
them to the system to be posted at a later time. (If you save your transactions instead of 
post, you can edit the transactions before posting.)

IMPORTING TRANSACTIONS—IMPORT FILE FORMAT

The text files cannot contain special characters. Special characters, such as tabs and 
form-feeds, are typically characters that are not printable. Each line of text must be 
terminated with the line terminator for the operating system. For example, in MS-DOS 
the line terminator is a carriage return/new line sequence.

KEYWORD RECORD

The keyword record is the first line of the import text file and identifies the division and 
may also identify the separator character. If no separator character is defined here, the | 
(pipe sign) is used as the default.The format is: 

CSX + Line number
(Line number is 0 + your TTY number)

+ .L##
(## represents your division number)

DIV = nn SEP = x

where
Importing Transactions 
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The remaining lines of the file identify the information that you are importing to your 
General Ledger or Project/Grant system. Each line is broken into three units:

• The first character indicates the type of information (e.g., account number) and 
is a number between 1 and 6.

• The third character is the separator character. (Again, the pipe sign is the default 
separator character.)

• The next characters are the values for the field. If there are multiple values, use 
the separator character, without any additional spaces, between each value. 

IMPORTING TRANSACTIONS—IMPORT FILE FIELD DEFINITIONS

The rest of the lines are identified as record type 1 though 6 as described in Table 6.3. 

• nn is the division number

• x is the separation character

Table 6.3—Import Transaction Information—Field Definitions

 Type Fields
[Max Characters] Field Definitions

1 journal name
posting date
batch name [5]
description [30]

• Journal name must exist.
• Date format must be MMDDYYYY.
• Enter a batch name and description only if your setup allows imported 

transactions to be saved.
• If you import the transactions as saved, the description must be 

unique.

2 account number(s) • Type 2 must always be followed by a type 3. 

3 description [30]
ref1 [10]
ref2 [10]
ref3 [10]
amount
unit
rate

• Type 3 must always follow a type 2.
• Amount must be all numeric, no commas or dollar sign.
• Description, ref1–3, units, and rates may be blank.
• Blanks are indicated with the | sign.
• Units * rate must = amount.
• Units and rates must have decimal and 4 decimal places.
• If units and rates are used in your journals, they must be in the record 

or indicated by a blank.
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Indicate debit/credit in amount fields with a + or -. Debits are assumed + and 
credits -. If no sign is entered, + is assumed.

IMPORTING TRANSACTIONS—IMPORT FILE EXAMPLE 1
The following example imports a $800 transaction to account A01 00-00 1110 through 
the CREC journal using types 2 and 3. 

1|CREC|01022004|TEMP
2|A0100001110
3|January 2-04 Dep|Dep #1|||800.00|20.0000|40.0000
4|A0100004110|Cty Tax|ck #35|||400.00-
5|Cntry|Kenya
6|20.0000-|40.0000

4 account
description [30]
ref1 [10]
ref2 [10]
ref3 [10]
amount

• Type 4 can be used instead of or with a 2/3 pair.
• Account must exist.
• Blanks are indicated with the | sign.
• Amount must be all numeric, no commas or dollar sign. 
• Decimal must be used to indicate cents. If no decimal is entered, 

default is two decimal places.
• Description and references may be blank.

5 data item name
data item value

• Optional, but when used must follow a type 2/3 pair or type 4.
• Data item must exist, be defined in the journal control, and value must 

match definition.

6 units
rate

• Optional, but when used must follow type 4.
• Units * rate must = amount in preceding type 4.
• Units and rates must have decimal and 4 decimal places.

Table 6.3—Import Transaction Information—Field Definitions (Continued)

 Type Fields
[Max Characters] Field Definitions
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IMPORTING TRANSACTIONS—IMPORT FILE EXAMPLE 2
The following example imports a $400 transaction to account A01 00-00 1110 through 
the CREC journal using type 5 (excluding types 2 and 3). 

1|CREC|01022004|TEMP
4|A0100004110|Cty Tax|ck #35|||400.00-
5|Cntry|Kenya
6|20.0000-|40.0000

IMPORTING TRANSACTIONS—GL AND P/G IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name for both General Ledger and Project/Grant 
imports: 

For example, your Station ID number is 864. Therefore, the import name must be:
• GL0864.Y

For more information on Station ID numbers, see Appendix F—Determining Your 
Station ID on page 355.

IMPORTING TRANSACTIONS—IMPORTING THE FILE

To import the transaction file from the Execute Programs task (see General Instructions 
for Importing Files on page 107), enter the required information according to Table 6.4. 

GL + 0 + your Station ID number + .Y

Table 6.4—Importing Transactions—Importing the File

Field Entry

Program Name GLS018 (For General Ledger)
PGS018 (For Project/Grant)

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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You can also go to your DOS prompt, type AFWRUN, and enter the program 
name to run the program from outside FundWare. 

Use the following instructions to post the imported transaction.
1.  Open FundWare using the division to which you imported the file.

2. Click Journal Entries > Imported on the module navigator (if the module is 
not expanded, click General Ledger first) or select General Ledger > Journal 
Entries > Imported from the menu bar. The Imported Journal Entries window 
displays (Figure 6.2). 

Figure 6.2—Import Journal Entries

3. Click Post to post the transaction.

IMPORTING TRANSACTIONS—IMPORT FILE ERRORS

When you run the import task, the system checks the file for errors. If errors are found, 
the error report is saved to the FundWare > Data folder with the following name for 
both General Ledger and Project/Grant imports: 

For example, if your Station ID number is 864, the error file for a Division 95 import is:
• GLX0864.L95

If there are errors, review the error report to determine their causes. Correct the import 
file and run the program again.
For more information on Station ID numbers, see Appendix F—Determining Your 
Station ID on page 355.

GLX + 0 + your Station ID number + .L##
(## represents your division number)
Importing Transactions 
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AVOIDING ERRORS

To avoid errors in your import, ensure that your data is accurate:
• Account numbers are valid.
• Posting date is in a valid date table.
• Posting date is not in a closed period.
• Text file format is correct as described in the following section.

EXPORTING NET TRANSACTIONS
You can create a file containing the net transactions posted to a fiscal period for use as 
an import file at another FundWare site. 

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 6.3). 

Figure 6.3—System Utilities—Executing a Program
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4. In the Execute Program area, enter the required information according to Table 
6.5 to run the override. 

5. Click Run. The export task displays (Figure 6.4). 

Figure 6.4—Creating an Export File

6. Complete the required information according to Table 6.6. 

Table 6.5—Exporting Net Transactions—Exporting the File

Field Entry

Program Name CUSGL10

Switches Leave blank

Parameters Enter GLS to export General Ledger information.
Enter PGS to export Project/Grant information.

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.

Table 6.6—Export Net Transactions File—Fields and Associated Options

Field Options

Separator 
character

Default = | (pipe symbol). Keep the default unless your transfer process does not 
accept it. This char may not be '-', '.', '/' or a space.

ID type Enter one ID type for this export. It must one that is defined in the General Ledger. 
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7. Type 0 to accept your entries. When the task is complete, the file is saved to the 
FundWare > Data folder and you return to the System Utilities window.

EXPORTING NET TRANSACTIONS—EXPORT FILE NAME

When you run the export task, the system saves the file to the FundWare > Data folder 
with the following name: 

For example, if your TTY number is 864, the line # is 0864. So the error file name is:
• GL0864.Y

If you update this data after the export file is created, it will result in a data 
discrepancy between the export and import sites. To prevent this from 
happening, you can close the period to data entry immediately after you create 
the file.

EXPORTING DETAIL TRANSACTIONS
The Transaction Export task is used to export GL–P/G transactions posted to an ASCII 
text file (e.g., so that you can import the information another FundWare system at 
another location). If you will be importing the file to another FundWare system, see 
Importing Transactions on page 112.

Date Enter the period ending date. The date range for that period will display.

Description Enter a description that will label the transactions.

Reference 1 Enter the reference 1 field to put on the created transactions.

Include
• Actual
• Budget
• Encumbrance

Indicate by a Y or N in each fields which types of accounts to include in the export.

GL + Line number
(Line number is 0 + your TTY number)

+ .Y

Table 6.6—Export Net Transactions File—Fields and Associated Options (Continued)

Field Options
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To export your detail transactions, you must define a parameter to track both the last 
batch number exported and the date range of the last transactions exported. The system 
maintains a log file to record the dates and batch numbers of the exports and the user 
that performed the exports. 

DEFINING THE EXPORT PARAMETER

You must define the export parameter to activate the feature. The parameter tracks both 
the last batch number exported and the date range of the last transactions exported.

1.  Click Maintenance > Transaction Export > Define Parameter on the module 
navigator (if the module is not expanded, click General Ledger first) or select 
General Ledger > Maintenance > Transaction Export > Define Parameter 
from the menu bar. The option menu for the task displays.

2. Type A to add the parameter. The Define Transaction Export Param window 
displays (Figure 6.5). 

Figure 6.5—Define Transaction Export Param
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3. Complete the required fields according to Table 6.7. 

4. When complete, type 0 at the option menu to accept your entries.

5. Type E to end the task and close the window.

VIEWING THE EXPORT PARAMETER

Use the following instructions to view the current information in the export parameter.
1.  Click Maintenance > Transaction Export > Display Parameter on the 

module navigator (if the module is not expanded, click General Ledger first) or 
select General Ledger > Maintenance > Transaction Export > Display 
Parameter from the menu bar. The option menu for the task displays.

Table 6.7—Defining Export Parameter—Field Definitions

Field Valid Entry  Definition

User Options

System active Y
N

The field allows you to enable or disable the task according to 
your needs.
• Y—Export is currently active
• N—Export is currently inactive

System information—Maintained by the system

• Last export # Batch number of the last transaction exported.

• Current posted date First and last transaction dates posted by the
financial reporting systems since the last export.
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2. Type D to display the parameter. The parameter displays (Figure 6.6). 

Figure 6.6—Display Transaction Export Param

3. Type E to end the task and close the window.

EXPORTING TRANSACTIONS

The Export Transactions task is used to export transactions that have been posted to 
GL–P/G since the last export. You can also re-export transactions using a selection of 
date range and batch number range. 
Exporting Detail Transactions 
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1.  Click Maintenance > Transaction Export > Export Transactions on the 
module navigator (if the module is not expanded, click General Ledger first) or 
select General Ledger > Maintenance > Transaction Export > Export 
Transactions from the menu bar. The task displays (Figure 6.7). 

Figure 6.7—Exporting Transactions

2. Define the required fields according to Table 6.8. 

Table 6.8—Exporting Transactions—Field Definitions

Field Valid Entry  Definition

Function C
R

• Create new export—Transactions will be exported based on 
information in the parameter record. 
— All batches with a transaction number greater than “last 

export” and posted during the “current posted” time period will 
be exported. “Last export” and “current posted” are 
maintained in the parameter. 

• Re-export—By selecting this function, the system will prompt for a 
date and batch number range to be exported. 

— This function does not update the “last export” batch number 
in the parameter.

Separator char any single 
character

This character will be used to separate the fields in the export file. 
• The default character is the “|” (pipe) symbol.

Date range date Enter the first and last dates for the transactions to be exported. 
Zeros may be used for the first date and all 9's may be used for the 
last date.
• Entry in this field is not allowed in the Create new export function.
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3. When complete, type 0 to accept your entries. You are asked if you want to 
produce a report.

4. Type Y to extract the transactions and file a report. You are asked if you want to 
file another report.

5. Type N to end the task and close the window.

EXPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

For example, you are ready to import the file, so you log onto your computer and check 
the TTY number, which is 864. Therefore, the line number is 0864 and the import name 
must be:

• GL0864.Y
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

Batch range # Enter the first and last batch numbers for the transactions to be 
exported. 
• Entry in this field is not allowed in the Create new export function.

GL + Line number
(Line number is 0 + your TTY number)

+ .Y

Table 6.8—Exporting Transactions—Field Definitions (Continued)

Field Valid Entry  Definition
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EXPORT FILE FORMAT

Table 6.9 defines the export file format. 

DISPLAYING THE EXPORT LOG

Use the Display Export Log task to display transaction batch numbers that have been 
exported. Exports are displayed in reverse chronological order by the actual date of the 
export.

Table 6.9—

Record Type Column Description

keyword 1-4 The value DIV=

5-6 The 2 digit division number exported

8-11 The value SEP=

12 The 1 character specified for separator character when selecting the export

1 1 The value 1

3-7 Journal abbreviation

9-18 Posting date

2 1 The value 2

3-57 Account number(s)

3 1 The value 3

3-32 Description

34-43 Reference 1

45-54 Reference 2

56-65 Reference 3

67-88 Amount

5 1 The value 5

3-12 Additional data item abbreviation

14-69 Additional data item value
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1.  Click Maintenance > Transaction Export > Display Export Log on the 
module navigator (if the module is not expanded, click General Ledger first) or 
select General Ledger > Maintenance > Transaction Export > Display 
Export Log from the menu bar. The task displays (Figure 6.8). 

Figure 6.8—Display Export Log

2. Enter the date range of exports that you want to display.

Entering a starting date of all zeroes (00/00/0000) and an ending date of 
all nines (99/99/9999) results in all exports being included in the log.

3. Press ENTER. The exports created during the date range display (Figure 6.9). 

Figure 6.9—Displaying Exports
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4. Review the log according to Table 6.10. 

5. When you have viewed the information, press ENTER. You are asked if you 
want to view any additional export information.

6. Type N to end the task and close the window.

PRINTING THE EXPORT LOG

Use the Print Export Log task to print transaction batch numbers that have been 
exported. Exports are printed in reverse chronological order by the actual date of the 
export.

Table 6.10—Transaction Export Legend

Column  Definition

Type Export type:
• C—Create new export 
• R—Re-export

Begin “T” The first batch number exported.

End “T” The last batch number exported.

From date The first business date exported.

To date The last business date exported.

Exported The actual date these batches were exported.

User The user number that did the export. Zero indicates a “Stand alone” execution.

Name The name of the user that did the export
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1.  Click Maintenance > Transaction Export > Print Export Log on the module 
navigator (if the module is not expanded, click General Ledger first) or select 
General Ledger > Maintenance > Transaction Export > Print Export Log 
from the menu bar. The task displays (Figure 6.10). 

Figure 6.10—Print Export Log

2. Enter the date range of exports that you want to print.

Entering a starting date of all zeroes (00/00/0000) and an ending date of 
all nines (99/99/9999) results in all exports being included in the log.

3. Press ENTER. You are asked if you want to produce a report.

4. Type Y to extract the transactions and file a report (CSXLOG.L##, where ## 
represents your division number). You are asked if you want to file another 
report.

5. Type N to end the task and close the window. 
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C H A P T E R  7

IMPORTING/EXPORTING AP INFORMATION

There are four Accounts Payable import/export programs:
• Import Obligations
• Import Vendor Records 
• Export Obligations
• Check Reconciliation Import

The import tasks are not items on the FundWare applications menu. 
You must have security access (through Maintenance > System 
Administration > Accounts Payable) to restore or delete Imported Batches.

Create your text files for importing data using any text editor, database or word 
processor, or any other software application. However you create text files, they must 
have a specific format to be imported into FundWare modules. 

GENERAL INSTRUCTIONS FOR IMPORTING FILES
Files are imported through different programs using the Execute Programs task. The 
following section provides the basic instructions for this task. Each import task has a 
section defining the specific requirements for these programs.

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)
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3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 7.1). 

Figure 7.1—System Utilities—Executing a Program

4. In the Execute Program area, enter the required information according the 
requirements defined in each import section.

5. Click Run.

IMPORTING OBLIGATIONS
This task is used to import obligations from a text file into the Accounts Payable 
module. Some features include: 

• Obligations not involving checks may be imported and saved to a batch name. 
This saved batch may then be restored, edited and posted.

• Obligations not involving checks may be imported into any stage that is defined 
to allow data entry. Those batches which contain check information must be 
imported to a stage which is classified in the parameter record as “PAID” or 
greater. The allow data entry flag is ignored.

• Each execution of the task imports one batch of obligations.
• The number of obligations in a batch is essentially unlimited (over nine 

million).
• Decimal points and commas may be used for clarity, but are ignored by the 

program.
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• The use of obligation references is optional.

IMPORTING OBLIGATIONS—IMPORT FILE FORMAT

The text files cannot contain special characters. Special characters, such as tabs and 
form-feeds, are typically characters that are not printable. Each line of text must be 
terminated with the line terminator for the operating system. For example, in MS-DOS 
the line terminator is a carriage return/new line sequence.

KEYWORD RECORD

The keyword record is the first line of the import text file and identifies the division and 
may also identify the separator character. If no separator character is defined here, the | 
(pipe sign) is used as the default. The format is: 

IMPORTING OBLIGATIONS—IMPORT FIELD DEFINITIONS

You can use six types of records in the text file containing the obligations to be 
imported. This section defines the record types and explains how to format the records 
in the text file. Rules specific to a record type are explained below.
The following rules apply to all fields in all records:

• The “type” field always contains the record type number.
• All dates have the format, MMDDYYYY.
• All dates must be valid and not in closed periods.
• All dollar amounts must use numbers, and no $ characters. Their maximum size 

is 999 million.
• Obligation stage numbers, banks, vendor numbers, account numbers and 

references must be defined and valid.
• There can be only one batch total per batch. Total amount of obligations must 

match the batch total if the check batch total flag is “Y”. Total amount of detail 
records for each obligation must match obligation amount.

DIV = nn SEP = x

where

• nn is the division number

• x is the separation character
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• Record type 2 is only allowed for vendor number zero. You can only use one of 
these records for each obligation in a batch.

• There must be at least one obligation detail record and up to 9,999 detail records 
for each obligation in batch. There is one exception to this rule: if you use 
distribution tables and a table is applied against an obligation in the batch, you 
may omit the obligation detail record.

• Blank fields must be indicated by separator characters.
• Each record type must contain the same number of lines in the same format as 

specified in this document.

IMPORTING OBLIGATIONS—RECORD TYPE 0
Use one record type 0 (zero) per import file. This record uses one line and contains the 
business date, obligation stage, and total dollar amount of obligations to be imported. 
Optionally, if the import file is to be saved, you must specify a batch name and batch 
description, otherwise leave these fields blank. If check information is contained enter 
the bank name. Table 7.1 explains the field requirements for this line. 

Table 7.1—Record Type 0—Field Definitions

Field Field Definition

Type 1 character (for this line, this value is 0)

Business date 8 characters (mmddyyyy)

Stage number Up to 2 digits. Not required if batch name specified.

Group name May be blank. Enter a valid Advanced Security group name if you are using this 
feature.

Check batch total Entry must be Y or N:
• Y—Check batch total.
• N—Do not check batch total.

Batch total The batch total. Not required if Check Batch Total entry is N.

Batch name A five-character name if the import file is to be saved. This entry determines 
whether the batch is saved to the Imported Batches folder or posted to the stage 
specified in the Stage ## field.

Batch description Enter up to 30-character description if the import file is to be saved.

Bank name A valid Financial Institutions account name.
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EXAMPLE RECORD TYPE 0

The following example imports a batch to stage 30 (i.e., invoices). No group name is 
specified because this organization doesn’t use Advanced Security.

0|02212004|30||Y|1241.50|Examp|Example for Guide|Alpenglow Federal Bank

IMPORTING OBLIGATIONS—RECORD TYPE 1
Use one Record Type 1 for each obligation in the batch. This record is also called the 
obligation header record. It has three lines. The information corresponds to information 
entered on the Header tab of the obligation. Table 7.2 explains the field requirements 
for this line. 

Table 7.2—Record Type 1—Field Definitions

Field Field Definition

Line 1 of Record

Type 1 character (for this line, this value is 1)

Stage date 8 characters (mmddyyyy)

Vendor # A valid vendor number.

Total amount Total amount of the obligation.

Take discount Entry must be Y or N:
• Y—Take discount.
• N—Do not take discount.

Discount type Entry must be N, A, or P:
• N—No discount.
• A—Discount is flat dollar amount.
• P—Discount is a percentage rate.

Discount rate/amt If you use Discount type A or P, you must fill in the Discount rate/amt field. 
Discount rate is a percentage entered as a decimal number; i.e., use 1.00 for 1%. 
Discount amount is a dollar amount up to 999,999,999.99.

Discount date 8 characters (mmddyyyy)

Invoice date 8 characters (mmddyyyy)

Line 2 of Record

Description 1 1 to 35 alpha or numeric characters.
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EXAMPLE RECORD TYPE 1

The following is an example of record type 1.
1|02152004|100|1000.00|N||||02152004
Materials|Joe Jones
STD|A0101007140|

IMPORTING OBLIGATIONS—RECORD TYPE 2
Record type 2 is used for obligations to one-time vendors. It contains three lines. 
Multiple record type 2s may exist in the import file, but only one record type 2 may exist 
for each obligation. Table 7.3 explains the field requirements for this line. 

History note 1 to 30 alpha or numeric characters.

Line 3 of Record

Distribution name A valid distribution table name.

Distribution acct A valid account number.

Check # The check # if entry is a check.

Table 7.3—Record Type 2—Field Definitions

Field Field Definition

Line 1 of Record

Type 1 character (for this line, this value is 2)

Vendor name Up to 35 characters.

Address line 1 Up to 35 characters.

Line 2 of Record

Address line 2 Up to 35 characters.

City Up to 19 characters.

State/Territory/Province Up to 5 characters.

Postal code Up to 9 characters.

Table 7.2—Record Type 1—Field Definitions (Continued)

Field Field Definition
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EXAMPLE RECORD TYPE 2

The following example refers to a vendor found in Division 95. The country field is left 
blank.

2|Mountain Rental Management|P.O. Box 1876
|45 Centennial Way|Steamboat Springs|CO|80477
|

IMPORTING OBLIGATIONS—RECORD TYPE 3
The unique references for the preceding obligation. You can use from 1 to 18 reference 
records for each obligation in the batch. Table 7.4 explains the field requirements for 
this line. 

EXAMPLE RECORD TYPE 3

Type|Reference|Reference value
3|I|45699

Line 3 of Record

Country Up to 35 characters.

Table 7.4—Record Type 3—Field Definitions

Field Field Definition

Type 1 character (for this line, this value is 3)

Reference A valid reference code like T, S, V, etc.

Reference value Up to 15 characters.

Table 7.3—Record Type 2—Field Definitions (Continued)

Field Field Definition
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IMPORTING OBLIGATIONS—RECORD TYPE 4
The obligation detail record (type 4) contains one line. There must be one detail record 
for each obligation in the batch and there may be as many as 9,999 for each obligation, 
unless you are using a distribution table (Record Type 1, Line 3). Table 7.5 explains the 
field requirements for this line. 

EXAMPLE RECORD TYPE 4

The following example includes an item number, but no stock number.
4|153||Carpet cleaner|120|can|2.9900|358.80

IMPORTING OBLIGATIONS—RECORD TYPE 5
The obligation distribution record (type 5) contains two lines. If you use combined 
entry, there must be one distribution record (type 5) for each detail record (type 4) for 
each obligation in the batch. If you use separate entry, a one-to-one relationship is not 
required for record types 4 and 5. 

Table 7.5—Record Type 4—Field Definitions

Field Field Definition

Type 1 character (for this line, this value is 4)

Item number Up to 9,999.

Stock number Up to 15 alphanumeric characters.

Description Up to 30 characters.

Units From .0001 to 999,999,999.0001.

Units description Up to a 5 character description of the units.

Unit price From .0001 to 999,999,999.9999 (4 decimal places required).

Amount The amount of the detail line.
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This record is not used if you are using a distribution table (Record Type 1, Line 
3). 

EXAMPLE RECORD TYPE 5

5|27|Printer Ink
A0103017140|850.00

IMPORTING OBLIGATIONS—IMPORT FILE EXAMPLE

This example contains one keyword, one record type zero, and three obligations. The 
first obligation is to vendor 100 for $1000. It takes no discounts, is for materials, and 
uses the STD distribution table so no record types 4 or 5 are required. The second 
obligation is to vendor 400 for $1000 with a $10 discount. The invoice is for office 

Table 7.6—Record Type 5—Field Definitions

Field Field Definition

Line 1 of Record

Type 1 character (for this line, this value is 5)

Item number Up to 9,999.

Description Up to 30 characters.

Line 2 of Record

Transaction account A valid account.

Total amount Up to 999,999,999.99.
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supplies. It has one line of detail and one line of distribution. The last obligation is to 
one-time vendor Jennifer Jones for $100 for contract labor. This obligation uses two 
lines of detail and two lines of distribution.

DIV=95
0|02282004|30||Y|2100.00|||
1|02152004|100|1000.00|N||||02152004
Materials|Joe Jones
STD|A0101007140|
3|I|45699
3|P|98-778
1|02202004|400|1000.00|Y|A|10.00|03152004|
Office Supplies|Jane Smith
||
4|1||Computer Paper|10.0000|bx|100.0000|1000.00
5|1|Computer Paper
A0103017140|1000.00
1|02112004|0|100.00|||||
Contract Labor|
||
2|Jennifer Jones|P.O. Box 789
|Steamboat Springs|CO|80477
|
3|I|February
4|1||||||25.50
4|2||||||74.50
5|1|
A0200006114|25.50
5|2|
A0300006114|74.50

IMPORTING OBLIGATIONS—BUSINESS RULES

• If the import is to be saved, the Save Imports field (field 6 on the Extended 
Basic Setup parameter) must be set to “Y.” 

• A batch may not be saved if it involves checks.
• The program will overwrite any existing batch file with the same name. 

Therefore, if you do not want to replace an existing batch, ensure that the batch 
names are unique.
Importing Obligations 
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IMPORTING OBLIGATIONS—IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

For example, if your TTY number is 864, the line # is 0864. So the error file name is:
• OT0864.Y

For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

IMPORTING OBLIGATIONS—IMPORTING THE FILE

To import the obligation file from the Execute Programs task (see General Instructions 
for Importing Files on page 129), enter the required information according to Table 7.7. 

You can also go to your DOS prompt, type AFWRUN, and enter the program 
name to run the program from outside FundWare. 

OT + 0000 + .Y

OT + Line number
(Line number is 0 + your TTY number)

+ .Y

Table 7.7—Importing Obligations—Importing the File

Field Entry

Program Name CUSOT20

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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IMPORTING OBLIGATIONS—IMPORT FILE ERRORS

When the file has been imported, the batch will display in the Imported Batches folder 
of the Accounts Payable folder tree. Any errors found during the import task will be 
reflected in the Errors column of the Imported Batches folder. Also, The import task 
details any errors in an error report saved to the FundWare > Data folder with the 
following name: 

So the error file for a Division 95 import is:
• OTX0864.L95

If there are errors, review the error report to determine their causes. Correct the import 
file and run the program again.

By viewing the obligations in the imported batch, you can see which obligations 
have errors. However, you cannot correct the obligations from the Imported 
Batches folder. You must restore the batch to a stage and correct the obligation 
in the New folder of the stage. See Importing Obligations—Restoring an 
Imported Batch on page 141 for more information.

IMPORTING OBLIGATIONS—VIEWING AN IMPORTED BATCH

You can view your imported batches from the Imported Batches folder.
1.  Click Open… on the module navigator (if the module is not expanded, click 

Accounts Payable first) or select Accounts Payable > Open… from the menu 
bar. AP folder tree displays.

2. Click the Imported Batches folder to display all current imported batches in 
the folder tree. A summary of each batch displays in the detail pane.

3. Select the batch that you want to view. The obligations in the batch display in 
the detail pane.

4. To view an individual obligation in the batch, double-click the obligation or 
select the obligation and click View. (You can also right-click and select View 
from the shortcut menu.) The obligation details display.

OTX + 0000 + .L##
(## represents your division number)
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IMPORTING OBLIGATIONS—RESTORING AN IMPORTED BATCH

When you “restore” an imported batch, you move it to the New folder of one of your 
stages. You can then correct any errors before posting the obligations.

The size of the batch file can greatly impact the time that this process can take. 
Your cursor will display as an hourglass while the batch is being restored. 
Please be patient.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Accounts Payable first) or select Accounts Payable > Open… from the menu 
bar. AP folder tree displays.

2. Click the Imported Batches folder to display all current imported batches in 
the folder tree. A summary of each batch displays in the detail pane.

3. Select the batch and click Restore. The system asks you to select the stage to 
which you are restoring this imported batch (e.g., Invoices).

Your current business date should match the batch business date. If 
these dates are not in agreement, a message will display offering you 
the chance to change your business date.

4. Select the stage from the drop-down list.

5. Click OK. The imported obligations are saved to the New folder of the selected 
stage.

6. You can now post any error-free obligations. If any obligations have errors, you 
must correct the errors before you can post.

IMPORTING OBLIGATIONS—DELETING AN IMPORTED BATCH

Use the following instructions to delete an imported batch.
1.  Click Open… on the module navigator (if the module is not expanded, click 

Accounts Payable first) or select Accounts Payable > Open… from the menu 
bar. AP folder tree displays.

2. Click the Imported Batches folder to display all current imported batches in 
the folder tree. A summary of each batch displays in the detail pane.

3. Select the batch and click Delete. A confirmation message displays.
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4. Click Yes to delete the imported batch. Once the deletion process is complete, 
the batch is removed from the Imported Batches folder. If the deleted batch 
was the only batch, the Imported Batches folder is removed.

IMPORTING VENDORS
Use this task to import new vendors and changes to current vendors. When you are 
making a change, you only need to include the vendor number and the information 
being changed.

IMPORTING VENDORS—IMPORT FILE FORMAT

The text files cannot contain special characters. Special characters, such as tabs and 
form-feeds, are typically characters that are not printable. Each line of text must be 
terminated with the line terminator for the operating system. For example, in MS-DOS 
the line terminator is a carriage return/new line sequence.

KEYWORD RECORD

The keyword record is the first line of the import text file. (There can only be one 
keyword record per import file.) The keyword record must contain the division number 
and may contain a separator character. If no separator character is indicated, the “|” (pipe 
sign) character is assumed. The format for the keyword record is: 

The remaining lines of the file identify the information that you are importing to your 
Accounts Payable system. Each line is broken into three units:

• The first two characters indicate the type of information (e.g., Vendor number) 
and is a number between 00 and 08.

• The third character is the separator character. (Again, the pipe sign is the default 
separator character.)

• The next characters are the values for the field. If there are multiple values, use 
the separator character, without any additional spaces, between each value. 

DIV = nn SEP = x

where

• nn is the division number

• x is the separation character
Importing Vendors 
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IMPORTING VENDORS—IMPORT FILE FORMAT

You can only import information for a vendor once within the same import file. For 
example, the following incorrect import file has two changes to vendor 200, both in the 
same file but entered separately:

Div=95
00|200
03|27 Crawford Avenue||Steamboat Springs|CO|80477|USA
00|200
05|3035557015|3035553144

The following file would import these changes correctly:
Div=95
00|200
03|27 Crawford Avenue||Steamboat Springs|CO|80477|USA
05|3035557015|3035553144

IMPORTING VENDORS—FIELD DEFINITIONS

Table 7.8 provides definitions for the account import fields. 

Table 7.8—Vendor Text Files Fields and Definitions

Type Field Values Maximum Field Size

00 Vendor number  9 digits

01 Sortkey 10 characters

02 Name 35 characters

03 Street 1|Street 2|City|STP|Post 
code|Country

Vendor’s primary address
35 characters|35 characters|19 characters|5 characters|
9 characters|35 characters

04 Street 1|Street 2|City|STP|Post 
code|Country

Vendor’s secondary address
35 characters|35 characters|19 characters|5 characters|
9 characters|35 characters

05 Phone #|Fax # 10 digits|10 digits

06 Note 1|Note 2 20 characters|20 characters
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Although the system will allow up to 138 characters for all fields for either the 
Primary or Secondary address (Street 1 through Country), you will receive an 
error message if the total number of characters is greater than 97.

IMPORTING VENDORS—IMPORT FILE EXAMPLE

The following example adds vendor 2010 and changes the discount rate for vendor 200.
Div=95
00|2010
01|REC SUPPLY
02|Recycled Business Supply
03|37 Main Street|P.O. Box 4467|Steamboat Springs|CO|80477|USA
04|1466 S. Lincoln Avenue|P.O. Box 4039|Steamboat Springs|CO|80477|USA
05|3038795770|3038796850
06|27-1789902|supplies
07|Y|1.50|10
08|30
00|200
07|Y|3.00|30

07 Disc|percent|days 1 character|5 digits|3 digits
Disc options are:
• Y—Discount normally given.
• N—Discount not normally given.
Note: The percent field will ignore the placement of a 
decimal point and assume that the last two digits in the field 
are to the right of the decimal.
• 1.1 gets imported as .11
• 9 gets imported as .09
• 12.34 gets imported as 12.34
Note: Your maximum percent entry should be 100.00%. Any 
entry greater than 100.00% can cause errors with the 
program.

08 Net days 3 digits

Table 7.8—Vendor Text Files Fields and Definitions (Continued)

Type Field Values Maximum Field Size
Importing Vendors 
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IMPORTING VENDORS—IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

For example, you are ready to import the file, so you log onto your computer and check 
the TTY number, which is 864. Therefore, the line number is 0864 and the import name 
must be:

• OT0864.Z
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

IMPORTING VENDORS—IMPORTING THE FILE

To import the vendor file from the Execute Programs task (see General Instructions for 
Importing Files on page 129), enter the required information according to Table 7.9. 

You can also go to your DOS prompt, type AFWRUN, and enter the program 
name to run the program from outside FundWare. 

OT + Line number
(Line number is 0 + your TTY number)

+ .Z

Table 7.9—Importing Vendors—Importing the File

Field Entry

Program Name CUSOT10

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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IMPORTING VENDORS—IMPORT FILE ERRORS

When you run the import task, the system checks the file for errors. If errors are found, 
the error report is saved to the FundWare > Data folder with the following name: 

For example, if your TTY number is 864, the line # is 0864. So the error file for a 
Division 95 import is:

• OTX0864.L95
If there are errors, review the error report to determine their causes. Correct the import 
file and run the program again.

IMPORTING CHECK RECONCILIATION FILES
This task imports a text file of cleared checks into the Accounts Payable module. If there 
is an error in an import file, that record is not imported. A report is produced that shows 
additions and any errors. For each successfully imported record, the report lists the field 
number in which the error occurred and the information in that field.

IMPORTING CHECK RECONCILIATIONS—IMPORT FILE FORMAT

The text files cannot contain special characters. Special characters, such as tabs and 
form-feeds, are typically characters that are not printable. Each line of text must be 
terminated with the line terminator for the operating system. For example, in MS-DOS 
the line terminator is a carriage return/new line sequence.
The import file must be a text file with:

• One and only one keyword record.
• One and only one type 1 record—the bank record.

OTX + Line number
(Line number is 0 + your TTY number)

+ .L##
(## represents your division number)
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KEYWORD RECORD

The keyword record is the first line of the import text file. The record must contain the 
division number and may contain a separator character. If no separator character is 
indicated, the “|” (pipe sign) character is assumed. The format for the keyword record is: 

The remaining lines of the file identify the information that you are importing to your 
Accounts Payable system. Each line is broken into three units:

• The first character indicates the type of information (e.g., account number) and 
is either 1 or 2.

• The third character is the separator character. (Again, the pipe sign is the default 
separator character.)

• The next characters are the values for the field. If there are multiple values, use 
the separator character, without any additional spaces, between each value. 

IMPORTING CHECK RECONCILIATIONS—IMPORT FIELD DEFINITIONS

Table 7.10 provides definitions for the account import fields. 

DIV = nn SEP = x

where

• nn is the division number

• x is the separation character

Table 7.10—Import Bank Reconciliation Information—Field Definitions

Type Field Values Maximum Field Size

1 Record type #|Bank code 1|10 characters
• You can define only one type 1 line per import file.

2 Record type #|check#|Amount 2|7digits|999,999,999,999.99 maximum
• Amount should include cents but cannot include 

dollar signs.
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IMPORTING CHECK RECONCILIATIONS—IMPORT FILE EXAMPLE

The following example adds 3 checks for reconciliation:
DIV=02
1|Bank 23
2|8907867|897.00
2|8907868|56.50
2|8907869|5834.25

IMPORTING CHECK RECONCILIATIONS—IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

For example, you are ready to import the file to Division 95, so the import name must 
be:

• OT0000.C

IMPORTING CHECK RECONCILIATIONS—IMPORTING THE FILE

To import the check reconciliation file from the Execute Programs task (see General 
Instructions for Importing Files on page 129), enter the required information according 
to Table 7.11. 

You can also go to your DOS prompt, type AFWRUN, and enter the program 
name to run the program from outside FundWare. 

OT + 0000 + .C

Table 7.11—Importing Check Reconciliations—Importing the File

Field Entry

Program Name OCW048

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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IMPORTING CHECK RECONCILIATIONS—IMPORT FILE ERRORS

When you run the import task, the system checks the file for errors. If errors are found, 
the error report is saved to the FundWare > Data folder with the following name: 

For example, the error file for a Division 95 import is:
• OTX0000.L95

If there are errors, review the error report to determine their causes. Correct the import 
file and run the program again.

SCREEN MESSAGES FOR AP IMPORT TASKS
These first three messages may appear on the screen as you execute the program.

• Errors have occurred in extract!—The text file is formatted incorrectly. Correct 
text file and execute task again.

• Errors have occurred in edit!—Text file was in correct format but information 
did not pass the validation criteria. Correct text file and execute task again.

• Function Complete!—No errors were found and the entire text file was 
imported.

REPORT MESSAGES FOR AP IMPORT TASKS
The following messages refer to errors found in the import file and are shown on the 
error report. If errors are reported, correct the errors in the import file and resubmit the 
import file.

• Bank not in system—A batch containing checks specifies a bank not defined in 
the system.

• Batch may not be saved—The batch may not be saved because the parameter 
record is defined to not allow import batches to be saved. Change the save 
import flag in the parameter record to “Y”.

• Batch name already in system—The batch may not be saved because the batch 
name specified in the import file already exists in the system. Correct text file.

OTX + 0000 + .L##
(## represents your division number)
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• Cannot save a check batch—A batch containing checks may not be saved.
• Date not numeric—A date field in the text file contains alpha characters. 

Correct date fields.
• Distribution not in system—Distribution table entered in text file which is not 

currently defined. Correct distribution table name or define new distribution 
table.

• Division must be 01–99—Division number is not 1 through 99. Correct text file 
and execute task again.

• Division not in system—Division number is not currently defined. Correct text 
file and execute task again or define the new division.

• Duplicate detail—Text file contains detail lines for an obligation with the same 
item number. Correct text file.

• Duplicate field use—Text file contains more than one of the same type of record 
number for a single vendor number. Correct text file. 

• Duplicate reference—A reference exists more than one in text file for an 
obligation. Correct text file.

• Field not numeric—An amount field contains alphabetic characters. Correct 
amount fields.

• Field number not numeric—The first two digits in the first field of the record 
specify which record type to import. They are not numeric or not specified. 
Correct the record type fields.

• File not in system—The import file for this task was not found. This error will 
cause the entire import to be aborted. Make sure the file has the correct name 
and is in the FundWare Data directory. Correct and resubmit the import 
file.Invalid detail transaction account.

• Account numbers entered in—Correct text file or define new accounts. If the 
text file does not exist in chart—import batch is to be saved, this message is of 
accounts—only a warning. The obligation was saved, but the detail transaction 
was flagged as an error and must be corrected before the obligation may be 
posted.

• Invalid discount—In the vendor import file, the discount code is invalid. The 
only valid options are Y—Discount normally given, and N—Discount not 
normally given. Correct the text file.

• Invalid discount date—Discount date entered for obligation header is not a valid 
calendar date or 00/00/0000. Correct the text file.

• Invalid discount type—Invalid discount type is entered in obligation import text 
file. Correct text file.
Report Messages for AP Import Tasks 
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• Invalid field number—The record type number entered in text file is not in the 
range of numbers for the task. Correct text file.

• Invalid obligation date—Stage date entered for obligation header is not a valid 
calendar date. Correct the text file.

• Invalid posting date—Business date entered in batch record is not a valid 
calendar date existing in a valid date table. Correct the text file or define a new 
date table.

• Invalid reference—Invalid reference entered in text file. Correct text file or 
define new reference. If the import batch is to be saved, this message is only a 
warning, the obligation was saved but this reference was not added.

• Invalid vendor name—The vendor name must be at least three alpha or numeric 
characters.

• Keyword not recognized—Keyword record is incorrect. Correct text file and 
execute task again.

• Missing required field—A required field is missing. Add required records and 
fields to the import text file.

• No obligation for vendor—An obligation record type 2 (one time vendor) exists 
in text file without an associated record type 1 (obligation header). Correct text 
file.

• No parameters supplied—Keyword record is missing from text file. Add 
keyword record to text file and execute task again.

• No transactions to post!—The obligations import text file does not contain any 
obligations. Correct the text file and execute the task again.

• Out of Balance nnn.nn Batch Total—Total amount of obligations in text file 
does not match batch total. Correct text file. If the import batch is to be saved, 
this is only a warning message.

• nnn.nn Obligation Total—Total of all detail lines for an obligation does not 
match total for obligation entered in header record. Correct text file.

• Parameter not in system—Accounts Payable module is not yet defined. Set up 
your Accounts Payable module.

• Stage cannot be less than paid—The text file contains a stage number that is 
defined as less than paid. Those batches involving checks must post to a stage 
above that defined as paid in the parameter record.

• Stage does not allow entry—The obligation stage in the text file is not defined 
to allow new obligations to be entered. Correct stage number in text file or 
change the stage definition to allow new entries.
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• Stage not in system—The text file contains a stage number that is not defined 
for this division. Correct stage number in text file or define stage in Accounts 
Payable module.

• Vendor not in system—Text file contains vendor number not currently defined 
in your system. Correct vendor number in text file or define new vendor.

• Vendor may not be used—In the vendor import task, you cannot add or change 
vendors with the vendor number 0, (one time vendors).

• Vendor N/A not allowed—A type 2 (one time vendor) record exists in text file 
for an obligation assigned to a specific vendor. Correct text file.

EXPORTING OBLIGATIONS
This task exports obligations from the Accounts Payable module to a text file. Features 
include: 

• Text file compatibility with CUSOT20 obligation import task.
• Selection by reference value and stage reference date for obligations. Bank 

selection provided for stages involving checks.
• User definition of the destination division and separator character.
• Flagging of exported obligations preventing multiple processing of obligations.
• Capability of resetting the export flags if problems are encountered in the 

import process.

EXPORTING OBLIGATIONS—REQUIREMENTS AND CAUTIONS

• Obligations must have all detail at the specified stage as no partial export will be 
done.

• If the stage is in the check writing system, all checks must be logged and cut 
against the specified bank.

• Use caution if you use the export flags option; it could result in exporting an 
obligation twice.

EXPORTING OBLIGATIONS—CREATING THE FILE

You can create the export text file from the Execute Programs task.
1.  Open an instance of FundWare.
Exporting Obligations 
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2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 7.1). 

Figure 7.1—System Utilities—Executing a Program

4. In the Execute Program area, enter the required information according to Table 
7.12 to run the override. 

5. Click Run. The system asks you to identify from which stage you are exporting 
information.

Table 7.12—Creating an Obligation Export File

Field Entry

Program Name CUSOT30

Switches • 1—For extraction 
• 2—For reset of flag

Parameters Leave blank.

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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6. Enter the stage number. The export task displays (Figure 7.1). 

Figure 7.1—Creating an Export File

7. Complete the required information according to Table 7.13. 

8. Type 0 to accept your entries. When the task is complete, the file is saved to the 
FundWare > Data folder and you return to the System Utilities window.

Table 7.13—Export Obligations File—Fields and Associated Options

Field Options

Reference Enter the reference to be used in selection.

Reference value Enter the reference value range to be used in selection.

Stage date Enter the date range to be used in selection.

Group name Enter the group name (RAM) to be used in selection.

Bank Enter the bank name to be used in selection.

To division Enter the division number for which this file is destined.

Separator char Enter the desired separator character to be used in the text file. This char may not 
be '-', '.', '/' or a space.

Report mode Enter “E” to report only obligations exported.
• Enter “A” to report all obligations scanned and their status.

Batch name Enter a five-character batch name if the batch is to be saved by CUSOT20.
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EXPORTING OBLIGATIONS—EXPORT FILE NAME

When you run the export task, the system saves the file to the FundWare > Data folder 
with the following name: 

For example, if your Station ID number is 864, the error file name is:
• OTX0864.Y

If you update this data after the export file is created, it will result in a data 
discrepancy between the export and import sites. To prevent this from 
happening, you can close the period to data entry immediately after you create 
the file.

For more information on Station ID numbers, see Appendix F—Determining Your 
Station ID on page 355.
The task also creates a report with the following name: 

For example, if you export information for Division 95, the file name is:
• OTXTRK.L95

 

OTX + 0 + your Station ID number + .Y

OTX + TRK (for exports)
RST (for flag resets)

+ .L##
(## represents your division number)
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C H A P T E R  8

IMPORTING PAYROLL INFORMATION

This section explains how to import data into your Payroll/Personnel system:
• Employee master records,
• Employee direct deposit files, 
• Employee history files,
• Employee timesheets, and
• Check reconciliations. 

IMPORTING EMPLOYEE INFORMATION
The tasks to import employee master records, employee direct deposit files, and 
employee history files are very similar because you use the same Execute Programs task 
to define the format of the text file. Once you have defined one or more formats, you use 
the same Execute Programs task to import the file.

1.  Create one or more text file formats via an Execute Programs task. This doesn’t 
import the text file itself. 

The text files cannot contain special characters, such as tabs and form-
feeds. Each line of text must end with the line terminator for the 
operating system. In MS-DOS, the line terminator is a carriage return/
new line sequence.

2. Create the text files to be imported using any text editor, database, or word 
processor. 

3. Execute the import program to bring the data from the text file into the Payroll/
Personnel module via another Execute Programs task.
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THE IMPORT FORMAT

Two types of file formats can be used:
• Delimited file formats—One in which the length of each field in the file is not 

pre-defined. For example, the following fields are both acceptable because the 
field delimiter (in this case the pipe [|]) defines where each field begins and 
ends:
— 100|Smith|Admin|2000.00

10101123|Jones|Sales|3000.00
• Fixed-file formats—Does not use delimiters, rather the line, column, and length 

positions determine where the fields begin and end. Using the previous 
example, the format may be defined as shown in Table 8.1. 

A fixed format text file The text file would be:

— 0000000100Smith Admin 2000.00
0010101123Jones Sales 3000.00

CREATING THE IMPORT FORMAT

You can create your import format from the Execute Programs task.
1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

Table 8.1—Fixed-File Format

Field Column Length

Employee number 1 10

Last name 11 30

Department 42 10

Salary 52 12
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3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 8.1). 

Figure 8.1—System Utilities—Executing a Program

4. To define the file format from the Execute Programs task, enter the required 
information according to Table 8.2. 

5. Click Run. The system asks you to enter the import format name.

You can also go to your DOS prompt, type AFWRUN, and enter the 
program name to run the program from outside FundWare. 

6. Enter up to 10 alphanumeric characters. No embedded spaces are allowed. We 
recommend that you enter a name that is meaningful to your organization. The 
system asks if you are copying this format from an existing import format.

Table 8.2—Creating the Import Format

Field Entry

Program Name CUSPY08

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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7. Leave the Copy import field blank if you are not copying this format from an 
existing import format, or press F1 to select from a list of currently defined 
import formats. The first page of the import format definition displays (Table 
8.2). 

Figure 8.2—Payroll Import Format—Page 1 of 2

8. Complete the required fields according to Table 8.14. 

9. When complete, press ENTER. The second page of the task displays.

Table 8.3—Import Format Field Definitions—Page 1 of 2

Field Valid Entry Definition

Description 30 characters Description of the import.

Info type E
H
T

• Select E—Import employee information (i.e., employee 
master records and direct deposit).

• Select H—Import employee history information.
• Option T is used for timesheets (see Employee 

Timesheet File Formats on page 171).

Import type 1
2

• 1—Delimited import file.
• 2—Fixed format import file.

• Delimited by 1 character If the import type option is set to delimited, enter the 
character used as a separator between imported fields.

Record count 1 to 99 The number of records required for one master record to 
be imported.
Importing Employee Information 
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10. For the remainder of the task, you will define the data items included in your 
import file, as well as their specific location within the import file. Use the 
instructions in Table 8.4 to complete these fields. 

Table 8.4—Import Format Field Definitions—Page 2 of 2

Field Valid Entry Definition

Data item Employee data 
item

The existing employee data item to be imported. Press F1 
in this field to display a list of currently defined employee 
data items.

• Entry from C
R

For multiple value data items, enter the entry value.
• C—Value is a constant.
• R—Value is from an imported record.
These options and their associated fields are explained 
further below.

• Value from C
R

For single occurring data items, enter the value.
• These from fields have the same options for the selected 

employee data item. Any combination of options is valid.
• C—Value is a constant.
• R—Value is from an imported record.
These options and their associated fields are explained 
further below.

Data Item field options—Any of the following fields may display, depending on the option you enter for 
the data item fields above.

• Constant varies with the 
data item 
definition

If the selection is “Constant,” enter the constant value. 
Valid entries for this field vary depending on the data item 
definition.

• Record 1 to 99 If the selection is “Record,” indicate which record (from the 
group of records that make up each master record), 
contains the field to be imported.

• Position 1 to 99 If the selection is “Record” and Import type is set to 
Delimited, enter the position within the record that contains 
the field to be imported.

• Column 1 to 250 If the selection is “Record” and Import type is set to Fixed 
format, enter the column within the fixed record that 
contains the field to be imported.

• Length 1 to 55 If the selection is “Record” and Import type is set to Fixed 
format, enter the length of the field being imported.
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CREATING YOUR IMPORT TEXT FILE

Create your text files for importing data using any text editor, database word processor, 
or any other software application. The text files cannot contain special characters, such 
as tabs and form-feeds. The content of the import file is determined by the type of data 
you are importing (master records, history, or timesheets) and the format you have 
chosen. At a minimum, the file must contain the employee number (data item 
.EMPLOYEE) to import. In addition, the following rules apply:

• All dates have the format mmddyyyy.
• All dates must be valid and the posting date cannot be in a closed period.
• All dollar amounts must use numbers and no $ characters. Their maximum size 

is 999,999,999 (999 million).
• All files must begin with a keyword record.

KEYWORD RECORD

The first line of the import text file identifies the division and may also identify the 
separator character. If no separator character is defined here, the | (pipe sign) is used as 
the default. The format is: 

Specific examples of for each employee import are provided in the following sections.

DIV = nn SEP = x IMPORT = name POST = mmddyyyy FUNC = 1/m DDEC=Y/N

where

• nn is the division number

• x is the separation character

• name is the import file definition name. The default is IMPORT.

• mmddyyyy is the posting date. The default is today’s date.

• I/M is the type of posting. This is only used for employee master records. It is not required in the 
keyword record if timesheets or history is being imported. Must be Initial (“I”) or Modify (“M”). The 
default is “I” for initial

• Y/M is the default use of decimal points. A “Y” value causes decimal points to be placed in numeric 
fields when no decimal point is found. For example, for an amount field, “45” becomes .45 and for a 
rate field it becomes .000045. An “N” value assumes no decimal positioning. For example, for an 
amount field, “45” becomes $45.00 and for a rate field 45.000000. If a decimal point is found in a field, 
the Y or N value in DDEC is disregarded, and the decimal point is used just as it exists in the import 
file.
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IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

Because many import types (employee master record, direct deposit, history, 
and timesheet) use the same file name, you can only have one import file in 
your system at any one time.

For example, you are ready to import the file, so you log onto your computer and check 
the TTY number, which is 864. Therefore, the line number is 0864 and the import name 
must be:

• PY0864.Y
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

IMPORTING YOUR EMPLOYEE INFORMATION

You will use the same import program to import your employee master record, 
employee direct deposit file, and employee history file.

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

PY + Line number
(Line number is 0 + your TTY number)

+ .Y
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3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 8.3). 

Figure 8.3—System Utilities—Executing a Program

4. To define the file format from the Execute Programs task, enter the required 
information according to Table 8.5. 

5. Click Run. The system asks you to enter the import format name.

You can also go to your DOS prompt, type AFWRUN, and enter the 
program name to run the program from outside FundWare. 

Table 8.5—Importing Employee Information

Field Entry

Program Name CUSPY20

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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IMPORT FILE ERRORS

When you run the import task, the system checks the file for errors. If errors are found, 
the error report is saved to the FundWare > Data folder with the following name: 

For example, if your TTY number is 864, the line # is 0864. So the error file for a 
Division 95 import is:

• PYX0864.L95
If there are errors, review the error report to determine their causes. Correct the import 
file and run the program again.

IMPORTING THE EMPLOYEE MASTER RECORD—WHAT CAN YOU IMPORT?
Table 8.6 defines some of the information that you can import to your Payroll system 
using the Import Employee Master Record task. 

PYX + Line number
(Line number is 0 + your TTY number)

+ .L##
(## represents your division number)

Table 8.6—Employee Master Records—Possible Fields and Field Sizes

Field Description Maximum Field Size

Employee number 9 digits

Name–first 30 characters

Name–middle initial 10 characters

Name–last 30 characters

Street 1 55 characters

Street 2 55 characters

City 30 characters

STP 10 characters

Postal code 10 characters

Country 30 characters

Home phone number 10 digits

Emergency contact 30 characters
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In addition to the fields in Table 8.6, you may have user-defined data items that you 
want to import. You must be aware of the maximum field size for these fields when you 
define your import format and import text file.

Emergency phone number 10 digits

Alternate contact 30 characters

Alternate phone number 10 digits

Birth date 8 digits

Hire date 8 digits

Last review date 8 digits

Probation date 8 digits

Termination date 8 digits

Employee gender 2 digits

Social Security number 30 characters

Employment status 10 characters

Payment status 10 characters

Pay frequency 2 characters

Home department 10 characters

Salary 13 digit number with 2 decimal places

Hourly rate 9 digit rate with six decimal places

Other rate 10 characters

Other department 10 characters

GLA 10 characters

Additional basis for 55 characters

Dept’l salary/hourly/other 5 digits

% expensed 9 digit rate with six decimal places

Department 10 characters

Table 8.6—Employee Master Records—Possible Fields and Field Sizes (Continued)

Field Description Maximum Field Size
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EXAMPLE EMPLOYEE MASTER RECORD IMPORT

The following delimited file format example contains one keyword record and one 
employee to be imported. The format (MASTER) has been defined to recognize the pipe 
as the separator. (Because this employee equals one import record, the information 
should be on one line in the text file. This example has line breaks due to the width of 
the page.)

DIV=95 IMPORT=MASTER POST=01312004 FUNC=I DDEC=N
1001|Elizabeth|K.|James,101 South Street|P.O. Box 
111|Denver|CO|80122|3035534788|Michael 
James|3035534781|12091965|01042004||F|123-44-5566|A|P|HOURLY 
SM|Admin|6.00|1|100.00|1|Ice rink

Table 8.7 takes each entry in the import example and defines the associated fields. 

Table 8.7—Employee Master Records—Delimited File Example Entries and Fields

Entry Field Name Import Field

DIV=95 IMPORT=MASTER 
POST=01312004 FUNC=I DDEC=N

Keyword record
Import file name: MASTER

1001 Employee # 1

Elizabeth|K.|James Employee first/middle/
last name

2/3/4

101 South Street Street address 1 5

P.O. Box 111 Street address 2 6

Denver|CO|80122 City/STP/Post code 7/8/9

3035534788|Michael James|3035534781 Home phone number/
Emergency contact/
Emergency phone number

10/11/12

12091965|01042004|| Date of birth/Date of hire/
Date of termination

13/14/15
(Note: This is an empty 
field in the import file.)

F|123-44-5566 Gender/Social security 
number

16/17

A|P|HOURLY SM Employment status/
Payment status/Pay 
frequency

18/19/20
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IMPORTING THE EMPLOYEE DIRECT DEPOSIT FILE—WHAT CAN YOU IMPORT?
Table 8.8 defines some of the information that you can import to your Payroll system 
using the Import Employee Direct Deposit File task. 

EXAMPLE EMPLOYEE DIRECT DEPOSIT FILE

This delimited file format example contains one keyword record and one employee to be 
modified. The format (DIRDEP) has been defined to recognize the pipe as the separator.

DIV=95 IMPORT=DIRDEP POST=01312004 FUNC=M DDEC=N
1001|Y|1|Y|1|C|1|R|1|12345678|1|80 1234

Admin|6.00 Home department/Hourly 
rate of pay

21/22

1|100.00|1|Ice rink Percent expensed-hourly 
earnings: entry #/value for

23/24/25/26

Table 8.8—Employee Direct Deposit File—Possible Fields and 
Field Sizes

Field Description Maximum Field Size

Employee number 9 digits

EFT active 10 characters

EFT selection 10 characters

EFT line entry 5 digits

EFT cycle 10 characters

Deposit or Payment 10 characters

Amount/Percent/Remainder 10 characters

Amount/Percent 13 digit number with 2 decimal places

Bank DFI # 30 characters

Bank account # 30 characters

Table 8.7—Employee Master Records—Delimited File Example Entries and Fields (Continued)

Entry Field Name Import Field
Importing Employee Information 



Chapter 8—Importing Payroll Information
Table 8.9 takes each entry in the import example and defines the associated fields. 

IMPORTING THE EMPLOYEE HISTORY FILE—WHAT CAN YOU IMPORT?
Table 8.10 defines some of the information that you can import to your Payroll system 
using the Import Employee History File task. 

Table 8.9—Employee Direct Deposit File—Delimited File Example Entries and Fields

Entry Field Name Import Field

DIV=95 IMPORT=EFT POST=01312004 
FUNC=M DDEC=N

Keyword record
Import file name: EFT

1001|Y Employee #/Active flag 1/2

1|Y EFT line entry #/EFT cycle 3/4

1|C EFT line entry #/EFT Deposit or 
Payment

5/6

1|R EFT line entry #/EFT Amount, 
Percent, Remainder

7/8

1|12345678 EFT line entry #/EFT Bank Transit, 
Routing #

8/10

1|80 1234 EFT line entry #/Bank account # 11/12

Table 8.10—Employee History File—Possible Fields and Field Sizes

Field Description Maximum Field Size

Employee number 9 digits

Hours/units 11 digit number with 6 decimal places

Amount 14 digit number with 2 decimal places

Basis/hours/units 11 digit number with 6 decimal places

Basis amount 14 digit number with 2 decimal places
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EXAMPLE EMPLOYEE HISTORY IMPORT FILE

This delimited file format example contains one keyword record and one employee to be 
modified. 

DIV=95 IMPORT=HISTORY POST=01312004 FUNC=M DDEC=N
1001
83.3 83.3 500.00
31.00 500.00
31.00 500.00
7.25 500.00
7.25 500.00
12.00 500.00
7.00 500.00

Table 8.11 takes each line of the import file and defines the associated field. 

Table 8.11—Employee History File—Delimited File Example Entries and Fields

Entry Field

DIV=95 IMPORT=HISTORY POST=01312004 FUNC=M DDEC=N Keyword record
Import file name: HISTORY

1001 Employee #

83.3 83.3 500.00 Hrs-units/basis hrs-units/amount/
basis amt

31.00 500.00 Hrs-units/basis hrs-units/amount/
basis amt

31.00 500.00 Hrs-units/basis hrs-units/amount/
basis amt

7.25 500.00 Hrs-units/basis hrs-units/amount/
basis amt

7.25 500.00 Hrs-units/basis hrs-units/amount/
basis amt

12.00 500.00 Hrs-units/basis hrs-units/amount/
basis amt

7.00 500.00 Hrs-units/basis hrs-units/amount/
basis amt
Importing Employee Information 



Chapter 8—Importing Payroll Information
EMPLOYEE HISTORY REGISTER

If you are importing an Employee History file, the system will file an Employee History 
Register (PYEHIST.L##, where ## represents your division number).

EMPLOYEE TIMESHEET FILE FORMATS
The Import Employee Timesheets task is similar to the other Payroll import tasks: the 
format of the text file is user-defined (in other modules, the format is system-defined). 
Additionally, you can define multiple formats for use by these tasks.

1.  Create one or more text file formats via an Execute Programs task. This doesn’t 
import the text file itself. 

The text files cannot contain special characters, such as tabs and form-
feeds. Each line of text must end with the line terminator for the 
operating system. In MS-DOS, the line terminator is a carriage return/
new line sequence.

2. Create the text files to be imported using any text editor, database, or word 
processor. 

3. Execute the import program to bring the data from the text file into the Payroll/
Personnel module via another Execute Programs task.

CREATING THE TIMESHEET IMPORT FORMAT

You can create your import format from the Execute Programs task.
1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)
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3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 8.4). 

Figure 8.4—System Utilities—Executing a Program

4. To define the file format from the Execute Programs task, enter the required 
information according to Table 8.12. 

5. Click Run. The system asks you to enter the import format name.

You can also go to your DOS prompt, type AFWRUN, and enter the 
program name to run the program from outside FundWare. 

6. Enter up to 10 alphanumeric characters. No embedded spaces are allowed. We 
recommend that you enter a name that is meaningful to your organization. The 
system asks if you are copying this format from an existing import format.

Table 8.12—ICreating the Timesheet Import Format

Field Entry

Program Name CUSPY06

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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7. Leave the Copy import field blank if you are not copying this format from an 
existing import format, or press F1 to select from a list of currently defined 
import formats. The first page of the import format definition displays (Figure 
8.5). 

Figure 8.5—Timesheet Import Format—Page 1 of 3

8. Complete the required fields according to Table 8.13. 

Table 8.13—Import Format Field Definitions—Page 1 of 2

Field Valid Entry Definition

Description 30 characters Description of the import.

Info type E
H
T

Select T—Import timesheet information.

Import type 1
2

• 1—Delimited import file.
• 2—Fixed format import file.

• Delimited by 1 character If the import type option is set to delimited, enter the 
character used as a separator between imported fields.

Record count 1 to 99 The number of records required for one master record to 
be imported.
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9. When complete, press ENTER. The second page of the task displays (Figure 
8.6). 

Figure 8.6—Timesheet Import Format—Page 2 of 3

10. For the remainder of the task (pages 2 and 3), you will define the data items 
included in your import file, as well as their specific location within the import 
file. Use the instructions in Table 8.14 to complete these fields. 

Table 8.14—Import Timesheet Format Field Definitions—Pages 2 and 3

Field Valid Entry Definition

Data item Employee data 
item

The existing employee data item to be imported. Press F1 
in this field to display a list of currently defined employee 
data items.

• Entry from C
R

For multiple value data items, enter the entry value.
• C—Value is a constant.
• R—Value is from an imported record.
These options and their associated fields are explained 
further below.

• Value from C
R

For single occurring data items, enter the value.
• These from fields have the same options for the selected 

employee data item. Any combination of options is valid.
• C—Value is a constant.
• R—Value is from an imported record.
These options and their associated fields are explained 
further below.
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CREATING YOUR IMPORT TEXT FILE

Create your text files for importing data using any text editor, database word processor, 
or any other software application. The text files cannot contain special characters, such 
as tabs and form-feeds. The content of the import file is determined by the type of data 
you are importing (master records, history, or timesheets) and the format you have 
chosen. At a minimum, the file must contain the employee number (data item 
.EMPLOYEE) to import. In addition, the following rules apply:

• All dates have the format mmddyyyy.
• All dates must be valid and the posting date cannot be in a closed period.
• All dollar amounts must use numbers and no $ characters. Their maximum size 

is 999,999,999 (999 million).
• All files must begin with a keyword record.

Data Item field options—Any of the following fields may display, depending on the option you enter for 
the data item fields above.

• Constant varies with the 
data item 
definition

If the selection is “Constant,” enter the constant value. 
Valid entries for this field vary depending on the data item 
definition.

• Record 1 to 99 If the selection is “Record,” indicate which record (from the 
group of records that make up each master record), 
contains the field to be imported.

• Position 1 to 99 If the selection is “Record” and Import type is set to 
Delimited, enter the position within the record that contains 
the field to be imported.

• Column 1 to 250 If the selection is “Record” and Import type is set to Fixed 
format, enter the column within the fixed record that 
contains the field to be imported.

• Length 1 to 55 If the selection is “Record” and Import type is set to Fixed 
format, enter the length of the field being imported.

Table 8.14—Import Timesheet Format Field Definitions—Pages 2 and 3 (Continued)

Field Valid Entry Definition
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KEYWORD RECORD

The first line of the import text file identifies the division and may also identify the 
separator character. If no separator character is defined here, the | (pipe sign) is used as 
the default. The format is: 

EXAMPLE TIMESHEET IMPORT FILE

This delimited file format example contains one keyword record and timesheet for one 
salaried employee and one hourly employee to be modified. The format (TIMESHEET) 
has been defined to recognize the pipe as the separator. 

DIV=95 IMPORT=TIMESHEET POST=01312004 FUNC=M DDEC=N
1001|Salary|01302004|1|.S AMT|634.00|1|HOURLY|01302004|1|.H AMT|10

Table 8.15 takes each entry in the import example and defines the associated fields. 

DIV = nn SEP = x IMPORT = name POST = mmddyyyy FUNC = 1/m DDEC=Y/N

where

• nn is the division number

• x is the separation character

• name is the import file definition name. The default is IMPORT.

• mmddyyyy is the posting date. The default is today’s date.

• I/M is the type of posting. This is only used for employee master records. It is not required in the 
keyword record if timesheets or history is being imported. Must be Initial (“I”) or Modify (“M”). The 
default is “I” for initial

• Y/M is the default use of decimal points. A “Y” value causes decimal points to be placed in numeric 
fields when no decimal point is found. For example, for an amount field, “45” becomes .45 and for a 
rate field it becomes .000045. An “N” value assumes no decimal positioning. For example, for an 
amount field, “45” becomes $45.00 and for a rate field 45.000000. If a decimal point is found in a field, 
the Y or N value in DDEC is disregarded, and the decimal point is used just as it exists in the import 
file.

Table 8.15—Employee Timesheet File—Delimited File Example Entries and Fields

Entry Field Name Import Field

DIV=95 IMPORT=TIMECARD POST=01312004 
FUNC=M DDEC=N

Keyword record
Import file name: TIMECARD

1001 Employee # 1
Employee Timesheet File Formats 



Chapter 8—Importing Payroll Information
IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

Because many import types (employee master record, direct deposit, history, 
and timesheet) use the same file name, you can only have one import file in 
your system at any one time.

For example, you are ready to import the file, so you log onto your computer and check 
the TTY number, which is 864. Therefore, the line number is 0864 and the import name 
must be:

• PY0864.Y
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

IMPORTING YOUR EMPLOYEE TIMESHEETS

You will use the same import program to import your employee timesheet files.

Salary Earning item 2

01302004 Entry date 3

1 Entry number 4

.S AMT/634.00 Rate item/Amount 5/6

1 Employee # 7

HOURLY Earning item 8

01302004 Entry date 9

1 Entry number 10

.H AMT/10 Rate item/Hours 11/12

PY + Line number
(Line number is 0 + your TTY number)

+ .Y

Table 8.15—Employee Timesheet File—Delimited File Example Entries and Fields (Continued)

Entry Field Name Import Field
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1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 8.7). 

Figure 8.7—System Utilities—Executing a Program

4. To define the file format from the Execute Programs task, enter the required 
information according to Table 8.16. 

5. Click Run. The system asks you to enter the import format name.

You can also go to your DOS prompt, type AFWRUN, and enter the 
program name to run the program from outside FundWare. 

Table 8.16—Importing Timesheets

Field Entry

Program Name CUSPY20

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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When you run the import task, the system checks the file for errors. If errors are found, 
the error report is saved to the FundWare > Data folder with the following name: 

For example, if your TTY number is 864, the line # is 0864. So the error file for 
Division 95 import is:

• PYX0864.L95
If there are errors, review the error report to determine their causes. Correct the import 
file and run the program again.

IMPORTING CHECK RECONCILIATIONS
Payroll/Personnel can import a text file and change the records of your “outstanding” 
checks to “marked for reconciliation.” After the import has completed successfully, you 
can modify the reconciliation setting of any individual check, as necessary. Once you 
have reviewed your checks, you can post the marked for reconciliation checks. 
If there is an error in an import file record, no records are imported. An error report is 
produced. It shows any errors encountered. The report lists the record in which the error 
occurred, the check number, and the error. If no errors are found, no report is produced.

IMPORT FILE FORMAT

The text files cannot contain special characters. Special characters, such as tabs and 
form-feeds, are typically characters that are not printable. Each line of text must be 
terminated with the line terminator for the operating system. For example, in MS-DOS 
the line terminator is a carriage return/new line sequence.

KEYWORD RECORD

The keyword record is the first line of the import text file and identifies the division and 
may also identify the separator character. If no separator character is defined here, the | 
(pipe sign) is used as the default.The format is: 

PYX + Line number
(Line number is 0 + your TTY number)

+ .L##
(## represents your division number)

DIV = nn SEP = x

where
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IMPORT FIELD DEFINITIONS

All records must have the following format:
• Check number—10 characters
• Check amount—Can be 1 to 15 digits to the left of the decimal, the decimal, 

then 2 digits to the right of the decimal. The decimal may be omitted. The 
program assumes that the last 2 digits in the amount string are to the right of the 
decimal.

Each check and check amount are presented on the same line, separated by the defined 
separator character (default: pipe sign).

IMPORT FILE EXAMPLE

The following example add 3 checks that will be “marked for reconciliation”. The 
example contains one keyword record and 3 check records.

DIV=02
5005|202.20
5006|1006.29
5007|115.73

IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

For example, you are ready to import the file, so you log onto your computer and check 
the TTY number, which is 864. Therefore, the line number is 0864 and the import name 
must be:

• BR0864.Y
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

• nn is the division number

• x is the separation character

BR + Line number
(Line number is 0 + your TTY number)

+ .Y
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IMPORTING PAYROLL RECONCILIATION FILES

This task imports a text file and changes the records of your “outstanding” checks to 
“marked for reconciliation.” The import begins by checking the import file for errors. If 
any errors are found, NONE of the file is imported. If there are errors, review the error 
report to determine their causes. Correct the import text file and run the import again.
Use the following steps to import the payroll reconciliation.

1.  Click Bank Reconciliation > Import Payroll Reconciliation on the module 
navigator (if the module is not expanded, click Payroll/Personnel first) or 
select Payroll/Personnel > Bank Reconciliation > Import Payroll 
Reconciliation from the menu bar. 

2. Enter the bank to update with the import and press ENTER. A confirmation 
message displays (Figure 8.8). 

Figure 8.8—Importing Payroll Reconciliation

3. Type Y and press ENTER to accept the bank entry. The system imports the file. If 
the import is successful, the screen will display the message “Import posting 
complete.”

4. After the import has completed successfully, you can display your imported 
entries using the Display Checks task or the Enter Reconciliation task. 

5. If necessary, you may then “Unmark for Reconciliation” any check(s). 
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6. Since this task only changes the records of your “outstanding” checks to 
“marked for reconciliation,” you must post your “Marked for Reconciliation” 
checks using the Post Reconciliation task. 

IMPORT FILE ERRORS

When you run the import task, the system checks the file for errors. If errors are found, 
the error report is saved to the FundWare > Data folder with the following name: 

If there are errors, review the error report to determine their causes. Correct the import 
file and run the program again.

FILED REPORT NAME

The import module files a report using the following name:
• PYX[line #].L##, where ## represents your division number.

IMPORT SCREEN ERROR MESSAGES
The messages in Table 8.17 may appear on the screen as you execute Payroll/Personnel 
import programs.

BRIMPER + .L##
(## represents your division number)

Table 8.17—Screen Error Messages

Message Definition

Errors have occurred in edit! Text file was in the correct format but information did not pass the 
validation criteria. Correct the text file and execute task again.

Errors have occurred in extract! The text file is formatted incorrectly. See the error file. Correct the 
text file and execute the task again.

Errors have occurred in 
initialization!

The text file is formatted incorrectly. Correct the text file and 
execute task again.

Error report filed–import was not 
posted.

See Error Report (BRIMMPER.L00) filed by the import process.

Function Complete! No errors were found and the entire text file was imported.
Import Screen Error Messages 
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REPORT ERROR MESSAGES
The messages in Table 8.18 refer to errors found in the import error reports. If errors are 
reported, correct the errors in the text file and import the file again:

No transactions to post! No valid transactions were found to post.

Parameter not in system. The Payroll/Personnel module is not yet defined. Set up your 
Payroll/Personnel module.

Table 8.18—Report Error Messages

Message Definition

Date not numeric. A date field in the text file contains alpha characters. Correct date fields.

Division not in use. Must be importing into current division. (Div=nn in import file; nn must 
be the division you are signed into.)

Division XX must be 
between 01–99.

Division number is not 1 through 99. Correct the division number.

Division XX not in system. Division number is not currently defined. Correct the division number or 
define the new division.

Duplicate employee input Text file contains a duplicate employee number. Correct and import the 
file again.

Employee already in 
system.

Text file contains an employee number already defined in your system 
using the Initial (“I”) function. Correct the employee number or the 
function indicator on the keyword record.

Employee may not be used. Text file contains an employee number 0. Correct and import the file 
again.

Employee not in system. Text file contains an employee number not currently defined in your 
system using the Modify (“M”) function. Correct the employee number 
or the function indicator on the keyword record.

Field not numeric. An amount field in the text file contains alphabetic characters. Correct 
amount fields.

File XXX has no data. The specified text file for this task is empty. Modify the text file or use a 
different text file.

Table 8.17—Screen Error Messages (Continued)

Message Definition
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File XXX not in system. The text file for this task was not found. Make sure the file has the 
correct name and is in the FundWare Data directory. Correct and import 
the file again.

Function X must be “I” or 
“M”.

The function indicator (initial or modify) was incorrect. Correct the 
function indicator on the keyword record.

Import amount not equal to 
check amount.

The check number and dollar amount received from the electronic file 
do not match the reconciliation file. The bank may not have processed 
the check for the same amount as that which was issued. Check the 
Payroll Check Register for the correct numbers and values. Correct or 
delete the data in the import file and rerun the import process.

Import amount is negative. A record in the import file contains a negative amount. Either delete the 
negative sign in the record in the import file or delete the record. Rerun 
the import.

Import file not found. The import file for this task was not found. This error will cause the 
entire import to be aborted. Make sure the file has the correct name and 
is in the FundWare data directory. Correct and resubmit the import file. 

Import XXX not in system. The import definition could not be found. Correct and import the file 
again.

Invalid date for XXXX. The date for data item XXXX is not a valid calendar date. Correct the 
date for data item XXXX.

Invalid edit value for data 
item XXXX. 

The edit value for data item XXXX is not valid. Correct the edit value for 
data item XXXX.

Invalid posting date 99/99/
9999. 

The posting date is not a valid calendar date existing in a valid date 
table. Correct the posting date on the keyword record or define a new 
date table.

Keyword not recognized. Keyword record is incorrect. Correct the text file and execute the task 
again.

Missing required field. A required field is missing. Add required records and fields to the import 
text file.

No .EMPLOYEE to import. The specified import definition did not contain the employee number. 
Modify the import definition and import the file again.

No data items to import. The specified import definition did not contain any data items. Modify 
the import definition and import the file again.

No keywords supplied. Keyword record is missing from text file. Add keyword record to the text 
file and execute the task again.

Table 8.18—Report Error Messages (Continued)

Message Definition
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No parameters supplied. Keyword record is missing from text file. Add keyword record to text file 
and execute task again.

Too many decimal places for 
XXXX.

The number for data item XXXX contains too many decimal places. 
Modify the number for data item XXXX.

Too many items. The import definition may contain at most 100 data items. Modify the 
import definition and import the file again.

Transaction record not 
found.

No record is found for the check number being imported.

Table 8.18—Report Error Messages (Continued)

Message Definition
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C H A P T E R  9

IMPORTING AR INFORMATION
(7.40 CUSTOMERS)

The AR import feature allows you to import two types of information:
• Customer data, and
• Transaction data.

BEFORE YOU IMPORT YOUR CUSTOMER DATA
During the customer data import process, the Import Manager will ensure that your data 
fields meet the specific import requirements (see Business Rules for Customer Imports 
on page 191 for specifics). Therefore, you must complete the general setup of your 
Accounts Receivable system before you begin importing your data. Please see the 
Blackbaud FundWare Accounts Receivable Guide for more information.
In addition, you should:

• Have security access (e.g., ability to rename files) to the directory in which the 
data file is stored,

• Have security rights to import (see the security setting for the Accounts 
Receivable module),

• Backup your FundWare system, 
• Create a copy of the database to which you are importing data, and
• Ensure that no one is working in the Accounts Receivable module. 

If Accounts Receivable is open during the import and the Customers folder is 
open, the module will not recognize the imported data. You must access another 
folder in Accounts Receivable, then select the Customers folder again.
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DATA REQUIREMENTS FOR CUSTOMER IMPORTS
Table 9.1 lists the fields, data type, and maximum length for the fields used in the 
Customer import. 

There are certain fields that require predefined entries (e.g., Individual Prefix 
only allows Mr., Mrs., Dr., Ms., Miss, or <None>). These fields are identified 
with an asterisk in the Maximum Length column. For more information on what 
is allowed in the predefined fields, see the Blackbaud FundWare Accounts 
Receivable Guide for more information.

The order of the fields in the table is the order that the Import Manager expects the 
information. If your data is not in this order, or does not match the type and length 
requirements, you must adjust the data or the import manager will return errors on your 
data. 

Data that is less than the data size allowed for a field will not cause an error. 
However, if the data in a field is longer than the specified maximum, the Import 
Manager will return errors. 

Also:
• Any blank lines in your data will generate errors during import.
• Any quotations in your data (e.g., Toys “R” Us) will be removed during import 

(e.g., Toys R Us).
When you have formatted the data as necessary, you must save the file in a .txt (text) or 
.csv (comma-separated values) format.

Table 9.1—Customer Import Data Requirements

Import Field Name Maximum Length

Customer Code 25

Organization Name 50

Organization Type *

Individual Prefix *

Individual First Name 25

Individual Middle Name 25

Individual Last Name 25

Individual Suffix 50
Data Requirements for Customer Imports 
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Individual Email Address 50

Customer Status *

Address1 Street 1 50

Address1 Street 2 50

Address1 Street 3 50

Address1 City 50

Address1 State 50

Address1 Postal Code 50

Address1 Country 50

Address1 Address Type *

Address1 Address Description 50

Address2 Street 1 50

Address2 Street 2 50

Address2 Street 3 50

Address2 City 50

Address2 State 50

Address2 Postal Code 50

Address2 Country 50

Address2 Address Type *

Address2 Address Description 50

Address3 Street 1 50

Address3 Street 2 50

Address3 Street 3 50

Address3 City 50

Address3 State 50

Table 9.1—Customer Import Data Requirements 

Import Field Name Maximum Length
Blackbaud, Inc. 189



Blackbaud FundWare System Administration Guide

190
Address 1 will be defined as the “Bill To” address. If this is inaccurate, you re-
order your addresses or change the Bill To setting after completing the import.

Address3 Postal Code 50

Address3 Country 50

Address3 Address Type *

Address3 Address Description 50

Phone1 Phone Number 50

Phone1 Phone Type *

Phone1 Phone Description 50

Phone2 Phone Number 50

Phone2 Phone Type *

Phone2 Phone Description 50

Phone3 Phone Number 50

Phone3 Phone Type *

Phone3 Phone Description 50

Days Due 00-99 is valid

Table 9.1—Customer Import Data Requirements 

Import Field Name Maximum Length
Data Requirements for Customer Imports 
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BUSINESS RULES FOR CUSTOMER IMPORTS
Table 9.2 provides the business rules that the Import Manager will apply to your data. 

Table 9.2—Business Rules

Import Field Name Business Rule

Customer Code If you chose the Manual Customer Numbers option in General Setup, 
the customer code must be:
• Unique,
• Any character or numeric value, and
• Have a maximum length of 25.

If you chose the Automatic Customer Numbers option in General 
Setup, the Import Manager will:
• Ignore any customer codes in the import file, and
• Generate a new customer code and insert it in database. (The 

Import Manager will refer to the last customer code applied to 
determine next number.)

Organization Name and 
Individual Name (First and 
Last)

If the Organization Name is blank and First Name and Last Name are 
supplied, the Import Manager will treat the customer as an Individual 
Customer.
• AR allows for two types of customers: Individual and Organization. 

Once assigned as an Individual Customer, you cannot change a 
record type to an Organization Customer.

If the First Name and Last Name are blank and the Organization 
Name is supplied, the Import Manager will treat the customer as an 
Organization Customer.
• AR allows for two types of customers: Individual and Organization. 

Once assigned as an Individual Organization Customer, you cannot 
change a record type to an Individual Customer.

Individual Prefix If this field is null or blank, the Import Manager will set the appropriate 
database entry to <None>.

Address Type (1,2,3) If this field is null or blank, the Import Manager will set the appropriate 
database entry to <None>.

The first (or only) address will be designated the default.

Phone Type (1,2,3) If this field is null or blank, the Import Manager will set the appropriate 
database entry to <None>.

The first (or only) phone number will be designated the default.
Blackbaud, Inc. 191



Blackbaud FundWare System Administration Guide

192
IMPORTING YOUR CUSTOMER DATA
Once your customer data has been modified, as necessary, to match the needs of the 
Import Manager, use the following steps to import the data into Accounts Receivable. 

Review the steps in Before You Import Your Customer Data on page 187 to 
make sure that you are ready to import the data.

1.  Select Tools > Import from the menu bar. 

2. If asked, select the division into which you are importing data.

3. Click OK. The Import window displays (Figure 9.1). 

Figure 9.1—Import window

4. Select Customers (the default) from the Import drop-down list.

5. Select the delimiter (or format) of your data file:

• Tab-delimited, or
• Comma-delimited.

Days Due If this field is null or blank, the Import Manager will set the field to the 
default Days Due.
• The default Days Due is defined on General tab of the 

Maintenance > Accounts Receivable > General Setup task.

Table 9.2—Business Rules (Continued)

Import Field Name Business Rule
Importing Your Customer Data 
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6. Enter the first row number containing data. The default entry is 1. However, if 
your data has any heading rows, enter the first line of actual data.

7. Enter the directory path and name of the data file (Figure 9.2). Click the ellipsis 
to browse to the file. 

Figure 9.2—Example Customer Import window

8. Click OK to import your data, or Close to cancel the process. The Import 
Manager will evaluate you data before attempting the import process. If there 
are no errors, a confirmation message displays (Figure 9.3). 

Figure 9.3—Import Confirmation Message

If there are errors, the Manager will create an error file and will not 
proceed with the import. For more information, see Correcting Errors 
in Your Customer Data on page 195. 

9. Click OK. The import proceeds, displaying a message with the process is 
complete (Figure 9.4). 

Figure 9.4—Import Complete Message
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10. Click OK.

11. Close the Import Manager by clicking Close or the close button ( ).

You can now use the imported customers in Accounts Receivable.
The Import Manager will rename your data file to reflect the date and time that 
the import was completed. For example, the data file in Figure 9.5 was 
imported December 14, 2001 at 12:55 and 07 seconds. 

Figure 9.5—Example of a Renamed Data File

If there are any locks on your data file, or if the file is open, the file will not be 
renamed.

TIPS FOR IMPORTING YOUR CUSTOMER DATA
The import process has many elements, and it could be very easy for you to make a 
mistake. However, here are a few things to keep in mind to avoid some of the more 
common mistakes:

• If you select the wrong Import type, you will have a large error file because the 
Import Manager will not interpret your data correctly.

• If you enter an incorrect First Row Number, you could get error messages.
— For example, if the data in your import file begins on row 2, but you enter 1 

as the First Row Number, you will get a number of error messages 
regarding row 1.

— On the other hand, the data in your import file begins on row 2, but you 
enter 3 as the First Row Number, you will lose your first row of data and 
you may or may not receive errors (due to the dependencies of other rows).
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• If you select the wrong delimiter, you will have a large error file because the 
Import Manager has no way of interpreting your data correctly.

• If you create your data file in Excel, be careful that the program does not 
include more instances of delimiters on a line that you intend or extra lines with 
delimiters but no other data. 
— If you are using comma delimiters and view the file in Notepad, you should 

be able to identify any “extra” information.
• You should add quotation marks at the beginning and end of any text fields that 

include your delimiter (e.g., using a comma in a comma-delimited file). (Excel 
may do this automatically.) For example, if you are using the comma-delimited 
format and a customer’s name is:
— Mittens for Kittens, Inc.
— The field should look like this: “Mittens for Kittens, Inc.”

CORRECTING ERRORS IN YOUR CUSTOMER DATA
Before beginning the import process, the Import Manager will read your customer data. 
If there are problems, it will return an error message (Figure 9.6) and the import process 
will not proceed. No records will be imported until the errors are cleared. 

Figure 9.6—Example Error Message

Use the following steps to correct your data.

1.  Write down the name and location of the error file.

2. Click OK.
Blackbaud, Inc. 195



Blackbaud FundWare System Administration Guide

196
3. Open the error file (Figure 9.7). (If you did not note the name of this file, it will 
be saved in the same directory as your data file and will have an extension of 
.csv.) 

Figure 9.7—Example Error File

4. Print the file for reference while you correct the data.

5. Use the error messages to determine the row and type of error. The errors were 
triggered when the Import Manager compared your data to the customer data 
requirements and business rules. Therefore, refer to the requirements and 
business rules to determine the source of the error.

An easy mistake to make would be to select the wrong delimiter. For 
example, if you have comma-delimited text and select the tab delimiter, 
you would have a large error file because the Import Manager would 
have no way of interpreting your data correctly.

6. When you have finished correcting your data file, you can again attempt the 
import process. 

You must close the error file before trying to import the file again. The 
Import Manager will delete the error file and, if necessary, create a new 
error file.

IMPORTING TRANSACTION DATA
FundWare allows you to import transaction data for the following:
Importing Transaction Data 
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• Standard invoices—Pending and posted;
• Memo invoices—Pending and posted; and
• Credit memos—Pending and posted.

If you import a posted document (i.e., standard invoice, memo invoice, or credit memo), 
the import program will not create an entry in your General Ledger. To avoid duplicate 
entries, you should use a setting of “posted” for any documents that you have previously 
posted to General Ledger.

BEFORE YOU IMPORT YOUR TRANSACTION DATA
During the transaction data import process, the Import Manager will ensure that your 
data fields meet the specific import requirements (see Data Requirements for 
Transaction Imports on page 198 for specifics). Therefore, you must complete the 
general setup of your Accounts Receivable system and add your customers (either 
through the program or the customer import process) before you begin importing your 
data. The process for completing AR setup is described in the Blackbaud FundWare 
Accounts Receivable Guide. Instructions for importing customer information can be 
found in this chapter (Importing Your Customer Data on page 192). Instructions for 
adding customers through AR can be found in the Blackbaud FundWare Accounts 
Receivable Guide.
In addition, you should:

• Have security access (e.g., ability to rename files) to the directory in which the 
data file is stored,

• Have security rights to import (see the security setting for the Accounts 
Receivable module),

• Backup your FundWare system, 
• Create a copy of the database to which you are importing data, and
• Ensure that no one is working in the Accounts Receivable module or its 

maintenance tasks.
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DATA REQUIREMENTS FOR TRANSACTION IMPORTS
You must organize your transaction data in the following order, adhering to the specified 
requirements. If any of your data does not match the requirements, an error log will note 
the problem and the program will not import your data.

All of the fields listed must exist in the order shown in your data file, even if this 
version of the import program will ignore the information. This means that you 
will have blank fields.

For a table summarizing the allowed lengths for each field, turn to Table 9.4 on 
page  208.

A.  Action ID—Indicates that you are adding transaction information. The entry 
must be Add.

— Entry required. If you do not enter valid data into this field, the import 
program will not import the data file and will enter a message in an error 
log.

B. Legacy Document ID—Because each invoice is likely to have multiple rows, 
this field allows the import program to maintain the relationship within a 
specific invoice. Enter a up to 100 numeric characters.

— Entry required. If you do not enter valid data into this field, the import 
program will not import the data file and will enter a message in an error 
log.

— This number is unique. All rows with the same ID will be connected in 
FundWare (i.e., will be on the same invoice).

— Tip: You can create a new number, or you can use the invoice number 
(which is also stored in Column D).

C. Invoice Type—Indicates the type of document. Your entry must be one of the 
following:

• Standard invoice,
• Credit memo, or
• Memo invoice.
— Entry required. If you do not enter valid data into this field, the import 

program will not import the data file and will enter a message in an error 
log.

D. Invoice Number—Is equal to the original document number (e.g., invoice 
number). Your entry to this field cannot exceed 12 characters.
Data Requirements for Transaction Imports 
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— Entry optional if… your Accounts Receivable setup indicates that your 
invoice numbers will be generated by the system (i.e., “Automatic Invoice 
Numbers”). The import program will ignore any entries to this column.

— Entry required if… If your Accounts Receivable setup indicates that your 
invoice numbers will be entered manually.

— This number is unique. All rows with the same ID will be connected in 
FundWare (i.e., will be on the same invoice).

— This number can be the same as the number stored in Column B (assuming 
that this number does not exceed 12 characters).

E. Customer Number—Enter the customer number (allows up to 25 alphanumeric 
characters).

— Entry required. If you do not enter valid data into this field, the import 
program will not import the data file and will enter a message in an error 
log.

— This customer must exist in your database.
— You can import transactions for customers regardless of status (i.e., Active, 

On-Hold, or Inactive).
F. Payment Due Date—Holds the payment due date (e.g., 08/05/2002). 

— Entry optional for standard and memo invoices. If you do not enter a 
date for a pending invoice, the system will calculate the due date based on 
the customer’s default days due.

— Entry unnecessary for credit memos. The system will ignore any entry in 
this field for credit memos (posted or pending).

G. Description—Enter any description of the document. You can enter up to 50 
alphanumeric characters into this field.

— Entry optional.
H. Customer Name—Enter the customer’s last name and first name, separated by a 

comma (e.g., Ross, Betsy). You can enter up to 50 alphanumeric characters into 
this field.

— If the customer is an organization, enter the organization name (e.g., 
Helping Hands Foundation).

— Entry optional. If you do not enter a customer name, the import program 
will apply the customer name associated with the specified customer 
number, according to the customer record.

I. Create User Name—Holds the user name of the employee who entered the 
original invoice (e.g., Demo User). You can enter up to 50 alphanumeric 
characters into this field.
Blackbaud, Inc. 199



Blackbaud FundWare System Administration Guide

200
— Entry optional. If you do not include an entry in this field for an invoice, 
the employee user name will appear as “not specified” when the invoice is 
viewed.

J. Create Date—Indicates the business date on which the document was created. 
For example, 09/15/2002.

— Entry optional. If you do not enter a date in this field, the import program 
will assign the invoice date as the creation date (see the entry for Column 
K).

K. Invoice Date—Indicates the actual date that the invoice was created (as 
compared to the business date). For example, 09/14/2002.

— Entry required. If you do not enter valid data into this field, the import 
program will not import the data file and will enter a message in an error 
log.

— If the invoice has been posted, this date must be equal to the Post Business 
Date (Column O). If the entries in these two columns do not match, the 
import program will change the Invoice Date to match the Post Business 
Date.

L. Customer Bill-To Address—Holds the Bill To address for the selected customer. 
(This address was designated as the “Default” address in FundWare, version 
7.16.) This field will hold up to 350 alphanumeric characters.

— Entry optional. If you do not enter valid data into this field, the import 
program will insert the Bill To address indicated on the customer’s record. 
(However, if there is no designated Bill To address, no address will appear 
on the invoice.)

— Separate each line of the address with the “pipe” symbol (|).
M. Customer Ship-To Address—Holds the Ship To address for the selected 

customer. This field will hold up to 350 alphanumeric characters. 

— Entry optional. If you do not enter valid data into this field, the import 
program will insert the Ship To address indicated on the customer’s record. 

— If there is no Ship To address indicated on the customer record, the field 
will remain blank.

— Separate each line of the address with the “pipe” symbol (|).
N. Invoice Status—Indicates the status of the invoice. Your entry must be one of 

the following:

• Pending, or
• Posted.
Data Requirements for Transaction Imports 
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— Entry required. If you do not enter valid data into this field, the import 
program will not import the data file and will enter a message in an error 
log.

Your transaction data file can include both pending and posted invoices.

O. Post Business Date—Holds the business date on which you posted an invoice. 
For example, 09/22/2002. 

— Entry required for posted invoices. If you do not enter valid data into this 
field, the import program will not import the data file and will enter a 
message in an error log.

— If the invoice is pending, the import program will ignore any entry in this 
field.

— This date must be equal to the Invoice Date (Column K). If the entries in 
these two columns do not match, the import program will change the 
Invoice Date to match the Post Business Date.

P. Post System Date—Holds the actual date on which you posted an invoice (as 
opposed to the business date). For example, 09/21/2002. 

— Entry optional. 
— If the invoice is posted and you leave this field blank, the import program 

will assign the Post Business Date (Column O) as the Post System Date. 
— If the invoice is pending, the import program will ignore any entry in this 

field.
Q. Post User Name—Enter the name of the employee who posted the invoice (e.g., 

Demo User). You can enter up to 50 alphanumeric characters into this field.

— Entry optional.
— If the invoice is posted and you leave this field blank, the employee user 

name will appear as “not specified” when the invoice is viewed.
— If the invoice is pending, the import program will ignore any entry in this 

field.
R. Post GL Batch ID—Indicates the batch number that was assigned when the 

invoice was posted to your General Ledger (up to 4 numbers long). This number 
must be greater than 0. 

— Entry optional.
— If the invoice is posted and you do not include an entry in this field, the 

import program will assign a batch ID of -1.
— If the invoice is pending, the import program will ignore any entry in this 

field.
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S. Reserved for future use—Any entry in this field will be ignored by the import 
program.

T. Reserved for future use—Any entry in this field will be ignored by the import 
program.

U. Reserved for future use—Any entry in this field will be ignored by the import 
program.

V. Reserved for future use—Any entry in this field will be ignored by the import 
program.

W. Reserved for future use—Any entry in this field will be ignored by the import 
program.

X. Reserved for future use—Any entry in this field will be ignored by the import 
program.

Y. Reserved for future use—Any entry in this field will be ignored by the import 
program.

Z. Legacy Line Item ID—Enter a unique alphanumeric value (up to 100 characters 
in length) for:

— Each line item (or “charge”) within an invoice. If a charge has multiple 
distributions, all the entries will have the same number. 

— Each receivable entry, if the invoice has been posted. If the associated 
charge has multiple distributions, all the entries for the receivable will have 
the same number. This number must not equal the number used for 
associated charges.

See Figure 9.15 on page 220 for an example of the Legacy Line Item 
ID.

This entry will allow the import file to maintain the relationship if a line item 
has multiple account distributions.

— If you view our example import information (Example Transaction Import 
Setup on page 210), we use a revenue code called “Walk Ts” (Figure 9.8 on 
page 213). By definition, this revenue code distributes the funds to two GL 
accounts. Therefore, you would enter the same number into this field for 
these two entries (one for each GL distribution account). (To see how this 
would look in the import file, see Figure 9.15 on page 220).

— Entry required. If you do not enter valid data into this field, the import 
program will not import the data file and will enter a message in an error 
log.
Data Requirements for Transaction Imports 
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— For an example, see Figure 9.15 on page 220.
AA.Line Item Type—Indicates the type of the line item (i.e., is this a charge item or 

a receivable item). Your entry must be one of the following:

• Charge, or
• Receivable.
— Entry required. If you do not enter valid data into this field, the import 

program will not import the data file and will enter a message in an error 
log.

— If the invoice is pending, you should only have entries (one or more) for 
charges.

— If the invoice is posted, you should have entries for charges and balancing 
entries for receivables.

AB.Revenue Code—Holds the revenue code for the line item stored in Column AA. 
You can enter up to 50 alphanumeric characters in this field.

— Entry required. If you do not enter valid data into this field, the import 
program will not import the data file and will enter a message in an error 
log.

— This revenue code must exist (with the exact same spelling) within your 
FundWare database.

AC.Reference—Holds any reference associated with the line item stored in Column 
Z. You can enter up to 50 alphanumeric characters in this field.

— Entry optional. If you do not enter valid data into this field, the import 
program will assign the default reference from the revenue code, if one is 
defined.

If you specify a Reference or Unit Description (Column AH) for 
receivables but not their associated charges, the import program may 
apply the defined Description and Reference to the charge line items. 
(This applies to Posted invoices only.) 

AD.Line Item Quantity—Enter the number, or quantity, of the line item stored in 
Column Z. You can enter up to 12 numeric characters, a decimal point, and 6 
additional numeric characters in this field. 

— Entry optional. If you do not enter valid data into this field, the import 
program will leave this information blank on the invoice.
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See Table 9.3 for the valid combinations of the Line Item Quantity, 
Line Item Unit Price (Column AE), and Line Item Amount (Column 
AF). 

— You can indicate negative numbers by adding a minus sign before the 
number.

— This entry is directly tied to the line item stored in Column Z.
AE.Line Item Unit Price—Indicates the unit price for the line item stored in Column 

Z. You can enter up to 15 numeric characters, a decimal point, and 2 additional 
numeric characters in this field.

— Entry optional. If you do not enter valid data into this field, the import 
program will assign the default amount from the revenue code definition.

Refer to Table 9.3 for the valid combinations of the Line Item Quantity 
(Column AD), Line Item Unit Price, and Line Item Amount (Column 
AF).

Table 9.3—Quantity, Unit Price, and Amount Import Combinations

Column AD—Line 
Item Quantity

Column AE—Line 
Item Unit Price

Column AF—Line 
Item Amount Requirements

Imported Imported Imported The value of:
• Column AD * Column AE
must equal the value in Column AF or 
you will receive an error for Column 
AF.

Imported Not imported (i.e., 
field blank in 
import file)

Not imported (i.e., 
field blank in 
import file)

The import program will apply the Unit 
Price (Column AE) based on the 
revenue code definition.
If there is no Unit Price defined for the 
revenue code, you will receive errors 
regarding Column AE and Column AF.

Not imported (i.e., 
field blank in 
import file)

Not imported (i.e., 
field blank in 
import file)

Imported The import program will leave the 
values for Column AD and Column AE 
blank on the imported invoice, and will 
apply the value in Column AF as the 
Line Item Amount.

Imported Imported Not imported (i.e., 
field blank in 
import file)

The import program will calculate:
• Column AD * Column AE
The result will appear on the imported 
invoice as the Line Item Amount.
Data Requirements for Transaction Imports 
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— Negative numbers are not allowed in this field. If you enter a negative 
number, the import program will return an error message.

AF. Line Item Amount—Enter the dollar amount of the line item stored in Column 
Z (i.e., the total dollar amount distributed to all accounts) stored in Column Z. 
You can enter up to 15 numeric characters, a decimal point, and 2 additional 
numeric characters in this field.

— Entry optional. If you do not enter valid data into this field, the import 
program will assign the default amount from the revenue code definition, or 
calculate from the quantity (Column AD) and unit price (Column AE).

Refer to Table 9.3 for the valid combinations of the Line Item Quantity 
(Column AD), Line Item Unit Price (Column AE), and Line Item 
Amount.

AG.Line Item Account Mask—Enter the receivable account (or account mask) for 
the each charge entries. Up to 55 alphanumeric characters allowed.

— Entry optional for pending invoices. If you do not enter valid data into 
this field for a pending invoice, the import program will apply the 
receivable account (or mask) defined for the revenue code (first) or defined 
on the customer’s record (second) if no receivable account is defined for the 
revenue code. 

— Entry unnecessary for posted invoices. If the invoice is posted, the import 
program will ignore any entry in this field. You will enter the resolved 
receivable account for the receivable line items in Column AM.

AH.Unit Description—Holds the description associated with the line item stored in 
Column Z. Up to 50 alphanumeric characters allowed.

— Entry optional. If your entry in Column AA is “Receivable,” any entries in 
this field will be ignored.

If you specify a Unit Description or Reference (Column AC) for 
receivables but not their associated charges, the import program may 
apply the defined Description and Reference to the charge line items. 
(This applies to Posted invoices only.) 

AI. Reserved for future use—Any entry in this field will be ignored by the import 
program.

AJ. Legacy Line Item Account ID—Enter a unique alphanumeric ID for each 
receivable and charge line item account (up to 100 characters in length). This 
number will be used in the Legacy Source Line Item Account ID (Column AK) 
to link the receivable entry to its corresponding charge entry.
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— Entry required for posted invoices. If you do not enter valid data into this 
field, the import program will not import the data file and will enter a 
message in an error log.

— Entry optional for pending invoices. If you do not enter valid data into 
this field for a pending invoice, the import program will determine the data 
for Column AM and Column AN based on the revenue code definition.

AK.Legacy Source Line Item Account ID—For each receivable line item, enter the 
Legacy Line Item Account ID (Column AJ) for the corresponding charge (up to 
100 characters in length). (This entry should be an alphanumeric value.) This 
allows the import program to link the receivable entry to its corresponding 
charge entry. 

— Entry required for receivable accounts on posted invoices. If you do not 
enter valid data into this field, the import program will not import the data 
file and will enter a message in an error log.

— Entry unnecessary for charge accounts on posted invoices. The import 
program will ignore any entry in this field.

— Entry unnecessary for pending invoices. The import program will ignore 
any entry in this field.

AL.Legacy Source Line Item ID—For each receivable line item, enter the Legacy 
Line Item Account ID (Column Z) for the corresponding charge (up to 100 
characters in length). (This entry should be an alphanumeric value.) This allows 
the import program to link the receivable entry to its corresponding charge 
entry.

— Entry required for posted invoices. If you do not enter valid data into this 
field, the import program will not import the data file and will enter a 
message in an error log.

— Entry unnecessary for pending invoices. The import program will ignore 
any entry in this field.

AM.Line Item Accounts—Indicates the distribution accounts to which the funds 
associated with the charges and receivables on a posted invoice will be credited. 
You can enter up to 55 alphanumeric characters in this field.

— Entry required for posted invoices. If you do not enter valid data into this 
field for all charge and receivable entries, the import program will not 
import the data file and will enter a message in an error log.

Entry is also required if you want to specify the GL distribution for a 
pending invoice.

— Entry unnecessary for receivable entries. The import program will ignore 
any entry in this field.
Data Requirements for Transaction Imports 
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AN.Line Item Accounts Amount—Enter the dollar amount that will be posted to the 
account listed in Column AM. You can enter up to 15 numeric characters, a 
decimal point, and 2 additional numeric characters in this field.

— Entry required. If you do not enter valid data into this field, the import 
program will not import the data file and will enter a message in an error 
log.

— All charges for a distribution must sum to the Line Item Amount (Column 
AF). (See Figure 9.16 on page 221 for an example.)

— All receivables for a distribution must sum to the Line Item Amount 
(Column AF). (See Figure 9.16 on page 221 for an example.)

— This entry is directly tied to the entry in Column AA.
AO.Description—Applies to posted invoices only. You can enter up to 50 

alphanumeric characters in this field. (Within the FundWare AR module, this 
information is assigned when you post an invoice, based on your general setup 
posting settings. For imported, posted invoices, you will only see this 
information if you void the invoice and view the associated trace report.)

— Entry optional. If you do not enter valid data into this field, the import 
program will leave this information blank on the invoice. 

AP. Reference 1—Applies to posted invoices only. You can enter up to 50 
alphanumeric characters in this field. (Within the FundWare AR module, this 
information is assigned when you post an invoice, based on your general setup 
posting settings. For imported, posted invoices, you will only see this 
information if you void the invoice and view the associated trace report.)

— Entry optional. If you do not enter valid data into this field, the import 
program will leave this information blank on the invoice. 

AQ.Reference 2—Applies to posted invoices only. You can enter up to 50 
alphanumeric characters in this field. (Within the FundWare AR module, this 
information is assigned when you post an invoice, based on your general setup 
posting settings. For imported, posted invoices, you will only see this 
information if you void the invoice and view the associated trace report.)

— Entry optional. If you do not enter valid data into this field, the import 
program will leave this information blank on the invoice. 

AR.Reference 3—Applies to posted invoices only. You can enter up to 50 
alphanumeric characters in this field. (Within the FundWare AR module, this 
information is assigned when you post an invoice, based on your general setup 
posting settings. For imported, posted invoices, you will only see this 
information if you void the invoice and view the associated trace report.)
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— Entry optional. If you do not enter valid data into this field, the import 
program will leave this information blank on the invoice. 

For quick reference, see Table 9.4 for the allowed field lengths. 

Table 9.4—Transaction Import Data Requirements

Column Name Import Field Name Maximum Length or Valid Entry

Column A Action ID • Add

Column B Legacy Document ID 100

Column C Invoice Type • Standard invoice
• Memo invoice
• Credit Memo

Column D Invoice Number 12

Column E Customer Number 25

Column F Payment Due Date 10

Column G Description 50

Column H Customer Name 50

Column I Create User Name 50

Column J Create Date 10

Column K Invoice Date 10

Column L Customer Bill-To Address 350

Column M Customer Ship-To Address 350

Column N Invoice Status • Pending
• Posted

Column O Post Business Date 10

Column P Post System Date 10

Column Q Post User Name 50

Column R Post GL Batch ID 4

Column S Reserved N/A

Column T Reserved N/A

Column U Reserved N/A
Data Requirements for Transaction Imports 
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Column V Reserved N/A

Column W Reserved N/A

Column X Reserved N/A

Column Y Reserved N/A

Column Z Legacy Line Item ID 100

Column AA Line Item Type • Charge
• Receivable

Column AB Revenue Code 50

Column AC Reference 50

Column AD Line Item Quantity 18 (e.g., 123456789012.123456)

Column AE Line Item Unit Price 17 (e.g., 123456789012345.12)

Column AF Line Item Amount 17 (e.g., 123456789012345.12)

Column AG Line Item Account Mask 55

Column AH Unit Description 50

Column AI Reserved N/A

Column AJ Legacy Line Item Account ID 100

Column AK Legacy Source Line Item Account ID 100

Column AL Legacy Source Line Item ID 100

Column AM Line Item Accounts 55

Column AN Line Item Accounts Amount 17 (e.g., 123456789012345.12)

Column AO Description 50

Column AP Reference 1 50

Column AQ Reference 2 50

Column AR Reference 3 50

Table 9.4—Transaction Import Data Requirements (Continued)

Column Name Import Field Name Maximum Length or Valid Entry
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EXAMPLE TRANSACTION IMPORT SETUP
To help you understand how the data in your system must be organized in your data 
import file, the following sections present:

• Accounts Receivable setup information 
— General Setup on page 210
— Customers on page 211
— Revenue Codes on page 212

• Two example invoices (pending and posted) defined in our system
— Invoices on page 214

• Example Excel spreadsheets showing how that invoice information would 
appear in an import data file.

GENERAL SETUP

Our Accounts Receivable module has the following applicable default settings. 
Customers: 

Figure 9.1—Customer Record Settings

Invoices: 

Figure 9.2—Invoice Settings
Example Transaction Import Setup 
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Journals: 

Figure 9.3—Journal Settings

Sales journal (to which invoices are posted): 

Figure 9.4—Settings for Sales Journal

CUSTOMERS

The following two customers have been entered into our Accounts Receivable system. 

Figure 9.5—Customer Jeannie Cole
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Figure 9.6—Organization Customer Golden Foundation

REVENUE CODES

The following revenue codes are active in our Accounts Receivable system. 

Figure 9.7—Revenue Code for Walk Registrations
Example Transaction Import Setup 
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Figure 9.8—Revenue Code for Walk T-Shirts

Figure 9.9—Revenue Code for Walk Donations
Blackbaud, Inc. 213



Blackbaud FundWare System Administration Guide

214
INVOICES

The following screen shots show two invoices in the FundWare system. This should 
help you understand how the information that you provide corresponds to our system. 
Note that we have not changed the charge code distribution from the revenue code 
defaults. 

Figure 9.10—Pending Invoice for Golden Foundation

When you resolve the revenue accounts against the receivable account mask defined on 
the revenue code, you get the following receivable account distribution.

Account Amount Derived from…

Note: This is the revenue 
account distribution based 
on the definition for revenue 
code “Walk Ts.”

Note: This is the 
revenue account 
distribution based on the 
definition for revenue 
code “Walk Reg.”
Example Transaction Import Setup 
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A03 00-00 1210 $245.00 Receivable mask = AXX 00-00 1210 for Walk Reg
Revenue account = A03 00-00 5910 for Walk Reg

A01 00-00 1210 $118.13 Receivable mask = AXX 00-00 1210 for Walk Ts
Revenue account = A01 00-00 4910 for Walk Ts

A02 00-00 1210 $39.37 Receivable mask = AXX 00-00 1210 for Walk Ts
Revenue account = A02 00-00 5910 for Walk Ts
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Figure 9.11—Posted Invoice for Jeannie Cole

Note: This is the 
revenue account 
distribution based on 
the definition for 
revenue code “Walk 
Dona.”

Note: This is the revenue account 
distribution based on the definition 
for revenue code “Walk Reg.”

Note: This is the revenue 
account distribution based 
on the definition for revenue 
code “Walk Ts.”
Example Transaction Import Setup 
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When you resolve the revenue accounts against the receivable account mask defined on 
the revenue code, you get the following receivable account distribution.

When this invoice was posted, it was given the GL batch ID 200. 

Figure 9.12—GL Batch ID for Posted Invoice.

SPREADSHEETS

The following figures (Figure 9.13 through Figure 9.16) show how the data associated 
with the two invoices would appear in an Excel spreadsheet, ready to import into 
FundWare.

Account Amount Derived from…

A01 00-00 1210 $91.88 Receivable mask = AXX 00-00 1210 for Walk Dona
Revenue account = A01 00-00 4910 for Walk Dona
Revenue account = A01 03-01 4910 for Walk Dona
Receivable mask = AXX 00-00 1210 for Walk Ts
Revenue account = A01 00-00 4910 for Walk Ts
(Even though there are three revenue accounts for two 
charges, they resolve to the same receivable account.)

A02 00-00 1210 $5.62 Receivable mask = AXX 00-00 1210 for Walk Ts
Revenue account = A02 00-00 5910 for Walk Ts

A03 00-00 1210 $35.00 Receivable mask = AXX 00-00 1210 for Walk Reg
Revenue account = A03 0-00 5910 for Walk Reg
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Figure 9.13—Example Spreadsheet, 1 of 4
Example Transaction Import Setup 
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Figure 9.14—Example Spreadsheet, 2 of 4
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Figure 9.15—Example Spreadsheet, 3 of 4
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Figure 9.16—Example Spreadsheet, 4 of 4

IMPORTING YOUR TRANSACTION DATA
Once your transaction data has been modified, as necessary, to match the data 
requirements of the Import Manager, use the following steps to import the data into 
Accounts Receivable. 

Review the steps in Before You Import Your Transaction Data on page 197 to 
make sure that you are ready to import the data.

1.  Select Tools > Import from the menu bar. 

2. If asked, select the division into which you are importing data.

3. Click OK. The Import window displays. 
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4. Select Transactions from the Import drop-down list (Figure 9.17). 

Figure 9.17—Import window

5. Select the delimiter (or format) of your data file:

• Tab-delimited, or
• Comma-delimited.

6. Enter the first row number containing data. The default entry is 1. However, if 
your data has any heading rows, enter the first line of actual data.

7. Enter the directory path and name of the data file (Figure 9.18). Click the 
ellipsis to browse to the file. 

Figure 9.18—Example Customer Import window
Importing Your Transaction Data 
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8. Click OK to import your data, or Close to cancel the process. The Import 
Manager will evaluate you data before attempting the import process. If there 
are no errors, a confirmation message displays (Figure 9.19). 

Figure 9.19—Import Confirmation Message

If there are errors, the Manager will create an error file and will not 
proceed with the import. For more information, see Correcting Errors 
in Your Transaction Data on page 225.

9. Click OK. The import proceeds, displaying a message with the process is 
complete (Figure 9.20). 

Figure 9.20—Import Complete Message

10. Click OK.

You will not be able to work in the AR module until you close this 
message.

11. Close the Import Manager by clicking Close or the close button ( ).

You can now access the imported invoices in Accounts Receivable.
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The Import Manager will rename your data file to reflect the date and time that 
the import was completed. For example, the data file in Figure 9.21 was 
imported December 14, 2001 at 12:55 and 07 seconds. 

Figure 9.21—Example of a Renamed Data File

If there are any locks on your data file, or if the file is open, the file will not be 
renamed.

TIPS FOR IMPORTING YOUR TRANSACTION DATA
The import process has many elements, and it could be very easy for you to make a 
mistake. However, here are a few things to keep in mind to avoid some of the more 
common mistakes:

• If you select the wrong Import type, you will have a large error file because the 
Import Manager will not interpret your data correctly.

• If you enter an incorrect First Row Number, you could get error messages.
— For example, if the data in your import file begins on row 2, but you enter 1 

as the First Row Number, you will get a number of error messages 
regarding row 1. (Figure 9.23 shows what these error messages could look 
like.)

— On the other hand, the data in your import file begins on row 2, but you 
enter 3 as the First Row Number, you will lose your first row of data and 
you may or may not receive errors (due to the dependencies of other rows).

• If you select the wrong delimiter, you will have a large error file because the 
Import Manager has no way of interpreting your data correctly. (In this case, 
your message will read “Delimiter not found.”)
Tips for Importing Your Transaction Data 



Chapter 9—Importing AR Information (7.40 Customers)
• If you create your data file in Excel, be careful that the program does not 
include more instances of delimiters on a line that you intend or extra lines with 
delimiters but no other data. 
— If you are using comma delimiters and view the file in Notepad, you should 

be able to identify any “extra” information.
• You should not enter any information in any of the fields marked for future use, 

as you could get error messages that may be difficult to interpret.
• You should add quotation marks at the beginning and end of any text fields that 

include your delimiter (e.g., using a comma in a comma-delimited file). (Excel 
may do this automatically.) For example, if you are using the comma-delimited 
format and a customer’s name is:
— Mittens for Kittens, Inc.
The field should look like this: 

— “Mittens for Kittens, Inc.”
• Dates must always contain a 4-digit year in one of the following valid formats:

— mm/dd/yyyy
— mm-dd-yyyy
The following formats are considered variants of the above valid formats and 
will be accepted:

— m/d/yyyy or m-d-yyyy
— m/d/yyyy or mm-d-yyyy
— m/dd/yyyy or m-dd-yyyy

CORRECTING ERRORS IN YOUR TRANSACTION DATA
Before beginning the import process, the Import Manager will read your transaction 
data. If there are problems, it will return an error message (Figure 9.22) and the import 
process will not proceed. No records will be imported until the errors are cleared. 

Figure 9.22—Example Error Message
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Use the following steps to correct your data.
1.  Write down the name and location of the error file.

2. Click OK.

3. Open the error file (Figure 9.23). (If you did not note the name of this file, it 
will be saved in the same directory as your data file and will have an extension 
of .csv.) 

Figure 9.23— Example Error File

An easy mistake to make would be to enter the wrong starting row 
number, which is what we did in this example.

4. Print the file for reference while you correct the data.

5. Use the error messages to determine the row and type of error. The errors were 
triggered when the Import Manager compared your data to the transaction 
import data requirements. Therefore, refer to the requirements to determine the 
source of the error.

6. When you have finished correcting your data file, you can again attempt the 
import process. 

You must close the error file before trying to import the file again. The 
Import Manager will delete the error file and, if necessary, create a new 
error file.
Correcting Errors in Your Transaction Data 
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IMPORTING/EXPORTING AR INFORMATION
(5.8/5.9 CUSTOMERS)

The tasks to import customer files are very similar because you use the same Execute 
Programs task to define the format of the text file. Once you have defined one or more 
formats, you use the same Execute Programs task to import the file.

1.  Create one or more text file formats via an Execute Programs task. This doesn’t 
import the text file itself. 

The text files cannot contain special characters, such as tabs and form-
feeds. Each line of text must end with the line terminator for the 
operating system. In MS-DOS, the line terminator is a carriage return/
new line sequence.

2. Create the text files to be imported using any text editor, database, or word 
processor. 

3. Execute the import program to bring the data from the text file into the Classic 
Accounts Receivable module via another Execute Programs task.

There are nine types of AR import/export tasks available using FundWare version 5.8 or 
5.9 (Table 10.1). 

Table 10.1—Import/Export Tasks

Import Tasks Export Tasks

Customer Records Allocation Aging

Transactions Customer Records

Orders Customer Meters

Meter Transactions

Meter Maintenance
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THE IMPORT FORMAT

You have the option of two different types of file formats for your import text file:
• Delimited file formats—One in which the length of each field in the file is not 

pre-defined. For example, the following fields are both acceptable because the 
field delimiter (in this case the pipe [|]) defines where each field begins and 
ends:
— 101|3|Paul J. Johnson|3034571400
— 1200|3|Jenny Garner|3037582000

• Fixed-file formats—Does not use delimiters, rather the line, column, and length 
positions determine where the fields begin and end. Using the previous 
example, the format may be defined as shown in Table 10.2. 

A fixed-format text file The text file would be:

— 00000001013Paul J. Johnson3034571400
00000012003Jenny Garner3037582000

GENERAL INSTRUCTIONS FOR IMPORTING FILES
Files are imported through different programs using the Execute Programs task. The 
following section provides the basic instructions for this task. Each import task has a 
section defining the specific requirements for these programs.

Repetitive Billing

Table 10.2—Fixed-File Format

Field Column Length

Customer number 1 10

Billing run 11 5

Customer name 16 30

Telephone number 47 12

Table 10.1—Import/Export Tasks (Continued)

Import Tasks Export Tasks
General Instructions for Importing Files 
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1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 10.1). 

Figure 10.1—System Utilities—Executing a Program

4. In the Execute Program area, enter the required information according to the 
requirements defined in each import section.

5. Click Run. When complete, you return to the Execute Program screen.
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IMPORTING CUSTOMER RECORDS—WHAT CAN YOU IMPORT?
The Import Customer Records tasks allows you to import information for new 
customers and changes to current customers’ records. When you are making a change, 
you only need to include the customer number and the information being changed. 
Table 10.3 defines some of the information that you can import to your Accounts 
Receivable system using the Import Customer Records task. 

Table 10.3—Importing Customer Records—Possible Fields and Field Sizes

Field Description Maximum Field Size

Customer number 9 digits

Billing run 2 digits

Class 4 digits

Region 4 digits

Active flag 1 character (Y or N)

Billing sortkey 10 characters

Billing name 35 characters

Billing street 1|street 2 35 characters|35 characters

Billing city|STP|post code 19 characters|5 characters|9 characters

Billing country 35 characters

Billing area code & phone 10 digits

Billing fax area code/number 10 digits

Contact sortkey 10 characters

Contact name 35 characters

Contact street 1|street 2 35 characters|35 characters

Contact city|STP|post code 19 characters|5 characters|9 characters

Contact country 35 characters

Contact area code & phone 10 digits

Contact fax area code/number 10 digits

Service house num|Direction|Street 5 digits|1 character|22 characters
Importing Customer Records—What Can You Import? 
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IMPORTING CUSTOMER RECORDS—CREATING THE IMPORT FORMAT

You can create your import format from the Execute Programs task.
1.  Open an instance of FundWare.

2. Click Import/Export > Define Customer Import on the module navigator (if 
the module is not expanded, click Classic Accounts Receivable first) or select 
Classic Accounts Receivable > Import/Export > Define Customer Import 
from the menu bar. 

3. The system asks you to enter the import format name.

4. Enter up to 10 alphanumeric characters. No embedded spaces are allowed. We 
recommend that you enter a name that is meaningful to your organization. The 
system asks if you are copying this format from an existing import format.

Service note1|Service note2 30 characters|30 characters

Service ship method 30 characters

Service terms 30 characters

Int|Chg|Alloc|Dep 1 char|1 char|1 char|1char
• Your entry for these fields is either Y or N.

Table 10.3—Importing Customer Records—Possible Fields and Field Sizes (Continued)

Field Description Maximum Field Size
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5. Leave the Copy import field blank if you are not copying this format from an 
existing import format, or press F1 to select from a list of currently defined 
import formats. The first page of the task displays (Figure 10.2). 

Figure 10.2—Define Customer Import—Page 1 of 2

6. Complete the required fields according to Table 10.4. 

7. When complete, press ENTER. The second page of the task displays. 

Table 10.4—Importing Customer Records—Format Field Definitions—Page 1 of 2

Field Valid Entry Definition

Description 30 characters Description of the import.

Import type 1
2

• 1—Delimited import file.
• 2—Fixed format import file.

• Delimited by 1 character If the import type option is set to delimited, enter the 
character used as a separator between imported fields.

Record count 1 to 99 The number of records required for one master record to 
be imported.
Importing Customer Records—What Can You Import? 
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8. For the remainder of the task, you will define the data items included in your 
import file, as well as their specific location within the import file. Use the 
instructions in Table 10.5 to complete these fields. 

Table 10.5—Importing Customer Records—Format Field Definitions—Page 2 of 2

Field Valid Entry Definition

Data item Employee data 
item

The existing employee data item to be imported. Press F1 in 
this field to display a list of currently defined employee data 
items.

• Entry from C
R

For multiple value data items, enter the entry value.
• C—Value is a constant.
• R—Value is from an imported record.
These options and their associated fields are explained 
further below.

• Value from C
R

For single occurring data items, enter the value.
• These from fields have the same options for the selected 

employee data item. Any combination of options is valid.
• C—Value is a constant.
• R—Value is from an imported record.
These options and their associated fields are explained 
further below.

Data Item field options—Any of the following fields may display, depending on the option you enter for 
the data item fields above.

• Constant varies with the 
data item definition

If the selection is “Constant,” enter the constant value. Valid 
entries for this field vary depending on the data item 
definition.

• Record 1 to 99 If the selection is “Record,” indicate which record (from the 
group of records that make up each master record), contains 
the field to be imported.

• Position 1 to 99 If the selection is “Record” and Import type is set to 
Delimited, enter the position within the record that contains 
the field to be imported.

• Column 1 to 250 If the selection is “Record” and Import type is set to Fixed 
format, enter the column within the fixed record that contains 
the field to be imported.

• Length 1 to 55 If the selection is “Record” and Import type is set to Fixed 
format, enter the length of the field being imported.
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IMPORTING CUSTOMER RECORDS—CREATING YOUR IMPORT TEXT FILE

Create your text files for importing data using any text editor, database word processor, 
or any other software application. The text files cannot contain special characters, such 
as tabs and form-feeds. The content of the import file is determined by the type of data 
you are importing and the format you have chosen. At a minimum, the file must contain 
the customer number (data item .CUSTOMER) to import. In addition, the following 
rules apply:

• All dates have the format mmddyyyy.
• All dates must be valid and the posting date cannot be in a closed period.
• All dollar amounts must use numbers and no $ characters. Their maximum size 

is 999,999,999 (999 million).
• All files must begin with a keyword record.

KEYWORD RECORD

The first line of the import text file identifies the division and may also identify the 
separator character. If no separator character is defined here, the | (pipe sign) is used as 
the default. The format is: 

DIV = nn SEP = x IMPORT = name FILE = name POST = mmddyyyy FUNC = 1/m DDEC=Y/N

where

• nn is the division number

• x is the separation character

• name is the import file definition name. The default is IMPORT.

• name is the import file name. For more information, see Importing Customer Records—Import File 
Name on page 236. 

• mmddyyyy is the posting date. The default is today’s date.

• I/M is the type of posting. This is only used for employee master records. Must be Initial (“I”) or Modify 
(“M”). The default is “I” for initial

• Y/M is the default use of decimal points. A “Y” value causes decimal points to be placed in numeric 
fields when no decimal point is found. For example, for an amount field, “45” becomes .45 and for a 
rate field it becomes .000045. An “N” value assumes no decimal positioning. For example, for an 
amount field, “45” becomes $45.00 and for a rate field 45.000000. If a decimal point is found in a field, 
the Y or N value in DDEC is disregarded, and the decimal point is used just as it exists in the import 
file.
Importing Customer Records—What Can You Import? 
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Specific examples of for each import are provided in the following sections.

IMPORTING CUSTOMER RECORDS—IMPORT FILE EXAMPLE

The following delimited file format example contains one keyword record and one 
customer to be imported. The format (TEST) has been defined to recognize the pipe as 
the separator. (Because this import equals one import record, the information should be 
on one line in the text file. This example has line breaks due to the width of the page.)

DIV=95 IMPORT=TEST POST=01312004 FUNC=I DDEC=N
101|3|1000|1000|Y|JOHNSON ST|Steve A. Johnson|830 Fox Run|PO Box 
774287|Steamboat Springs|CO|80477|3038791710||JOHNSON JU|Judy Johnson|830 
Fox Run|PO Box 774287|Steamboat Springs|CO|80477|3038791710

Table 10.6 takes each entry in the import example and defines the associated fields. 

Table 10.6—Importing Customer Records—Delimited File Example Entries and Fields

Entry Field Name Import 
Field

DIV=95 IMPORT=TEST POST=01312004 
FUNC=I DDEC=N

Keyword record

101 Customer number 1

3 Billing run 2

1000 Class 3

1000 Region 4

Y Active flag 5

JOHNSON ST Billing sortkey 6

Steve A. Johnson Billing name 7

830 Fox Run|PO Box 774287 Billing street 1|street 2 8|9

Steamboat Springs|CO|80477 Billing city|STP|post code 10|11|12

3038791710|| Billing area code and phone|Billing fax area 
code/number

13|14

JOHNSON JU Contact sortkey 15

Judy Johnson Contact name 16

830 Fox Run|PO Box 774287 Contact street 1|street 2 17|18
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IMPORTING CUSTOMER RECORDS—IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

Because many Accounts Receivable import types use the same file name, you 
can only have one import file in your system at any one time.

For example, you are ready to import the file, so you log onto your computer and check 
the TTY number, which is 864. Therefore, the line number is 0864 and the import name 
must be:

• AR0864.Y
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

IMPORTING CUSTOMER RECORDS—IMPORTING THE FILE

To import the customer record file from the Execute Programs task (see General 
Instructions for Importing Files on page 228), enter the required information according 
to Table 10.7. 

Steamboat Springs|CO|80477 Contact city|STP|post code 19|20|21

3038791710 Contact area code and phone 22

AR + Line number
(Line number is 0 + your TTY number)

+ .Y

Table 10.7—Importing Customer Records—Importing the File

Field Entry

Program Name CUSAR10

Switches Leave blank

Parameters Leave blank

Table 10.6—Importing Customer Records—Delimited File Example Entries and Fields 

Entry Field Name Import 
Field
Importing Customer Records—What Can You Import? 
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You can also go to your DOS prompt, type AFWRUN, and enter the program 
name to run the program from outside FundWare. 

IMPORTING CUSTOMER RECORDS—IMPORT FILE ERRORS

Once you have imported your file, the system produces and saves an error report to the 
FundWare > Data folder: 

For example, you are ready to import the file to Division 95, so you log onto your 
computer and check the TTY number, which is 864. Therefore, the line number is 0864 
and the error file for a Division 95 import is:

• ARX0864.L95
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

IMPORTING CUSTOMER RECORDS—ERROR MESSAGES

If there are errors in the import, review the error report to determine their causes. Then 
edit or create a new import file to add or correct those customers in error and run the 
program again. Table 10.8 defines some of the messages you may receive. 

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.

ARX + Line number
(Line number is 0 + your TTY number)

+ .L##
(## represents your division number)

Table 10.8—Importing Customer Records—Error Messages

Message Definition

Errors have occurred! One or more errors have been found in input text file. Errors are listed 
in the print file and if an error is found for a customer, no changes are 
made for that customer.

AR[TTY #].Z not in system. The input file listed does not exist in the data directory. The [line #] will 
be the number of the terminal executing the task.

Table 10.7—Importing Customer Records—Importing the File (Continued)

Field Entry
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ABFS parameter not in 
system.

The ABFS parameter has not been defined for the division specified in 
the keyword record.

No parameters supplied. No valid keywords could be found in the first non-blank record in the 
input file.

Division must be 01–99. The division number specified in the keyword record must be between 
1 and 99.

Division not in system. The division number specified in the keyword record has not been 
defined.

Keyword not recognized. A keyword was found in the first non-blank record but it was not DIV= 
or SEP=.

Record type not numeric. The first two characters of a record were not numeric. This could be 
caused by previous records not having enough or having too many 
separator characters.

Invalid record type. The only valid record types are 00-08. This could be caused by 
previous records not having enough or having too many separator 
characters. 

Duplicate field use. More than one of a record type was found after a 00 record. For 
example, two records with an 03 record type in columns 1 and 2. This 
could be caused by previous records not having enough or having too 
many separator characters.

Customer number may not 
be used.

A zero customer number may not be used.

Billing run may not be 
changed.

You may not change a customers billing run after the customer has 
been defined.

Billing run may not be used. The billing run must be between 1 and 40.

Billing run not in system. The billing run specified has not been defined.

Class not in system. The class specified has not been defined.

Region not in system. The region specified has not been defined.

Customer active must be ‘Y’ 
or ‘N’.

The only valid values for the customer active flag are Y and N.

Add interest must by 'Y' or 'N'. The only valid values for the additional interest calculation are Y and 
N.

Table 10.8—Importing Customer Records—Error Messages (Continued)

Message Definition
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IMPORT TRANSACTIONS
The Import Transactions task is used to import balance forward transactions from a text 
file into the Accounts Receivable module. This task will not post open item transactions. 
Some features include:

• Each execution of the task imports one batch of transactions.
• The number of transactions in a batch is essentially unlimited (over nine 

million).
• You can use decimal points and commas may be used for clarity, but they are 

ignored by the program.
• Amounts must all be numerals. Do not use the $ character. You must enter all 

digits, including cents.
• Optionally, a batch total may be entered and checked against the total of all 

transactions in the batch.

IMPORTING TRANSACTIONS—IMPORT FILE FORMAT

The text files cannot contain special characters. Special characters, such as tabs and 
form-feeds, are typically characters that are not printable. Each line of text must be 
terminated with the line terminator for the operating system. For example, in MS-DOS 
the line terminator is a carriage return/new line sequence.
You use three types of records in the text file containing the transactions to be imported:

• Keyword record
• Batch total record
• Transaction records

Add charges must by ‘Y’ or 
‘N’.

The only valid values for the additional charges calculation are Y and 
N.

Add alloc must by ‘Y’ or ‘N’. The only valid values for the additional allocations calculation are Y 
and N.

Add deposit must by ‘Y’ or 
‘N’.

The only valid values for the additional deposit calculation are Y and N.

Table 10.8—Importing Customer Records—Error Messages (Continued)

Message Definition
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This section defines the record types and explains how to format the records in the text 
file. Rules specific to each record type are explained below.

KEYWORD RECORD

The first non-blank line of the import text file is the keyword record (there can be only 
one in each import file). The keyword record identifies the division and may also 
identify the separator character. If no separator character is defined here, the | (pipe sign) 
is used as the default. The format is: 

BATCH TOTAL RECORD

The second non-blank line of the import text file is the batch total record (there can be 
only one in each import file). The batch total record contains the business date, an 
indicator whether batch total checking is required, and the total dollar amount of 
transactions to be imported. The maximum dollar amount of the batch total is 
999,999,999,999,999.99. Use the format (with the default pipe sign as separator): 

Business Date|Y or N|Batch Total

TRANSACTION RECORD

Each transaction must include two input records (i.e., two lines in the import file) that 
contain the information. The format is:

Customer#|Charge code|Description|Units|Unit price|Amount|
Allocated charge code|Allocated period|Account number|

DIV = nn SEP = x FUNC = opt

where

• nn is the division number

• x is the separation character

• opt is the default for allocated payments. Must be Even (“E”), Oldest (“O”), or Both (“B”). The default is 
E.
Import Transactions 



Chapter 10—Importing/Exporting AR Information (5.8/5.9 Customers)
IMPORTING TRANSACTIONS—FIELD DEFINITIONS

Each field in the import file must not exceed the lengths specified on the next page. 
Each field is separated by the separator character. Some of the fields have options, 
certain lengths and special considerations based on the charge code definition. 

Table 10.9—Importing Transactions—Field Definitions

Field Maximum Field Size

Customer 
number

Up to 9 numeric characters
• The number must exist in your Accounts Receivable system.

Charge code Up to 4 numeric characters
• The number must exist in your Accounts Receivable system.

Description 30 characters that contain a description of the transaction
• If the charge code allows the description to be entered, this description will be 

used. 
• Otherwise, the charge code description is used for the transaction.

Units Maximum of 99,999,999,999.999999
• If the charge code allows the entry of units, the number entered will be used. 
• Otherwise, the units will be set to zero.

Unit Price Maximum of 99,999,999,999.999999
• For calculated rate structures, the unit price is always set to zero. 
• For single rate structures, if the charge code allows the entry of unit price and 

one is present in the input record, use it. 
• Otherwise, use the unit price from the charge code definition. 

Amount Maximum of 999,999,999,999,999.99
• For charge codes with calculated rate structures, the amount is always 

calculated. 
• For single rate structures, if the charge code allows entry of the amount and 

there is an amount in the input record, use it. 
• If the amount can be calculated, i.e., neither the units or unit price is zero, 

calculate the amount by using units X unit price. 
• Otherwise, use the single rate structure amount from the charge code definition.
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IMPORTING TRANSACTIONS—IMPORT FILE EXAMPLE

This example contains three transactions that post to division 95. 
DIV=95
02282004|Y|50.00|
100|20|Initial deposit|||50.00|
|
1000|2|Adj to 30 days|||-50.00|
A01 00 00 1110|
3000|250||5.000000|10.000000||
|

Table 10.10 takes each entry in the import example and defines the associated fields. 

Allocated charge 
code

Up to 5 numeric characters (Optional field)

Allocated period 1 character (Optional field)
• When no allocated charge code or period is specified, the system must generate 

the allocations based on the option specified in the keyword record. Multiple 
entries cannot be entered for the input record.

• An allocated charge code is specified but no allocated period is specified. The 
FUNC= specified in the keyword record will be used to determine how the 
allocation is to be applied. Multiple entries could be posted for the input record.

• An allocated charge and period are specified. A single entry will be posted for the 
input record.

Account number If the charge code allows entry of the account number and an account number is 
present in the input record, use it. 
• Otherwise, the account number will be taken from the charge code definition.
If allocated payments are used, the default account number is the allocated 
account specified in the charge code record.
• Otherwise, the account number can be specified in the text file.

Table 10.10—Importing Transactions—Delimited File Example Entries and Fields

Line Entry Definition

line 1 DIV=95 Keyword record

Table 10.9—Importing Transactions—Field Definitions (Continued)

Field Maximum Field Size
Import Transactions 
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IMPORTING TRANSACTIONS—IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

Because many Accounts Receivable import types use the same file name, you 
can only have one import file in your system at any one time.

For example, if your Station ID number is 864, the import name must be:
• AR0864.Y

line 2 02282004|Y|50.00| Batch total record
• Batch total is 50.00 and will be checked against 

the transaction total.

line 3 100|20|Initial deposit|||50.00| A 50 dollar deposit transaction, charge code 20, to 
customer 100.
• The Units and Unit price fields are blank.

line 4 | • The account number will be taken from the charge 
code definition.

• The Allocated charge code and Allocated period 
fields are blank. 

line 5 1000|2|Adj to 30 days|||-50.00| A -50.00 adjustment, charge code 2, to customer 
1000.

line 6 A01 00 00 1110| Transaction will be posted to this account.
• The Allocated charge code and Allocated period 

fields are blank.

line 7 3000|250||5.000000|10.000000|| A 50.00 initial water charge, charge code 250, to 
customer 3000.

line 8 | • The account number will be taken from the charge 
code definition.

• The Allocated charge code and Allocated period 
fields are blank. 

AR + 0 + your Station ID number + .Y

Table 10.10—Importing Transactions—Delimited File Example Entries and Fields (Continued)

Line Entry Definition
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For more information on Station ID numbers, see Appendix F—Determining Your 
Station ID on page 355.

IMPORTING TRANSACTIONS—IMPORTING THE FILE

To import the transactions file from the Execute Programs task (see General 
Instructions for Importing Files on page 228), enter the required information according 
to Table 10.11. 

You can also go to your DOS prompt, type AFWRUN, and enter the program 
name to run the program from outside FundWare. 

IMPORTING TRANSACTIONS—IMPORT FILE ERRORS

Once you have imported your file, the system produces and saves an error report to the 
FundWare > Data folder: 

For example, if your Station ID number is 864, the error file for a Division 95 import is:
• ARY0864.L95

For more information on Station ID numbers, see Appendix F—Determining Your 
Station ID on page 355.

Table 10.11—Importing Transactions—Importing the File

Field Entry

Program Name CUSAR20

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.

ARY + 0 + your Station ID number + .L##
(## represents your division number)
Import Transactions 
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IMPORTING TRANSACTIONS—ERROR MESSAGES

If there are errors in the import, review the error report to determine their causes. Then 
edit or create a new import file to add or correct those customers in error and run the 
program again. Table 10.12 defines some of the messages you may receive. 

Table 10.12—Importing Transactions—Error Message

Message Definition

Errors have 
occurred in extract!

Format errors have been found in transaction extract. The batch will not be 
posted.

Errors have 
occurred in edit!

Fatal errors have been found in transaction edit. The batch will not be posted.

No transactions to 
post!

The import file contained no valid transactions to post. Create a text file named 
AR[line #].Y that contains valid accounts receivable transactions.

AR[line #].Y File 
not in system.

The input text file was not in the data directory. The [line #] will be the number of 
the terminal executing the task.

No parameters 
supplied.

The keyword record was not found. The keyword record must contain DIV= and 
optionally SEP= for the separator character. It must be the first non-blank record 
in the input file.

Division must be 
01–99.

The division specified in the DIV= parameter must be in the range of 01 to 99.

Division not in 
system.

The division specified in the DIV= parameter has not been defined.

Keyword not 
recognized.

The only valid keywords in the first non-blank record in the text file are DIV= and 
SEP=.

Balance flag must 
by 'Y' or 'N'.

The second field in the batch total record must be Y or N to indicate whether or 
not the batch total should be checked.

Function may not 
be used.

The specified function was invalid. Valid values are: “E”, “O” or “B”.

Invalid posting 
date.

The first field in the batch total record must be a valid calendar date, format 
MMDDYYYY.

Transactions do 
not balance.

The computed transaction total does not equal the batch total entered in the batch 
total record and the check balance flag was entered as a Y.

Customer may not 
be used.

A customer number of all zeros may not be used.
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IMPORTING ORDERS
This task is used to import orders from a text file into the Accounts Receivable system. 
Some features include:

• Each execution of the task imports one batch of orders.
• The number of transactions in a batch is essentially unlimited (over nine 

million).

Customer not in 
system.

The customer number in the record has not been defined.

Billing run not in 
system.

The billing run in the customer record was not found in the ABFS parameter.

Year end not yet 
run.

The current period for the billing run in the ABFS parameter is greater than the 
year end period for the billing run in the ABFC parameter record.

Warning! 
Statement already 
printed.

The statement has already been printed for the customer.

Warning! 
Customer inactive.

The customer has been flagged as inactive.

Charge code not in 
system.

The charge code entered in the transaction has not been defined.

Donations not 
allowed.

A charge code that has been defined as a donation type was entered in the 
transaction and donations are not supported at this time.

Billing run uses 
payment 
allocation.

.A payment type charge code was entered for a customer whose billing run uses 
payment allocation. Transactions may not be imported for customers in billing 
runs that use payment allocation.

Account number 
may not be used.

No account number was entered on a transaction and no account number exists 
in the charge code definition.

ID type x not in 
system.

The account number for the ID type listed has not been defined.

Units X unit price 
not = amount.

The calculated units X unit price in the transaction does not equal the amount 
entered in the transaction.

Table 10.12—Importing Transactions—Error Message (Continued)

Message Definition
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• You can use decimal points and commas may be used for clarity, but they are 
ignored by the program.

• Amounts must all be numerals. Do not use the $ character. You must enter all 
digits, including cents.

IMPORTING ORDERS—IMPORT FILE FORMAT

The text files cannot contain special characters. Special characters, such as tabs and 
form-feeds, are typically characters that are not printable. Each line of text must be 
terminated with the line terminator for the operating system. For example, in MS-DOS 
the line terminator is a carriage return/new line sequence.
You use three types of records in the text file containing the transactions to be imported:

• Keyword record
• Batch total record
• Transaction records

The program processes imported orders the same as the Enter Order task based upon 
how the system parameter flags are defined. This section defines the record types and 
explains how to format the records in the text file. Rules specific to each record type are 
explained below.

KEYWORD RECORD

The first non-blank line of the import text file is the keyword record (there can be only 
one in each import file). The keyword record identifies the division and may also 
identify the separator character. If no separator character is defined here, the | (pipe sign) 
is used as the default. The format is: 

DIV = nn SEP = x

where

• nn is the division number

• x is the separation character
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BATCH HEADER RECORD—RECORD TYPE 0

The second non-blank line of the import text file is the batch header record (there can be 
only one in each import file). The batch header record contains the record type (must be 
the number 0), the business date, group name, operator and the form name for this batch. 
Use the format (with the default pipe sign as separator): 

Record type|Business date|Group name|Operator|Formz
Table 10.13 defines each entry in the batch total record. 

ORDER HEADER RECORD—RECORD TYPE 1

Use one order header record (i.e., Record Type 1) for each order in the batch. This 
record contains three lines. The format for record type 1 is explained below. Please note: 
lines 2 and 3 are indented two spaces. (Also, the information in line 1 should be on one 
line in the text file. This example has line breaks due to the width of the page.)

Line 1 (S = Ship). The format is: 
1|Record type|Cust #|S name|S str1|S str2|S city|S STP|S post code|S country|S phone 
#|S FAX #
Description|Ship method|Terms|Client PO
User 1|User 2|User 3|User 4|User 5

Table 10.14 defines each entry in record type 1. 

Table 10.13—Batch Header Record (Type 0)—Field Definitions

Field Definition

Record type 0 (zero)

Business date mmddyyyy

Group name Must be a valid RAM group name. Up to 10 characters.

Operator Enter operator name. Up to 3 characters.

Form The form name. Up to 5 characters.

Table 10.14—Record Type 1—Field Definitions

Field Definition

Line 1

Record type 1 (one)
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Customer number Up to 9 digits.

Ship name Up to 35 characters.
• If you enter “Bill”, the name, street 1 and 2, City/STP/Post, country, phone 

and FAX numbers from the Billing info field in the master customer record 
will be imported. 

• If you enter “Contact”, the name, street 1 and 2, City/STP/Post, country, 
phone and FAX numbers from the Contact info field in the master customer 
record will be imported.

Ship street 1 Up to 35 characters.

Ship street 2 Up to 35 characters.

Ship city Up to 19 characters.

Ship STP Up to 5 characters.

Ship postal code Up to 9 characters.

Ship country Up to 35 characters.

Ship phone number Up to 10 digits.

Ship FAX number Up to 10 digits.

Line 2

Description Up to 30 characters.

Ship method Up to 30 characters. If left blank, the ship method from the customer's master 
record will be imported.

Terms Up to 30 characters. If left blank, the terms from the customer's master record 
will be imported.

Client PO Up to 30 characters.

Line 3

User 1 Up to 30 characters.

User 2 Up to 30 characters.

User 3 Up to 30 characters.

User 4 Up to 30 characters.

User 5 Up to 30 characters.

Table 10.14—Record Type 1—Field Definitions (Continued)

Field Definition
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ORDER DETAIL RECORD—RECORD TYPE 2

Record type 2 is used for order detail. You must have at least one record type 2 for each 
record type 1; however, you may have multiple record type 2s depending on the number 
of item numbers defined for each order. The format is:
Use at least one order detail record (i.e., Record Type 2) for each order header record 
(type 1). This record contains two lines. The format for record type 2 is explained below. 
Please note: line 2 is indented two spaces. (Also, the information in line 1 should be on 
one line in the text file. This example has line breaks due to the width of the page.)

2|Record type|Item #|Line type|Stock #|Code|Detail desc1|Detail desc2|
Detail desc3|Detail desc4
Quantity|Unit of measure|Unit price|Amount|Account

Table 10.15 defines each entry in record type 1.

Table 10.15—Record Type 2—Field Definitions

Field Definition

Line 1

Record type 2 (two)

Item number Up to 4 characters.

Line type 1 digit. Must be a C (charge code) or a S (stock code). A “S” entry is only 
valid with the inventory system.

Stock number Up to 15 characters. Enter stock number if you selected an S.

Code Up to 4 digits. Enter charge code number if you selected a C.

Detail description 1 Up to 55 characters.

Detail description 2 Up to 55 characters.

Detail description 3 Up to 55 characters.

Detail description 4 Up to 55 characters.

Line 2

Quantity Up to 10 digits and 6 decimal places (six decimal places are required).
• If the amount field is left blank, the system will compute the amount by 

multiplying the quantity and unit price fields.
• If the quantity, unit price and amount fields contains numbers, the system 

will verify that quantity times the unit price equals the number in the 
amount field. If not, an error message will be printed. 
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IMPORTING ORDERS—IMPORT FILE EXAMPLE

The following example adds to invoice form FORM1, customer 10, with a charge code 
of 7001 in Division 95.

DIV=95
0|01312004||KAR|FORM1
1|10|Mark Swans|3989 North Federal Highway||

Westminster|CO|80232||3035661000|Cookbook reorder|
UPS Reg|Net 30|8650 2% discount if pay cash||||

2|1|C||7001|Colorado Cookbook II|||
1.000000|each|30.000000||A0100004910

IMPORTING ORDERS—IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

Because many Accounts Receivable import types use the same file name, you 
can only have one import file in your system at any one time.

Unit of measure Up to 5 characters.

Unit price Up to 10 digits and 6 decimal places (six decimal places are required).
• If the amount field is left blank, the system will compute the amount by 

multiplying the quantity and unit price fields.
• If the quantity, unit price and amount fields contains numbers, the system 

will verify that quantity times the unit price equals the number in the 
amount field. If not, an error message will be printed. 

Amount Up to 10 digits and 2 decimal places (two decimal places are required).
• If the amount field is left blank, the system will compute the amount by 

multiplying the quantity and unit price fields.
• If the quantity, unit price and amount fields contains numbers, the system 

will verify that quantity times the unit price equals the number in the 
amount field. If not, an error message will be printed. 

Account Up to 55 characters.

AR + Line number
(Line number is 0 + your TTY number)

+ .Y

Table 10.15—Record Type 2—Field Definitions (Continued)

Field Definition
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For example, you are ready to import the file, so you log onto your computer and check 
the TTY number, which is 864. Therefore, the line number is 0864 and the import name 
must be:

• AR0864.Y
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

IMPORTING ORDERS—IMPORTING THE FILE

To import the orders file from the Execute Programs task (see General Instructions for 
Importing Files on page 228), enter the required information according to Table 10.16. 

You can also go to your DOS prompt, type AFWRUN, and enter the program 
name to run the program from outside FundWare. 

IMPORTING ORDERS—IMPORT FILE ERRORS

Once you have imported your file, the system produces and saves an error report to the 
FundWare > Data folder: 

For example, you are ready to import the file to Division 95, so you log onto your 
computer and check the TTY number, which is 864. Therefore, the line number is 0864 
and the error file for a Division 95 import is:

• ARX0864.L95

Table 10.16—Importing Orders—Importing the File

Field Entry

Program Name CUSAR25

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.

ARX + Line number
(Line number is 0 + your TTY number)

+ .L##
(## represents your division number)
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For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

IMPORTING ORDERS—ERROR MESSAGES

Table 10.17 explains the messages that may appear on the screen as you execute the 
program. 

Table 10.18 explains the messages that may appear on the screen as you execute the 
program. If errors are reported, correct the errors in the text file and import the file 
again.

Table 10.17—Importing Orders—Screen Error Messages

Message Definition

ABFS parameter requires 
conversion.

The wrong version of the ABFS parameter record is installed. Install the 
correct version of the program.

Errors have occurred in 
extract!

Format errors have been found in the text extract program and the task 
is terminated.

Errors have occurred in edit! Errors have been found while editing the extracted text file and the task 
is terminated.

File not in system. An input file could not be found with the name of AR(line).Y.

ICSS parameter requires 
conversion.

The wrong version of the ICSS parameter record is installed. Install the 
correct version of the program.

Inventory not active. The ICSS parameter has not been defined but the ABFS parameter 
uses stock numbers.

No transactions to post! No valid transactions were found to post and the task is terminated.

Parameter not in system. The ABFS parameter has not been defined.

Table 10.18—Importing Orders—Error Report Messages

Message Definition

Charge code not in system. The charge code in the order detail record has not been defined.

Customer billing run not in 
system.

The customer billing run has not been defined.

Customer billing run not open 
item.

The customer billing run is not open item.
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Customer can't be used. The customer number in the order header record is zero which is not 
valid.

Customer not in system. The customer number in the order header record has not been 
defined.

Division must be 01–99. The division number supplied after the DIV= keyword must be in the 
range of 01 to 99.

Division not in system. The division number supplied after the DIV= keyword has not been 
defined.

Duplicate detail. Two or more detail records for the same order have been input with 
the same item number.

File not in system. An input file could not be found with the name of AR(line).Y.

Form not in system. The form number in the order header record has not been defined.

Header entry has no detail. The header record has no detail record defined.

Invalid field number. Field number (column 1 of each record) must be:
• 0 = Batch header record
• 1 = Order header record
• 2 = Order detail record

Invalid line type. The line type must be “S” or “C.”

Invalid posting date. The posting date in the batch header record must be a valid calendar 
date.

Invalid transaction account. The transaction account entered in the detail record is not valid.

Keyword not recognized. The only valid keywords are DIV= and SEP=.

No parameters supplied. No keywords were found in the first non-blank record in the input file.

Operator not in system. The operator number in the batch header record has not been 
defined.

Stock number can't be used. The stock number in the order detail record is zero which is not valid.

Stock number not in system. The stock number in the order detail record has not been defined

Unit times unit price not = 
amount.

The unit, unit price and amount fields must be correct.

Table 10.18—Importing Orders—Error Report Messages (Continued)

Message Definition
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IMPORTING METER TRANSACTIONS
This task is used to import meter readings from a text file into the Accounts Receivable 
system. Some features include: 

• Each execution of the task imports one batch of meter readings.
• The number of transactions in a batch is essentially unlimited (over nine 

million).
• You can use decimal points and commas for clarity, but they are ignored by the 

program.
• Amounts must all be numerals. Do not use the $ character. You must enter all 

digits, including cents.

IMPORTING METER TRANSACTIONS—IMPORT FILE FORMAT

The text files cannot contain special characters. Special characters, such as tabs and 
form-feeds, are typically characters that are not printable. Each line of text must be 
terminated with the line terminator for the operating system. For example, in MS-DOS 
the line terminator is a carriage return/new line sequence.
You use three types of records in the text file containing the transactions to be imported:

• Keyword record
• Batch header record
• Meter reading record

KEYWORD RECORD

The first non-blank line of the import text file is the keyword record (there can be only 
one in each import file). The keyword record identifies the division and may also 
identify the separator character. If no separator character is defined here, the | (pipe sign) 
is used as the default. The format is: 

DIV = nn SEP = x

where

• nn is the division number

• x is the separation character
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BATCH HEADER RECORD—RECORD TYPE 1

The second non-blank line of the import text file is the batch header record (there can be 
only one in each import file). The batch header record contains the record type (must be 
the number 1), the business date, and the function for this batch. The following 
functions are allowed:

• A—Enter meter readings
• B—Adjust current readings
• C—Enter delayed readings
• D—Adjust delayed readings

Use the format (with the default pipe sign as separator): 
1|Business Date|Function|

METER READING RECORD—RECORD TYPE 2

Each meter reading uses one input record that contains the information. The format is: 
2|Customer#|Meter#|Reading Date|Meter reading| 

Table 10.19 defines each entry in record type 2. 

Table 10.19—Record Type 2—Field Definitions

Field Definition

Customer# Up to 9 numeric characters
• The number must exist in your Accounts Receivable system.

Meter# Up to 10 numeric characters
• The number must exist in your Accounts Receivable system.

Reading Date This must be valid calendar date in the format MMDDYYYY.

Meter reading The meter reading is a number that contains a maximum of 99,999,999,999.999999.
Importing Meter Transactions 
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IMPORTING METER TRANSACTIONS—IMPORT FILE EXAMPLE

This example contains three meter readings that post to division 95. The function for the 
batch is type B, change meter readings.

DIV=95
1|05312004|B|
2|100|w100|05152004|7500057.376900|
2|300|w300|05202004|4679.000000|
2|400|w400|05212004|50.000000

Table 10.20 defines each entry in the example. 

IMPORTING METER TRANSACTIONS—IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

For example, if your TTY number is 864, the line # is 0864. So the import file name 
would be:

• AR0864.N
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

Table 10.20—Importing Meter Transactions—Example Import File

Entry Definition

DIV=95 Keyword record

1|05312004|B| Batch header

2|100|w100|05152004|7500057.376900| Meter reading

2|300|w300|05202004|4679.000000| Meter reading

2|400|w400|05212004|50.000000| Meter reading

AR + Line number
(Line number is 0 + your TTY number)

+ .N
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IMPORTING METER TRANSACTIONS—IMPORTING THE FILE

To import the meter transactions file from the Execute Programs task (see General 
Instructions for Importing Files on page 228), enter the required information according 
to Table 10.21. 

You can also go to your DOS prompt, type AFWRUN, and enter the program 
name to run the program from outside FundWare. 

IMPORTING METER TRANSACTIONS—IMPORT REPORT

When you import meter transactions, the system saves a transaction report to the 
FundWare > Data folder: 

For example, you are ready to import the file, so you log onto your computer and check 
the TTY number, which is 864. Therefore, the line number is 0864 and the error file for 
a Division 95 import is:

• ARN0864.Y
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

Table 10.21—Importing Meter Transactions—Importing the File

Field Entry

Program Name CUSAR32

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.

ARN + Line number
(Line number is 0 + your TTY number)

+ .L##
(## represents your division number)
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IMPORTING METER TRANSACTIONS—IMPORT FILE ERRORS

When you run the import task, the system checks the file for errors. If errors are found, 
the error report is saved to the FundWare > Data folder with the following name: 

For example, if your TTY number is 864, the line # is 0864. So the error file for 
Division 95 import is:

• ARN0864.L95
If there are errors, review the error report to determine their causes. Then either edit or 
create a new import file to add or correct those meter transactions in error and run the 
program again. 

IMPORTING METER TRANSACTIONS—ERROR MESSAGES

Table 10.22 explains errors messages that you may receive during this process. 

ARN + Line number
(Line number is 0 + your TTY number)

+ .L##
(## represents your division number)

Table 10.22—Importing Meter Transactions—Error Messages

Message Definition

Errors occurred in extract. Format errors have been found in the input text file. The batch is not 
posted.

Parameter not in system. The ABFS system parameter has not been defined for the division 
specified in the DIV= parameter of the keyword record.

Meters not used. The A/R system being updated is not set up to use meters.

Errors occurred in edit. Errors have been found in the input file. The batch is not posted.

No transactions to post. No valid transactions were found in the input text file.

No parameters supplied. A valid keyword record, which must be the first non-blank record in the 
file was not found.

Division must be 01–99. The division number found in the DIV= keyword record must be in the 
range of 01 to 99.

Division not in system. The division number found in the DIV= keyword record has not been 
defined.

Keyword not recognized. The only valid keywords in the first non-blank record in the file are DIV= 
and SEP=.
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Invalid record type. The only valid record types (column 1 of each record) after the keyword 
record are 1 for the header record and 2 for the detail records.

Invalid posting date. The posting date, field 2 in the header record, is not a valid calendar 
date. The format is MMDDYYYY.

Header record missing. The first non-blank record after the keyword record must be a record 
type 1.

Invalid function. The function in the header must be one of the following:
• A—Enter meter readings
• B—Adjust current meter readings
• C—Enter delayed meter readings
• D—Adjust delayed meter readings

Record type is not detail. All records following the header record must be detail records (type 2).

Customer not in system. The customer number in the detail record has not been set up in the AR 
system.

Warning–customer inactive. The customer number in the detail record has been coded as inactive in 
the AR system.

Warning–statement already 
printed.

The customer number in the detail record has already had a statement 
printed in the current billing period.

Meter not in system. The customer/meter number in the detail record has not been set up in 
the AR system.

Reading already in system. The function for this run is “enter meters” or “enter delayed meters” and 
the customer/meter number in the detail record has already had a meter 
reading entered for this billing period.

Reading not in system. The function for this run is “adjust meters” or “adjust delayed meters” 
and the customer/meter number in the detail record has not had a 
meter reading entered for the current billing period.

Meter has delayed reading. The function for this run is “adjust meters” and the customer/meter 
number in the detail record has a delayed meter reading in the current 
billing period.

Meter has current reading. The function for this run is “adjust delayed meters” and the customer/
meter number in the detail record has a meter reading in the current 
billing period.

Duplicate entry. The customer/meter number in the detail record has already been 
entered in this batch.

Table 10.22—Importing Meter Transactions—Error Messages (Continued)

Message Definition
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IMPORTING METER MAINTENANCE
Use this task to import both information for new meters and changes to current meter 
records. When you are making a change, you only need to include the customer number, 
meter number and the information being changed.

IMPORTING METER MAINTENANCE—REQUIREMENTS AND CAUTIONS

The following rules apply to each import file: 
• One (and only one) keyword record must be present as the first non-blank 

record in the file.
• A type 00 record must be used to assign a customer number and meter number. 

All field numbers following the 00 record pertain to the customer/meter number 
in the 00 record.

• Blank fields must be indicated by separator characters.
• If you wish to change any of the information in a particular record type, you 

must include all fields for that record type. For example, if you wish to change 
the route sequence using record type 03, you must also include the route number 
for the meter.

Meter reading greater than 
meter digits.

The meter reading in the detail record has more significant digits than is 
allowed for the meter.

Warning–reading looped 
past zero.

The meter reading in the detail record caused the meter to roll over.

Charge code entry not 
allowed.

The customer/meter/charge code in the meter billing charge file (ARN) 
is coded as active but the charge code does not exist in the charge 
code (ARF) file.

Table 10.22—Importing Meter Transactions—Error Messages (Continued)

Message Definition
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IMPORTING METER MAINTENANCE—IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

For example, if your TTY number is 864, the line # is 0864. So the import file name 
would be:

• AR0864.M
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

IMPORTING METER MAINTENANCE—IMPORT FILE FORMAT

You use two types of records in the text file containing the meter maintenance readings 
to be imported:

• Keyword records, and
• Meter records.

This section defines the record types and explains how to format the records in the text 
file. Rules specific to a record type are explained below.

KEYWORD RECORD

The first non-blank line of the import text file is the keyword record (there can be only 
one in each import file). The keyword record identifies the division and may also 
identify the separator character. If no separator character is defined here, the | (pipe sign) 
is used as the default. The format is: 

AR + Line number
(Line number is 0 + your TTY number)

+ .M

DIV = nn SEP = x

where

• nn is the division number

• x is the separation character
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METER RECORDS 

All other records must be a two-digit record type followed by a field separator and the 
information for the field. Character fields begin directly after the field separator 
character and terminate at the next field separator. Fields that are too short are padded 
with spaces, those that are too long are truncated.
Table 10.23 defines the record types and fields for the meter records. 

Table 10.23—Importing Meter Maintenance—Meter Record Field Descriptions

Type Field Description Maximum Field Size

00 Customer number|Meter number 9 digits|10 characters

01 Meter type 5 characters

02 Status 1 character (FNLI)

03 Route number|Route sequence 4 characters|4 characters

04 House number|Direction|Street 5 characters|1 character|30 characters

05 Service note 1|Service note 2 30 characters|30 characters

06 Multiplier|Meter digits|Demand meter 99,999,999,999.999999|1 digit| 
character (Y or N)

07

08 Date 1|Reading 1|Date 2|Reading 2|Date 
3|Reading 3|Date 4|Reading 4|Date 
5|Reading 5|Date 6|Reading 6

for each date and reading:
99/99/9999|99,999,999,999.999999

09 Date 7|Reading 7|Date 8|Reading 8|Date 
9|Reading 9|Date 10|Reading 10|Date 
11|Reading 11|Date 12|Reading 12

for each date and reading:
99/99/9999|99,999,999,999.999999

10 Code 1|Status 1|Code 2|Status 2|Code 
3|Status 3|Code 4|Status 4|Code 5|Status 
5|Code 6|Status 6|Code 7|Status 7|Code 
8|Status 8

For each code and status:
4 digits|1 character (I or A)
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IMPORTING METER MAINTENANCE—IMPORT FILE EXAMPLE

The following example adds customer 1000, meter number W100 and changes the 
Route number and route sequence for customer 2000, meter number W200 in division 
95.

DIV=95
00|1000|W100|
01|Water|
02|F|
03|1000|1001|
04|123|E|Main St.|
05|Meter in back of house|Large dog|
06|1|4|N|
08|01312004|1000|
10|201|A|
00|2000|W200|
03|1000|1002|

IMPORTING METER MAINTENANCE—IMPORTING THE FILE

To import the meter maintenance file from the Execute Programs task (see General 
Instructions for Importing Files on page 228), enter the required information according 
to Table 10.24. 

You can also go to your DOS prompt, type AFWRUN, and enter the program 
name to run the program from outside FundWare. 

Table 10.24—Importing Meter Maintenance—Importing the File

Field Entry

Program Name CUSAR31

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
Importing Meter Maintenance 



Chapter 10—Importing/Exporting AR Information (5.8/5.9 Customers)
IMPORTING METER TRANSACTIONS—IMPORT REPORT

When you import meter transactions, the system saves a transaction report to the 
FundWare > Data folder: 

For example, you are ready to import the file to division 95, so you log onto your 
computer and check the TTY number, which is 864. Therefore, the line number is 0864 
and the import name must be:

• ARM0864.L95
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

IMPORTING METER MAINTENANCE—IMPORT FILE ERRORS

When you run the import task, the system checks the file for errors. If errors are found, 
the error report is saved to the FundWare > Data folder with the following name: 

For example, if your TTY number is 864, the line # is 0864. So the error file for 
Division 95 import is:

• ARM0864.L95
If there are errors, review the error report to determine their causes. Use the Define 
Meters task to edit the meters, or create or edit a new import file to add or correct those 
meters in error and run the program again. 

ARM + Line number
(Line number is 0 + your TTY number)

+ .L##
(## represents your division number)

ARM + Line number
(Line number is 0 + your TTY number)

+ .L##
(## represents your division number)
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IMPORTING METER MAINTENANCE—ERROR MESSAGES

Table 10.25 explains errors messages that you may receive during this process.

Table 10.25—Importing Meter Maintenance—Error Messages

Message Definition

Errors have occurred! One or more errors have been found in input text file. Errors are listed in 
the print file and if an error is found for a meter, no changes are made for 
that meter.

AR[line #].M not in system. The input file listed does not exist in the data directory. The [line #] will be 
the number of the terminal executing the task.

ABFS parameter not in 
system.

The ABFS parameter has not been defined for the division specified in 
the keyword record.

No parameters supplied. No valid keywords could be found in the first non-blank record in the input 
file.

Division must be 01-99. The division number specified in the keyword record must be between 1 
and 99.

Division not in system. The division number specified in the keyword record has not been 
defined.

Keyword not recognized. A keyword was found in the first non-blank record but it was not DIV= or 
SEP=.

Record type not numeric. The first two characters of a record were not numeric. This could be 
caused by previous records not having enough or having too many 
separator characters.

Invalid record type. The only valid record types are 00–10. This could be caused by previous 
records not having enough or having too many separator characters.

Duplicate field use. More than one of a record type was found after a 00 record. For example, 
two records with an 03 record type in columns 1 and 2. This could be 
caused by previous records not having enough or having too many 
separator characters.

Customer not in system. The specified customer does not yet exist.

Meter number may not be 
used.

A blank meter number may not be used.

Status may not be used. An invalid meter status may not be used.

Multiplier may not be used. A multiplier must be a non-zero value.

Demand may not be used. An invalid demand indicator may not be used.
Importing Meter Maintenance 
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IMPORTING REPETITIVE BILLING
Use this task to import both information for new repetitive billing charges and changes 
to current repetitive billing charge records. When you are making a change, you only 
need to include the customer number, cycle, charge code and the information being 
changed.

IMPORTING REPETITIVE BILLING—REQUIREMENTS AND CAUTIONS

• One (and only one) keyword record must be present as the first non-blank 
record in the file.

• A type 00 record must be used to assign a customer number, cycle and charge 
code. All field numbers following the 00 record pertain to the customer/cycle/
charge code in the 00 record.

• Blank fields must be indicated by separator characters.
• If you wish to change any of the information in a particular record type, you 

must include all fields for that record type. For example, if you wish to change 
the amount for record type 03, you must also include the unit and unit price field 
with either a value or separator characters. 

Charge code not in system. The specified meter charge code has not been defined.

Charge status may not be 
used.

An invalid charge code status may not be used.

Readings may not be used. Once activity has been posted, meter readings may not be imported.

Reading date may not be 
used.

An invalid reading date may not be used.

Reading too large. A reading was entered that was larger than the number of digits allowed.

Table 10.25—Importing Meter Maintenance—Error Messages (Continued)

Message Definition
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IMPORTING REPETITIVE BILLING—IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

For example, if your TTY number is 864, the line # is 0864. So the import file name 
would be:

• AR0864.R
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

IMPORTING REPETITIVE BILLING—IMPORT FILE FORMAT

You use two types of records in the text file containing the repetitive billings to be 
imported:

• Keyword records, and
• Repetitive charge records.

This section defines the record types and explains how to format the records in the text 
file. Rules specific to a record type are explained below.

KEYWORD RECORD

The first non-blank line of the import text file is the keyword record (there can be only 
one in each import file). The keyword record identifies the division and may also 
identify the separator character. If no separator character is defined here, the | (pipe sign) 
is used as the default. The format is: 

AR + Line number
(Line number is 0 + your TTY number)

+ .R

DIV = nn SEP = x

where

• nn is the division number

• x is the separation character
Importing Repetitive Billing 
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REPETITIVE CHARGE RECORDS

All other records must be a two digit record type followed by a field separator and the 
information for the field. Character fields begin directly after the field separator 
character and terminate at the next field separator. Fields that are too short are padded 
with spaces, those that are too long are truncated. Refer to the example for formatting 
information.

Table 10.26 defines the record types and fields for the meter records. 

IMPORTING REPETITIVE BILLING—IMPORT FILE EXAMPLE

The following example adds customer 1000, cycle 01, charge code 201 and changes the 
description for customer 2000, cycle 01, charge code 301 in division 95.

DIV=95
00|1000|01|201|
01|Monthly water charge|
02|A|
03|||2500|
00|2000|01|301|
01|Monthly sewer charge|

Table 10.26—Importing Repetitive Billing—Charge Records Field Definitions

Type Field Description Maximum Field Size

00 Customer number|Cycle|Charge code 9 digits|2 digits|4 digits

01 Description 30 characters

02 Type 1 character (AUR)

03 Units|Unit price|Amount 99,999,999,999.999999|99,999,999,999.999999|
999,999,999,999.999.99
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IMPORTING REPETITIVE BILLING—IMPORTING THE FILE

To import the repetitive billing file from the Execute Programs task (see General 
Instructions for Importing Files on page 228), enter the required information according 
to Table 10.27. 

You can also go to your DOS prompt, type AFWRUN, and enter the program 
name to run the program from outside FundWare. 

IMPORTING REPETITIVE BILLING—IMPORT REPORT

When you import meter transactions, the system saves a transaction report to the 
FundWare > Data folder: 

For example, you are ready to import the file, so you log onto your computer and check 
the TTY number, which is 864. Therefore, the line number is 0864 and the import name 
must be:

• ARS0864.L95
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

Table 10.27—Importing Repetitive Billing—Importing the File

Field Entry

Program Name CUSAR40

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.

ARS + Line number
(Line number is 0 + your TTY number)

+ .L##
(## represents your division number)
Importing Repetitive Billing 
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IMPORTING REPETITIVE BILLING—IMPORT FILE ERRORS

When you run the import task, the system checks the file for errors. If errors are found, 
the error report is saved to the FundWare > Data folder with the following name: 

For example, if your TTY number is 864, the line # is 0864. So the error file for 
Division 95 import is:

• ARS0864.L95
If there are errors, review the error report to determine their causes. Use the Define 
Repetitive Charge task or Define Repetitive Billing to edit the meters, or create or edit a 
new import file to add or correct those meters in error and run the program again. 

IMPORTING REPETITIVE BILLING—ERROR MESSAGES

Table 10.28 explains errors messages that you may receive during this process. 

ARS + Line number
(Line number is 0 + your TTY number)

+ .L##
(## represents your division number)

Table 10.28—Importing Repetitive Billing—Error Messages

Message Definition

Errors have occurred! One or more errors have been found in input text file. Errors are listed in 
the print file and if an error is found for a meter, no changes are made for 
that meter.

AR[line #].R not in system. The input file listed does not exist in the data directory. The [line #] will be 
the number of the terminal executing the task.

ABFS parameter not in 
system.

The ABFS parameter has not been defined for the division specified in 
the keyword record.

No parameters supplied. No valid keywords could be found in the first non-blank record in the input 
file.

Division must be 01–99. The division number specified in the keyword record must be between 1 
and 99.

Division not in system. The division number specified in the keyword record has not been 
defined.

Keyword not recognized. A keyword was found in the first non-blank record but it was not DIV= or 
SEP=.
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EXPORTING ALLOCATION AGING
The Export Allocation Aging task allows you to extract the Accounts Receivable aging 
information into a text file. This file can then be imported into a spreadsheet or other 
processing program for producing various user reports.

EXPORTING ALLOCATION AGING—REQUIREMENTS AND CAUTIONS

The output of this task is only as current as the current information maintained in the 
FundWare files.

EXPORTING ALLOCATION AGING—EXPORT FILE NAME

You have two options for the export file name:
• The default file name (##ARA.TXO, where ## represents your division 

number), or 
• A user-defined file name.

Record type not numeric. The first two characters of a record were not numeric. This could be 
caused by previous records not having enough or having too many 
separator characters.

Invalid record type. The only valid record types are 00–10. This could be caused by previous 
records not having enough or having too many separator characters.

Duplicate field use. More than one of a record type was found after a 00 record. For example, 
two records with an 03 record type in columns 1 and 2. This could be 
caused by previous records not having enough or having too many 
separator characters.

Customer not in system. The specified customer does not yet exist.

Charge code not in 
system.

The specified meter charge code has not been defined.

Charge type may not be 
used.

An invalid charge type may not be used.

Cycle may not be used. The specified cycle number can not be zero.

Table 10.28—Importing Repetitive Billing—Error Messages (Continued)

Message Definition
Exporting Allocation Aging 



Chapter 10—Importing/Exporting AR Information (5.8/5.9 Customers)
EXPORTING ALLOCATION AGING—EXPORTING THE FILE

Use the following instructions to export the allocation aging information.
1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 10.3). 

Figure 10.3—System Utilities—Executing a Program

4. In the Execute Program area, enter the required information according to Table 
10.29. 

Table 10.29—Exporting Allocation Aging—Exporting the File

Field Entry

Program Name CUSAR15

Switches Leave blank
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EXPORTING ALLOCATION AGING—EXPORT FILE FIELD DEFINITIONS

Character fields are always surrounded by quotes, numeric fields are always printed 
without commas and contain a leading “-” if the field is negative. Figure 10.30 defines 
the fields in the export file. 

Parameters DIV=## O=filename
• Where ## represents your division number.
• O=filename is optional. This option allows you to enter a user-defined export file 

name.
— The export file name will match exactly what you enter after the equal sign. 

For example, “filename” has not file extension (e.g., .txt); therefore, the 
export file will have extension.

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
• You must select your division, even though you are also specifying the division in 

the Parameters field.

Table 10.30—Exporting Allocation Aging—Field Definitions

Field Number Definition

1 Customer number

2 Charge code

3 Current period postings

4 Current 30-day period postings

5 Current 60-day period postings

6 Current 90-day period postings

Table 10.29—Exporting Allocation Aging—Exporting the File (Continued)

Field Entry
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EXPORTING ALLOCATION AGING—EXPORT FILE EXAMPLE

The following is an example of an export file.
100,201,102.47,.00,.00,.00
100,202,20.00,.00,.00,.00
100,301,50.00,.00,.00,.00
100,401,60.00,.00,.00,.00
100,501,15.00,.00,.00,.00
200,11,1.58,1.21,.00,.00
200,15,.00,1.44,.00,.00
200,16,8.42,.00,.00,.00
200,201,29.52,28.73,.00,.00
200,202,20.00,20.00,.00,.00
200,302,10.81,8.84,.00,.00
200,401,30.00,30.00,.00,.00
200,501,15.00,15.00,.00,.00
300,201,27.80,.00,.00,.00
300,202,20.00,.00,.00,.00
300,302,6.50,.00,.00,.00
300,401,30.00,.00,.00,.00
300,501,15.00,.00,.00,.00

EXPORTING CUSTOMER RECORDS
The Export Customer Records task allows you to extract the Accounts Receivable 
customer master records into a text file. This file can then be imported into a spreadsheet 
or other processing program for producing various user reports.

EXPORTING CUSTOMER RECORDS—REQUIREMENTS AND CAUTIONS

The output of this task is only as current as the current information maintained in the 
FundWare files.

EXPORTING CUSTOMER RECORDS—EXPORT FILE NAME

You have two options for the export file name:
• The default file name (##ARC.TXO, where ## represents your division 

number), or 
• A user-defined file name.
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EXPORTING CUSTOMER RECORDS—EXPORTING THE FILE

Use the following instructions to export the allocation aging information.
1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 10.4). 

Figure 10.4—System Utilities—Executing a Program

4. In the Execute Program area, enter the required information according to Table 
10.31. 

Table 10.31—Exporting Customer Records—Exporting the File

Field Entry

Program Name CUSAR16

Switches Leave blank
Exporting Customer Records 
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EXPORTING CUSTOMER RECORDS—EXPORT FILE FIELD DEFINITIONS

Character fields are always surrounded by quotes, numeric fields are always printed 
without commas and contain a leading “-” if the field is negative. Figure 10.32 defines 
the fields in the export file. 

Parameters DIV=## O=filename
• Where ## represents your division number.
• O=filename is optional. This option allows you to enter a user-defined export file 

name.
— The export file name will match exactly what you enter after the equal sign. 

For example, “filename” has not file extension (e.g., .txt); therefore, the export 
file will have extension.

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
• You must select your division, even though you are also specifying the division in 

the Parameters field.

Table 10.32—Exporting Customer Records—Field Definitions

Field Number Definition

1 Customer number

2 Billing sortkey

3 Billing name

4 Billing street 1

5 Billing street 2

6 Billing city

7 Billing state/territory/province

8 Billing postal code

9 Service address-house, direction and street

10 Service address direction range

Table 10.31—Exporting Customer Records—Exporting the File (Continued)

Field Entry
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EXPORTING CUSTOMER RECORDS—EXPORT FILE EXAMPLE

The following is an example of an export file.
10,"JOHNSON, P","Paul J. Johnson","3290 East Riverside Avenue","Post Office 
Box 493","Denver", "CO","80225",0,"","",.00,.00
20,"GARNER, J","Jenny Garner","4009 South Wadsworth","Suite 
5000","Lakewood", "CO","80215", 0,"","",.00,.00
30,"ROONEY, A","Andrea Rooney","5684 East Kingston Street","Suite 100", 
"Aurora","CO","80237", 0,"","",.00,.00
40,"SWANS, M","Mark Swans","3989 North Federal Highway","","Westminster", 
"CO","80232", 0,"","",.00,.00
50,"HALL, M","Mary Ann Hall","5632 North Quebec Street","Post Office Box 
5943", "Englewood", "CO","80111",0,"","",.00,.00
60,"NORTON, A","Andy Norton","4563 North Federal","Suite 100","Denver","CO" 
,"80212", 4565,"N","Federal",.00,.00

EXPORTING CUSTOMER METERS
The Export Customer Meters task allows the user to extract the current meter 
information from the Accounts Receivable system into a text file. This file can then be 
imported into a spreadsheet or other processing program for producing various user 
reports. 

EXPORTING CUSTOMER METERS—REQUIREMENTS AND CAUTIONS

The output of this task is only as current as the current information maintained in the 
FundWare files.

EXPORTING CUSTOMER METERS—EXPORTING THE FILE

1.  Open an instance of FundWare.

11 Service address number

12 Total deposits

13 Total deposit interest

Table 10.32—Exporting Customer Records—Field Definitions 

Field Number Definition
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2. Click Import/Export > Export Customer Meters on the module navigator (if 
the module is not expanded, click Classic Accounts Receivable first) or select 
Classic Accounts Receivable > Import/Export > Export Customer Meters 
from the menu bar. The first page of the task displays (Figure 10.5). 

Figure 10.5—Export Customer Meters, Page 1 of 2 

3. Complete the required fields according to the following table Table 10.33.

Table 10.33—Exporting Customer Meters—Field Definitions—Page 1 of 2

Field Definition

Meter numbers Enter the range of customer meters to be exported. 

Meter types Enter the range of meter types to include in the export.
• Default is All.

Meter routes Enter the range of meter routes to include in the export.
• Default is All.

Meter range

• Usage Enter a range of usage to include in the export.
• Default is All.

• Current only Include all or part of the information in the export:
• Y—Report current only.
• N—Report all.
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4. Press ENTER or PAGE DOWN to move to the second page of the task. These fields 
on this page allow you to define data items to filter the information in the export 
file.

5. Enter data items, as necessary.

6. When you have finished your selection, type 0 to exit and all meters that meet 
the selection criteria will be exported.

EXPORTING CUSTOMER METERS—EXPORT FILE NAME

The system will save your customer meters export file to the FundWare > Data folder 
with the following name: 

The Export Customer Meters and the Import Meter Maintenance task use the 
same file naming convention. You may overwrite an existing import file by 
export customer meters.

For example, you are ready to import the file, so you log onto your computer and check 
the TTY number, which is 864. Therefore, the line number is 0864 and the import name 
must be:

• AR0864.M

Dates Enter the ranges of dates to include in the export.
• Default is All.

Incl inactive Include or exclude inactive information:
• Y—Include inactive.
• N—Do not include inactive.

Incl demand Include or exclude demand meters:
• Y—Include demand meters.
• N—Do not include demand meters.

Sort items Enter data items on which the export file will sort.

AR + Line number
(Line number is 0 + your TTY number)

+ .M

Table 10.33—Exporting Customer Meters—Field Definitions—Page 1 of 2 (Continued)

Field Definition
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For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

EXPORTING CUSTOMER METERS—FIELD DEFINITIONS

Each meter reading produces two or more lines of text in the output file. Type “A” and 
“B” records will always be created and a type “C” record is created for each meter 
reading present in the meter file. In each line, both character information and numeric 
information is printed. Character fields are always surrounded by quotes, numeric fields 
are always printed without commas and contain a leading “-” if the field is negative. 
Fields are separated by one or more spaces.

METER HEADER RECORD

One meter header record exists for each meter exported. Table 10.34 describes the fields 
in this record. 

Table 10.34—Meter Header Record Fields Descriptions

Field # Description

1 Record type (always contains an “A”)

2 Customer number

3 Customer billing name

4 Meter number

5 Route number

6 Route sequence number

7 Meter multiplier

8 The number of digits (to the left of the decimal point) in the meter.

9 Meter type
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METER LOCATION

One meter location record exists following the meter header record, for each meter 
exported. Table 10.35 describes the fields in this record. 

METER READINGS

One meter reading record exists following the “A” and “B” records for the meter for 
each of the 13 non-zero meter readings present in the meter file. Table 10.36 describes 
the fields in this record. 

Table 10.35—Meter Location Fields Descriptions

Field # Description

1 Record type (always contains a “B”)

2 Service address

3 Service note 1

4 Service note 2

Table 10.36—Meter Readings Fields Descriptions

Field # Description

1 Record type (always contains a “C”)

2 Meter reading date (MM/DD/YYYY)

3 Meter reading (99999999999.999999)
Exporting Customer Meters 
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EXPORTING CUSTOMER METERS—EXPORT FILE EXAMPLE

The following is an example of an export file.
"A" 200 "Steve A. Johnson " "W200 " "1 " "12 " 1.000000 5 "Water" 
"B" " 830 Fox Run " "Meter behind house " "Large friendly dog " 
"C" "05/15/2004"         63025.000000 
"C" "04/15/2004"         57618.000000 
"C" "03/16/2004"         53200.000000 
"C" "02/15/2004"         51980.000000 
"C" "01/15/2004"         48125.000000 
"C" "12/15/2004"         44057.000000 
"A" 300 "Joseph E. Smith " "W300 " "1   " "8 "     1.000000 5 "Water" 
"B" " 819 E Pine Street " "Meter inside downstairs " "Behind stairs " 
"C" "05/15/2004"         92350.000000 
"C" "04/15/2004"         89100.000000 
"C" "03/16/2004"         86252.000000 
"C" "02/15/2004"         83000.000000 
"C" "01/15/2004"         80210.000000 
"C" "12/15/2004"         78100.000000 
"A" 400 "ABC Hardware " "W400 " "2 " "14 "      1.000000 6 "Water" 
"B" " 4328 W Second Avenue " "Meter behind shed " "south of building " 
"C" "05/15/2004"         49730.000000 
"C" "04/15/2004"         32400.000000 
"C" "03/16/2004"         22360.000000 
"C" "02/15/2004"          8150.000000 
"C" "01/15/2004"          6204.000000 
"C" "12/15/2004"          4000.000000
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IMPORTING CR INFORMATION
(7.40 CUSTOMERS)

BEFORE YOU IMPORT YOUR CUSTOMER DATA
During the customer data import process, the Import Manager will ensure that your data 
fields meet the specific import requirements (see Business Rules for Customer Imports 
on page 289 for specifics). Therefore, you must complete the general setup of your Cash 
Receipts system before you begin importing your data. Please see the Blackbaud 
FundWare Cash Receipts Guide for more information.
In addition, you should:

• Have security access (e.g., ability to rename files) to the directory in which the 
data file is stored,

• Have security rights to import (see the security setting for the Cash Receipts 
module),

• Backup your FundWare system, 
• Create a copy of the database to which you are importing data, and
• Ensure that no one is working in the Cash Receipts module. 

If Cash Receipts is open during the import and the Customers folder is open, 
the module will not recognize the imported data. You must access another folder 
in Cash Receipts, then select the Customers folder again.

DATA REQUIREMENTS FOR CUSTOMER IMPORTS
Table 11.1 lists the fields, data type, and maximum length for the fields used in the 
Customer import. 
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There are certain fields that require predefined entries (e.g., Individual Prefix 
only allows Mr., Mrs., Dr., Ms., Miss, or <None>). These fields are identified 
with an asterisk in the Maximum Length column. For more information on what 
is allowed in the predefined fields, see the Blackbaud FundWare Cash Receipts 
Guide for more information.

The order of the fields in the table is the order that the Import Manager expects the 
information. If your data is not in this order, or does not match the type and length 
requirements, you must adjust the data or the import manager will return errors on your 
data. 

Data that is less than the data size allowed for a field will not cause an error. 
However, if the data in a field is longer than the specified maximum, the Import 
Manager will return errors. 

Also:
• Any blank lines in your data will generate errors during import.
• Any quotations in your data (e.g., Toys “R” Us) will be removed during import 

(e.g., Toys R Us).
When you have formatted the data as necessary, you must save the file in a .txt (text) or 
.csv (comma-separated values) format.

Table 11.1—Customer Import Data Requirements

Import Field Name Maximum Length

Customer Code 25

Organization Name 50

Organization Type *

Individual Prefix *

Individual First Name 25

Individual Middle Name 25

Individual Last Name 25

Individual Suffix 50

Individual Email Address 50

Customer Status *

Address1 Street 1 50
Data Requirements for Customer Imports 
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Address1 Street 2 50

Address1 Street 3 50

Address1 City 50

Address1 State 50

Address1 Postal Code 50

Address1 Country 50

Address1 Address Type *

Address1 Address Description 50

Address2 Street 1 50

Address2 Street 2 50

Address2 Street 3 50

Address2 City 50

Address2 State 50

Address2 Postal Code 50

Address2 Country 50

Address2 Address Type *

Address2 Address Description 50

Address3 Street 1 50

Address3 Street 2 50

Address3 Street 3 50

Address3 City 50

Address3 State 50

Address3 Postal Code 50

Address3 Country 50

Address3 Address Type *

Table 11.1—Customer Import Data Requirements 

Import Field Name Maximum Length
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Address 1 will be defined as the “Bill To” address. If this is inaccurate, you re-
order your addresses or change the Bill To setting after completing the import.

Address3 Address Description 50

Phone1 Phone Number 50

Phone1 Phone Type *

Phone1 Phone Description 50

Phone2 Phone Number 50

Phone2 Phone Type *

Phone2 Phone Description 50

Phone3 Phone Number 50

Phone3 Phone Type *

Phone3 Phone Description 50

Table 11.1—Customer Import Data Requirements 

Import Field Name Maximum Length
Data Requirements for Customer Imports 
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BUSINESS RULES FOR CUSTOMER IMPORTS
Table 11.2 provides the business rules that the Import Manager will apply to your data. 

Table 11.2—Business Rules

Import Field Name Business Rule

Customer Code If you chose the Manual Customer Numbers option in General Setup, 
the customer code must be:
• Unique,
• Any character or numeric value, and
• Have a maximum length of 25.

If you chose the Automatic Customer Numbers option in General 
Setup, the Import Manager will:
• Ignore any customer codes in the import file, and
• Generate a new customer code and insert it in database. (The 

Import Manager will refer to the last customer code applied to 
determine next number.)

Organization Name and 
Individual Name (First and 
Last)

If the Organization Name is blank and First Name and Last Name are 
supplied, the Import Manager will treat the customer as an Individual 
Customer.
• CR allows for two types of customers: Individual and Organization. 

Once assigned as an Individual Customer, you cannot change a 
record type to an Organization Customer.

If the First Name and Last Name are blank and the Organization 
Name is supplied, the Import Manager will treat the customer as an 
Organization Customer.
• CR allows for two types of customers: Individual and Organization. 

Once assigned as an Individual Organization Customer, you cannot 
change a record type to an Individual Customer.

Individual Prefix If this field is null or blank, the Import Manager will set the appropriate 
database entry to <None>.

Address Type (1,2,3) If this field is null or blank, the Import Manager will set the appropriate 
database entry to <None>.

The first (or only) address will be designated the default.

Phone Type (1,2,3) If this field is null or blank, the Import Manager will set the appropriate 
database entry to <None>.

The first (or only) phone number will be designated the default.
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IMPORTING YOUR CUSTOMER DATA
Once your customer data has been modified, as necessary, to match the needs of the 
Import Manager, use the following steps to import the data into Cash Receipts. 

Review the steps in Before You Import Your Customer Data on page 285 to 
make sure that you are ready to import the data.

1.  Select Tools > Import from the menu bar. 

2. If asked, select the division into which you are importing data.

3. Click OK. The Import window displays (Figure 11.1). 

Figure 11.1—Import window

4. Select Customers (the default) from the Import drop-down list. (At this time, 
Customers data is the only data that you can import into Cash Receipts. 
Therefore, this is your only option from the drop-down list.)

5. Select the delimiter (or format) of your data file:

• Tab-delimited, or
• Comma-delimited.

6. Enter the first row number containing data. The default entry is 1. However, if 
your data has any heading rows, enter the first line of actual data.
Importing Your Customer Data 
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7. Enter the directory path and name of the data file (Figure 11.2). Click the 
ellipsis to browse to the file. 

Figure 11.2—Example Customer Import window

8. Click OK to import your data, or Close to cancel the process. The Import 
Manager will evaluate you data before attempting the import process. If there 
are no errors, a confirmation message displays (Figure 11.3). 

Figure 11.3—Import Confirmation Message

If there are errors, the Manager will create an error file and will not 
proceed with the import. For more information, see Correcting Errors 
in Your Customer Data on page 293. 

9. Click OK. The import proceeds, displaying a message with the process is 
complete (Figure 11.4). 

Figure 11.4—Import Complete Message

10. Click OK.

11. Close the Import Manager by clicking Close or the close button ( ).
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You can now use the imported customers in Cash Receipts.
The Import Manager will rename your data file to reflect the date and time that 
the import was completed. For example, the data file in Figure 11.5 was 
imported December 14, 2001 at 12:55 and 07 seconds. 

Figure 11.5—Example of a Renamed Data File

If there are any locks on your data file, or if the file is open, the file will not be 
renamed.

TIPS FOR IMPORTING YOUR CUSTOMER DATA
The import process has many elements, and it could be very easy for you to make a 
mistake. However, here are a few things to keep in mind to avoid some of the more 
common mistakes:

• If you select the wrong Import type, you will have a large error file because the 
Import Manager will not interpret your data correctly.

• If you enter an incorrect First Row Number, you could get error messages.
— For example, if the data in your import file begins on row 2, but you enter 1 

as the First Row Number, you will get a number of error messages 
regarding row 1.

— On the other hand, the data in your import file begins on row 2, but you 
enter 3 as the First Row Number, you will lose your first row of data and 
you may or may not receive errors (due to the dependencies of other rows).

• If you select the wrong delimiter, you will have a large error file because the 
Import Manager has no way of interpreting your data correctly.
Tips for Importing Your Customer Data 



Chapter 11—Importing CR Information (7.40 Customers)
• If you create your data file in Excel, be careful that the program does not 
include more instances of delimiters on a line that you intend or extra lines with 
delimiters but no other data. 
— If you are using comma delimiters and view the file in Notepad, you should 

be able to identify any “extra” information.
• You should add quotation marks at the beginning and end of any text fields that 

include your delimiter (e.g., using a comma in a comma-delimited file). (Excel 
may do this automatically.) For example, if you are using the comma-delimited 
format and a customer’s name is:
— Mittens for Kittens, Inc.
— The field should look like this: “Mittens for Kittens, Inc.”

CORRECTING ERRORS IN YOUR CUSTOMER DATA
Before beginning the import process, the Import Manager will read your customer data. 
If there are problems, it will return an error message (Figure 11.6) and the import 
process will not proceed. No records will be imported until the errors are cleared. 

Figure 11.6—Example Error Message

Use the following steps to correct your data.
1.  Write down the name and location of the error file.

2. Click OK.
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3. Open the error file (Figure 11.7). (If you did not note the name of this file, it 
will be saved in the same directory as your data file and will have an extension 
of .csv.) 

Figure 11.7—Example Error File

4. Print the file for reference while you correct the data.

5. Use the error messages to determine the row and type of error. The errors were 
triggered when the Import Manager compared your data to the customer data 
requirements and business rules. Therefore, refer to the requirements and 
business rules to determine the source of the error.

An easy mistake to make would be to select the wrong delimiter. For 
example, if you have comma-delimited text and select the tab delimiter, 
you would have a large error file because the Import Manager would 
have no way of interpreting your data correctly.

6. When you have finished correcting your data file, you can again attempt the 
import process. 

You must close the error file before trying to import the file again. The 
Import Manager will delete the error file and, if necessary, create a new 
error file.

 

Correcting Errors in Your Customer Data 
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IMPORTING CR INFORMATION
(5.8/5.9 CUSTOMERS)

FundWare allows you to import two types of information to your Cash Receipts system:
• Customer records, and
• Text files containing receipt type file maintenance to be posted to the receipt 

type master file from an external source.

IMPORTING CUSTOMER RECORDS
FundWare allows you to import both information for new receipt customers and changes 
to current receipt customers’ records to your Cash Receipts system using a three-step 
process:

1.  Create one or more text file formats via an Execute Programs task. This doesn’t 
import the text file itself. 

The text files cannot contain special characters, such as tabs and form-
feeds. Each line of text must end with the line terminator for the 
operating system. In MS-DOS, the line terminator is a carriage return/
new line sequence.

2. Create the text files to be imported using any text editor, database, or word 
processor. 

3. Execute the import program to bring the data from the text file into the Payroll/
Personnel module via another Execute Programs task.

IMPORTING CUSTOMER RECORDS—REQUIREMENTS AND CAUTIONS

The task first checks the import text file for errors. The requirements are:
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• One (and only one) keyword record must be present as the first non-blank 
record in the file.

• Blank fields must still be indicated by separator characters if you are using the 
delimited file format.

• If you wish to change any of the information in a customer record, any 
information that is imported will be changed.

IMPORTING CUSTOMER RECORDS—THE IMPORT FORMAT

You have the option of two different types of file formats for your import text file:
• Delimited file formats—One in which the length of each field in the file is not 

pre-defined. For example, the following fields are both acceptable because the 
field delimiter (in this case the pipe [|]) defines where each field begins and 
ends:
— 101|3|Paul J. Johnson|3034571400
— 1200|3|Jenny Garner|3037582000

• Fixed-file formats—Does not use delimiters, rather the line, column, and length 
positions determine where the fields begin and end. Using the previous 
example, the format may be defined as shown in Table 12.1. 

A fixed-format text file The text file would be:

— 00000001013Paul J. Johnson3034571400
00000012003Jenny Garner3037582000

Create your text files for importing data using any text editor, database or word 
processor, or any other software application. The text files cannot contain special 
characters, such as tabs and form-feeds. Each line of text must be terminated with the 
line terminator for the operating system. In MS-DOS the line terminator is a carriage 
return/new line sequence.

Table 12.1—Fixed-File Format

Field Column Length

Customer number 1 10

Customer name 11 30

Telephone number 47 12
Importing Customer Records 
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IMPORTING CUSTOMER RECORDS—CREATING THE IMPORT FORMAT

You can create your import format from the Execute Programs task.
1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 12.1). 

Figure 12.1—System Utilities—Executing a Program

4. In the Execute Program area, enter the required information according to Table 
12.2. 

Table 12.2—Importing Customer Records—Creating the Format

Field Entry

Program Name CUSCR08

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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You can also go to your DOS prompt, type AFWRUN, and enter the 
program name to run the program from outside FundWare. 

5. Click Run. The system asks you to enter the import format name. 

6. Enter up to 10 alphanumeric characters. No embedded spaces are allowed. We 
recommend that you enter a name that is meaningful to your organization. The 
system asks if you are copying this format from an existing import format.

7. Leave the Copy import field blank if you are not copying this format from an 
existing import format, or press F1 to select from a list of currently defined 
import formats. The first page of the task displays (Figure 12.1). 

Figure 12.1—Define Customer Import—Page 1 of 2

8. Complete the required fields according to Table 12.3. 

Table 12.3—Importing Customer Records—Format Field Definitions—Page 1 of 2

Field Valid Entry Definition

Description 30 characters Description of the import.

Import type 1
2

• 1—Delimited import file.
• 2—Fixed format import file.

• Delimited by 1 character If the import type option is set to delimited, enter the 
character used as a separator between imported fields.

Record count 1 to 99 The number of records required for one master record to 
be imported.
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9. When complete, press ENTER. The second page of the task displays. 

10. For the remainder of the task, you will define the data items included in your 
import file, as well as their specific location within the import file. Use the 
instructions in Table 12.4 to complete these fields. 

Table 12.4—Importing Customer Records—Format Field Definitions—Page 2 of 2

Field Valid Entry Definition

Data item Employee data 
item

The existing employee data item to be imported. Press F1 in 
this field to display a list of currently defined employee data 
items.

• Entry from C
R

For multiple value data items, enter the entry value.
• C—Value is a constant.
• R—Value is from an imported record.
These options and their associated fields are explained 
further below.

• Value from C
R

For single occurring data items, enter the value.
• These from fields have the same options for the selected 

employee data item. Any combination of options is valid.
• C—Value is a constant.
• R—Value is from an imported record.
These options and their associated fields are explained 
further below.

Data Item field options—Any of the following fields may display, depending on the option you enter for 
the data item fields above.

• Constant varies with the 
data item definition

If the selection is “Constant,” enter the constant value. Valid 
entries for this field vary depending on the data item 
definition.

• Record 1 to 99 If the selection is “Record,” indicate which record (from the 
group of records that make up each master record), contains 
the field to be imported.

• Position 1 to 99 If the selection is “Record” and Import type is set to 
Delimited, enter the position within the record that contains 
the field to be imported.

• Column 1 to 250 If the selection is “Record” and Import type is set to Fixed 
format, enter the column within the fixed record that contains 
the field to be imported.
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IMPORTING CUSTOMER RECORDS—IMPORT FILE FORMAT

Create your text files for importing data using any text editor, database word processor, 
or any other software application. The text files cannot contain special characters, such 
as tabs and form-feeds. The content of the import file is determined by the type of data 
you are importing and the format you have chosen. At a minimum, the file must contain 
the receipt customer number (data item .REC CUST) to import. In addition, the 
following rules apply:

• All dates have the format mmddyyyy.
• All dates must be valid and the posting date cannot be in a closed period.
• All dollar amounts must use numbers and no $ characters. Their maximum size 

is 999,999,999 (999 million).
• All files must begin with a keyword record.

KEYWORD RECORD

The first line of the import text file identifies the division and may also identify the 
separator character. If no separator character is defined here, the | (pipe sign) is used as 
the default. The format is: 

• Length 1 to 55 If the selection is “Record” and Import type is set to Fixed 
format, enter the length of the field being imported.

DIV = nn SEP = x IMPORT = name FILE = name POST = mmddyyyy FUNC = 1/m DDEC=Y/N

where

• nn is the division number

• x is the separation character

• name is the import file definition name. The default is IMPORT.

• name is the import file name. For more information, see Importing Customer Records—Import File 
Name on page 302. 

• mmddyyyy is the posting date. The default is today’s date.

Table 12.4—Importing Customer Records—Format Field Definitions—Page 2 of 2 (Continued)

Field Valid Entry Definition
Importing Customer Records 



Chapter 12—Importing CR Information (5.8/5.9 Customers)
IMPORTING CUSTOMER RECORDS—IMPORT FILE EXAMPLE

The following delimited file format example contains one keyword record and one 
receipt customer to be imported. (When you are making a change, you only need to 
include the customer number and the information being changed.) The format 
(MASTER) has been defined to recognize the pipe as the separator. (Because this 
employee equals one import record, the information should be on one line in the text 
file. This example has line breaks due to the width of the page.)

DIV=95 IMPORT=MASTER POST=01312004 FUNC=I DDEC=N
501|Andrew Smith|Johnson and Company|P.O. Box 778000|101 South 
Street|Denver|CO|80110|3034777710|3034777100|84-9988775

Table 12.5 takes each entry in the import example and defines the associated fields. 

• I/M is the type of posting. This is only used for employee master records. Must be Initial (“I”) or Modify 
(“M”). The default is “I” for initial

• Y/M is the default use of decimal points. A “Y” value causes decimal points to be placed in numeric 
fields when no decimal point is found. For example, for an amount field, “45” becomes .45 and for a 
rate field it becomes .000045. An “N” value assumes no decimal positioning. For example, for an 
amount field, “45” becomes $45.00 and for a rate field 45.000000. If a decimal point is found in a field, 
the Y or N value in DDEC is disregarded, and the decimal point is used just as it exists in the import 
file.

Table 12.5—Importing Customer Records—Delimited File Example Entries and Fields

Entry Field Name Import Field

DIV=95 IMPORT=MASTER POST=01312004 
FUNC=I DDEC=N

Keyword record

501|Andrew Smith Receipt customer number|Receipt 
customer name

1|2

Johnson and Company Organization name 3

P.O. Box 778000 Street 1 4

101 South Street Street 2 5

Denver|CO|80110 City|STP|Postal code 6|7|8

3034777710|3034777100 Phone number|FAX number 9|10

84-9988775 Tax id # (data item) 11
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IMPORTING CUSTOMER RECORDS—IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

Because many Cash Receipts import types use the same file name, you can only 
have one import file in your system at any one time.

For example, you are ready to import the file, so you log onto your computer and check 
the TTY number, which is 864. Therefore, the line number is 0864 and the import name 
must be:

• CR0864.Y
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

IMPORTING CUSTOMER RECORDS—IMPORTING THE FILE

Use the following instructions to import the customer records file.
1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

CR + Line number
(Line number is 0 + your TTY number)

+ .Y
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3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 12.2). 

Figure 12.2—System Utilities—Executing a Program

4. In the Execute Program area, enter the required information according to Table 
12.6. 

5. Click Run. When complete, you return to the Execute Program screen.

You can also go to your DOS prompt, type AFWRUN, and enter the 
program name to run the program from outside FundWare. 

Table 12.6—Importing Customer Records—Importing the File

Field Entry

Program Name CUSCR20

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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IMPORTING CUSTOMER RECORDS—IMPORT FILE ERRORS

Once you have imported your file, the system produces and saves an error report to the 
FundWare > Data folder: 

For example, you are ready to import the file to Division 95, so you log onto your 
computer and check the TTY number, which is 864. Therefore, the line number is 0864 
and the error file for a Division 95 import is:

• CRX0864.L95
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.
If there are errors, review the error report to determine their causes. Then edit or create a 
new import file to add or correct those customers in error and run the program again. 

IMPORTING CUSTOMER RECORDS—ERROR MESSAGES

The following messages may appear on the screen as you execute the program.
• Errors have occurred in extract!—One or more errors have been found in input 

text file and the task is terminated.
• Errors have occurred—Format errors have been found in the
• in initialization!—initialization program and the task is terminated.
• Errors have occurred in edit!—Errors have been found while editing the 

extracted text file and the task is terminated.
• No transactions to post!—No valid transactions were found to post and the task 

is terminated.
The following messages refer to errors found in the text file and are shown on the error 
report. Those errors described as “Warning” are only considered a warning if the batch 
is to be saved. Otherwise, the errors are fatal. Correct the errors in the text file and 
import the file again.

• CRSS Parameter not in system—The CRSS parameter has not been defined.
• CRSA Parameter not in system—The CRSA parameter has not been defined.
• Division must be 01-99.—The division number supplied after the DIV= 

keyword must be in the range of 01 to 99.

CRX + Line number
(Line number is 0 + your TTY number)

+ .L##
(## represents your division number)
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• Division not in system.—The division number supplied after the DIV= keyword 
has not been defined.

• File XXX has no data.—The specified import file is empty.
• File XXX not in system.—The specified import file could not be found.
• Function X must be “I” or “M”.—The function indicator (initial or modify) was 

incorrect.
• Import XXX not in system.—The specified import definition could not be 

found.
• Invalid posting date.—An invalid posting date was indicated.
• No data items to import.—The specified import definition did not contain any 

data items.
• No keywords supplied.—The keyword record was missing.
• No .REC CUST to import.—At a minimum, the receipt customer data item 

must be defined.
• Too many items.—An import definition may contain at most 100 data items.

IMPORTING CR TYPES
Use this task to create a text file containing receipt type file maintenance to be posted to 
the receipt type master file from an external source. 

IMPORTING CR TYPES—REQUIREMENTS AND CAUTIONS

The task checks the import text file for errors. The import file must have the correct 
name and format.

IMPORTING CR TYPES—IMPORT FILE NAME

Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

CR + Line number
(Line number is 0 + your TTY number)

+ .T
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For example, you are ready to import the file, so you log onto your computer and check 
the TTY number, which is 864. Therefore, the line number is 0864 and the import name 
must be:

• CR0864.T
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

IMPORTING CR TYPES—IMPORTING THE FILE

Use the following instructions to import the CR types file.
1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 12.1). 

Figure 12.1—System Utilities—Executing a Program
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4. In the Execute Program area, enter the required information according to Table 
12.7. 

5. Click Run. When complete, you return to the Execute Program screen.

You can also go to your DOS prompt, type AFWRUN, and enter the 
program name to run the program from outside FundWare. 

IMPORTING CR TYPES—IMPORT FILE ERRORS

Once you have imported your file, the system produces and saves an error report to the 
FundWare > Data folder: 

Because the Cash Receipts customer import task uses that same file name, you 
may overwrite any existing error report.

For example, you are ready to import the file to Division 95, so you log onto your 
computer and check the TTY number, which is 864. Therefore, the line number is 0864 
and the error file for a Division 95 import is:

• CRX0864.L95
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.
If there are errors, review the error report to determine their causes. Then, either use the 
Create Receipt task or create a new import file to add or correct those types in error and 
run the program again. 

Table 12.7—Importing CR Types—Importing the File

Field Entry

Program Name CUSCR28

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.

CRX + Line number
(Line number is 0 + your TTY number)

+ .L##
(## represents your division number)
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IMPORTING CR TYPES—ERROR MESSAGES

The following messages may appear on the screen as you execute the program.
• Errors have occurred in extract!—One or more errors have been found in input 

text file. Errors are listed in the print file and if an error is found for a customer, 
no changes are made for that customer.

• CRnnnn.T file not in system—The input file listed does not exist in the data 
directory. The nnnn will be the line number of the terminal executing the task.

The following messages refer to errors found in the text file and are shown on the error 
report. Those errors described as “Warning” are only considered a warning if the batch 
is to be saved. Otherwise, the errors are fatal. Correct the errors in the text file and 
import the file again.

• CRSS Parameter not in system—The CRSS parameter has not been defined for 
the division specified in the keyword record.

• No parameters supplied—No valid keywords could be found in the first non-
blank record in the input file.

• Division must be 01-99—The division number supplied after the DIV= 
keyword must be in the range of 01 to 99.

• Division not in system—The division number supplied after the DIV= keyword 
has not been defined.

• Keyword not recognized—A keyword was found in the first non-blank record 
but it was not DIV= or SEP=.

• Record type not numeric—The first 2 characters of a record were not numeric. 
This could be caused by previous records not having enough or having too 
many separator characters.

• Invalid record type—The only valid record types are 00-05. This could also be 
caused by previous records not having enough or having too many separator 
characters.

• Duplicate field use—More than 1 record type (other than 00) was found more 
than once after a 00 record. For example, 2 records with a 03 record type in 
columns 1 and 2. This could also be caused by previous records not having 
enough or having too many separator characters.

• Receipt type may not be used—A blank receipt type may not be used.
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IMPORTING FIXED ASSETS INFORMATION

FundWare allows you to import asset information to your Fixed Assets system using a 
three-step process:

1.  Create one or more text file formats via an Execute Programs task. This doesn’t 
import the text file itself. 

The text files cannot contain special characters, such as tabs and form-
feeds. Each line of text must end with the line terminator for the 
operating system. In MS-DOS, the line terminator is a carriage return/
new line sequence.

2. Create the text files to be imported using any text editor, database, or word 
processor. 

3. Execute the import program to bring the data from the text file into the Fixed 
Assets module via another Execute Programs task.

THE IMPORT FORMAT
You have the to option of two different types of file formats for your import text file:

• Delimited file formats—One in which the length of each field in the file is not 
pre-defined. For example, the following fields are both acceptable because the 
field delimiter (in this case the pipe [|]) defines where each field begins and 
ends:
— 100|copy machine|10082004|1000.00
— 10101123|Ford Truck #6974329516|01122004|20000.00
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• Fixed-file formats—Does not use delimiters, rather the line, column, and length 
positions determine where the fields begin and end. Using the previous 
example, the format may be defined as shown in Table 13.1. 

A fixed-format text file The text file would be:

— 0000000100copy machine                  10082004   1000.00
0010101123Ford Truck #6974329516 0112204   20000.00

CREATING THE IMPORT FORMAT
You can create your import format from the Execute Programs task.

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

Table 13.1—Fixed-File Format

Field Column Length

Asset number 1 10

Description 11 30

Cost date 41 10

Cost amount 51 12
Creating the Import Format 
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3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 13.1). 

Figure 13.1—System Utilities Window

4. In the Execute Program area, enter the required information according to Table 
13.2. 

5. Click Run. The system asks you to enter the import format name. 

You can also go to your DOS prompt, type AFWRUN, and enter the 
program name to run the program from outside FundWare. 

6. Enter up to 10 alphanumeric characters. No embedded spaces are allowed. We 
recommend that you enter a name that is meaningful to your organization. The 
system asks if you are copying this format from an existing import format.

Table 13.2—Importing Fixed Assets—Creating the Format

Field Entry

Program Name CUSFX08

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
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7. Leave the Copy import field blank if you are not copying this format from an 
existing import format, or press F1 to select from a list of currently defined 
import formats. The first page of the task displays (Figure 13.2). 

Figure 13.2—Define Fixed Assets Import—Page 1 of 2

8. Complete the required fields according to Table 13.3. Figure 13.3 shows an 
example of this setup. 

9. When complete, press ENTER. The second page of the task displays. 

Table 13.3—Importing Fixed Assets—Format Field Definitions—Page 1 of 2

Field Valid Entry Definition

Description 30 characters Description of the import.

Import type 1
2

• 1—Delimited import file.
• 2—Fixed format import file.

• Delimited by 1 character If the import type option is set to delimited, enter the 
character used as a separator between imported fields.

Record count 1 to 99 The number of records (or lines in the import file) required 
for one master record to be imported.
Creating the Import Format 
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10. For the remainder of the task, you will define the data items included in your 
import file, as well as their specific location within the import file. Use the 
instructions in Table 13.4 to complete these fields. 

Table 13.4—Importing Fixed Assets—Format Field Definitions—Page 2 of 2

Field Valid Entry Definition

Data item Asset data item The existing asset data item to be imported. Press F1 in this 
field to display a list of currently defined employee data 
items.

• Entry from C
R

For multiple value data items, enter the entry value.
• C—Value is a constant.
• R—Value is from an imported record.
These options and their associated fields are explained 
further below.

• Value from C
R

For single occurring data items, enter the value.
• These from fields have the same options for the selected 

data item. Any combination of options is valid.
• C—Value is a constant.
• R—Value is from an imported record.
These options and their associated fields are explained 
further below.

Data Item field options—Any of the following fields may display, depending on the option you enter for 
the data item fields above.

• Constant varies with the 
data item definition

If the selection is “Constant,” enter the constant value. Valid 
entries for this field vary depending on the data item 
definition.

• Record 1 to 99 If the selection is “Record,” indicate which record (from the 
group of records that make up each master record), contains 
the field to be imported.

• Position 1 to 99 If the selection is “Record” and Import type is set to 
Delimited, enter the position within the record that contains 
the field to be imported.

• Column 1 to 250 If the selection is “Record” and Import type is set to Fixed 
format, enter the column within the fixed record that contains 
the field to be imported.

• Length 1 to 55 If the selection is “Record” and Import type is set to Fixed 
format, enter the length of the field being imported.
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See Figure 13.3 for an example. 

Figure 13.3—Example Fixed Assets Format Definition

IMPORT FILE FORMAT
Create your text files for importing data using any text editor, database word processor, 
or any other software application. The text files cannot contain special characters, such 
as tabs and form-feeds. The content of the import file is determined by the type of data 
(asset records) and the selected format. At a minimum, the file must contain the asset 
number (data item .ASSET NBR) to import. In addition, the following rules apply:

• All dates have the format mmddyyyy.
• All dates must be valid and the posting date cannot be in a closed period.
• All dollar amounts must use numbers and no $ characters. Their maximum size 

is 999,999,999 (999 million).
• All files must begin with a keyword record.
Import File Format 
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KEYWORD RECORD

The first line of the import text file identifies the division and may also identify the 
separator character. If no separator character is defined here, the | (pipe sign) is used as 
the default. The format is: 

IMPORT FIELD DEFINITIONS
Table 13.5 defines the fields possible in a Fixed Assets import. 

DIV = nn SEP = x IMPORT = name POST = mmddyyyy FUNC = A/M

where

• nn is the division number

• x is the separation character

• name is the import file definition name. The default is IMPORT.

• mmddyyyy is the posting date. The default is today’s date.

• A or M is the type of posting. Must be Acquire (“A”) or Modify (“M”). The default is “A” for acquire.

Table 13.5—Importing Fixed Assets—Field Definitions

Field Description Maximum Field Size

Asset number 9 digits

Description 30 characters

Purchased from 30 characters

MFG serial number 30 characters

Responsible 30 characters

Group 4 digits

Location 4 digits

Reporting type 2 digits

Cost date 8 digits

Cost amount 15 digits with two decimal places
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IMPORT FILE EXAMPLE
This example contains one keyword and one asset to be acquired. The import file name 
is “IMPORT” and is defined to input the following information:

DIV=95 IMPORT=IMPORT POST=01312004
1001|Oak desk|200|100|30|01302004|1000.00|3|5|Y

Table 13.6 defines each entry in the example. 

Method 1 digit

Life 3 digits

Type 1 character

Salvage value 15 digits with two decimal places

Depr date 8 digits

Depr amount 15 digits with two decimal places

Table 13.6—Importing Fixed Assets—Import File Example

Entry Field

DIV=95 IMPORT=IMPORT POST=01312004 Keyword record

1001 Asset #

Oak desk Description

200|100 Group|Location

30|01302004 Cost date: entry #|value for

1000.00 Cost value

3|5|Y Depreciation method|life|life type

Table 13.5—Importing Fixed Assets—Field Definitions (Continued)

Field Description Maximum Field Size
Import File Example 
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IMPORT FILE NAME
Once you have created your import file, copy the file to the FundWare > Data folder. 
The file must have the following name: 

For example, you are ready to import the file, so you log onto your computer and check 
the TTY number, which is 864. Therefore, the line number is 0864 and the import name 
must be:

• FX0864.Y
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.

IMPORTING THE FILE
Use the following instructions to import the customer records file.

1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

FX + Line number
(Line number is 0 + your TTY number)

+ .Y
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3. Click System Utilities on the module navigator or select System 
Administration > System Utilities from the menu bar. The System Utilities 
window displays (Figure 13.4). 

Figure 13.4—System Utilities—Executing a Program

4. In the Execute Program area, enter the required information according to Table 
13.7. 

5. Click Run. When complete, you return to the Execute Program screen.

You can also go to your DOS prompt, type AFWRUN, and enter the 
program name to run the program from outside FundWare. 

Table 13.7—Importing Fixed Assets—Importing the File

Field Entry

Program Name CUSFX20

Switches Leave blank

Parameters Leave blank

Business Date Defaults to the current date. Accept default.

Division Select the applicable division from the drop-down list.
Importing the File 
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ERROR FILE NAME
Once you have imported your file, the system produces and saves an error report to the 
FundWare > Data folder: 

For example, you are ready to import the file to Division 95, so you log onto your 
computer and check the TTY number, which is 864. Therefore, the line number is 0864 
and the error file for a Division 95 import is:

• FXX0864.L95
For more information on TTY numbers (i.e., how to find the number for your terminal) 
see Appendix E—Working With TTY Line Numbers on page 341.
If there are errors, review the error report to determine their causes. Then edit or create a 
new import file to add or correct those assets in error and run the program again. 

ERROR MESSAGES
The following messages may appear on the screen as you execute the program.

• Errors have occurred in edit!—Text file was in the correct format but 
information did not pass the validation criteria. Correct the text file and execute 
task again.

• Errors have occurred in extract!—The text file is formatted incorrectly. Correct 
the text file and execute task again.

• Errors have occurred in initialization!—The text file is formatted incorrectly. 
Correct the text file and execute task again.

• Function Complete!—No errors were found and the entire text file was 
imported.

• No transactions to post!—No valid transactions were found to post.
• Parameter not in system—Fixed Assets module is not yet defined. Set up your 

Fixed Assets module.
The following messages refer to errors found in the text file and are shown on the error 
report. If errors are reported, correct the errors in the text file and import the file again.

FXX + Line number
(Line number is 0 + your TTY number)

+ .L##
(## represents your division number)
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• Asset already in system—Text file contains an asset number already defined in 
your system using the Acquire function (“A”). Correct the asset number or the 
function indicator on the keyword record.

• Asset in use—Text file contains an asset number that is currently in use. Reset 
the in use flag or wait until the asset is no longer in use.

• Asset not in system—Text file contains an asset number not currently defined in 
your system using the Modify function (“M”). Correct the asset number or the 
function indicator on the keyword record.

• Date not numeric—A date field in the text file contains alpha characters. 
Correct date fields.

• Division XX must be between 01-99—Division number is not 1 through 99. 
Correct the division number.

• Division XX not in system—Division number is not currently defined. Correct 
the division number or define the new division.

• Field not numeric—An amount field in the text file contains alphabetic 
characters. Correct amount fields.

• File XXX has no data—The specified text file for this task is empty. Modify the 
text file or use a different text file.

• File XXX not in system—The text file for this task was not found. Make sure 
the file has the correct name and is in the FundWare Data directory. Correct and 
import the file again.

• Function X must be “A” or “M”—The function indicator (acquire or modify) 
was incorrect. Correct the function indicator on the keyword record.

• Import XXX not in system—The import definition could not be found. Correct 
and import the file again.

• Invalid date for XXXX—The date for data item XXXX is not a valid calendar 
date. Correct the date for data item XXXX.

• Invalid posting date 99/99/9999—The posting date is not a valid calendar date 
existing in a valid date table. Correct the posting date on the keyword record or 
define a new date table.

• Invalid reporting type for data item—The text file contains an invalid reporting 
type for the specified data item. Correct the reporting type or define a new 
reporting type.

• Keyword not recognized—Keyword record is incorrect. Correct the text file and 
execute the task again.

• Missing required field—A required field is missing. Add required records and 
fields to the text file.
Error Messages 
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• No .ASSET NBR to import—The specified import definition did not contain 
the asset number. Modify the import definition and import the file again.

• No data items to import—The specified import definition did not contain any 
data items. Modify the import definition and import the file again.

• No keywords supplied—Keyword record is missing from text file. Add 
keyword record to the text file and execute the task again.

• Too many decimal places for XXXX—The number for data item XXXX 
contains too many decimal places. Modify the number for data item XXXX.

• Too many items—The import definition may contain at most 100 data items. 
Modify the import definition and import the file again.
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A P P E N D I X  A

BACKUP CONSIDERATIONS

Failure to institute proper backup and restore procedures could result in serious damage 
to your accounting database. When you encounter an error message or condition, the 
only way to recover your data may be to restore from backup. Keep the following 
considerations in mind when backing up and restoring FundWare data.
The definition of backup is copying your data, system, or utilities files from your hard 
drive to a separate media for storage away from the computer.
The importance of carefully instituting and maintaining a backup procedure cannot be 
overemphasized. There are many circumstances that can cause loss or corruption of data 
files such as a power failure during posting, a fire, or flood. If regular backups have not 
been performed, restoration of your system may take days instead of minutes. Consider 
the following points to ensure your system can be easily restored. 

• Set a regular backup schedule that makes sense for your organization. If you 
process a lot of data each day, daily backups are a good idea. Organizations with 
less volume may feel comfortable backing up data once a week.

• Before you begin entering data, please test your backup AND restore 
procedures on the Model Division. If you cannot restore to an operable system, 
troubleshoot the problem with your network administrator. If necessary, contact 
FundWare Support or your Certified FundWare Reseller. Test backups and 
restores from your working division at least once a month.

• Have more than one set of backups. Backup media CAN fail or accidentally be 
destroyed. The cost of media is small compared to the cost of labor to re-enter 
days, weeks or even months of data.
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PURGE/SAVE FISCAL YEAR
FundWare allows you to keep as many fiscal years on-line as your organization 
requires. The Purge/Save Fiscal Year function provides a feature that will let you 
remove and save data from the on-line system. It is critical that a permanent backup 
procedure is established and performed prior to purging/saving the General Ledger–
Project/Grant modules.

Purge removes all information in the General Ledger–Project/Grant modules for the 
year specified. This includes detail journal entries, as well as the summary balances.
Save removes only the detail of the journal entries while retaining summary balances. 
This option allows you to produce historical comparison reports showing multiple years. 
Once a year is saved, it cannot be re-opened for data entry.
Purge/Save Fiscal Year 
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SPECIAL KEYS IN THE CLASSIC EDITION

DATA ENTRY KEYS
The Classic Edition enables certain keys on your PC keyboard to perform in special 
ways. Below is a brief explanation of the keys and how they work.
CAPS LOCK—CAPS LOCK switches the alpha keys into the capital mode. The number 
keys are not affected.
NUM LOCK—NUM LOCK switches the numeric keys located on the right side of your PC 
keyboard so that they print only the numbers. On some keyboards, the cursor control 
keys (the arrow keys) are only active when NUM LOCK is off. Other keyboards have a 
separate set of cursor control keys.
TAB—TAB has arrows and is on the upper left side of your keyboard. During data entry 
from inside the FundWare system, this key functions like the ENTER. That is, it accepts 
the data keyed or retains the data displayed.
TAB+SHIFT—Use TAB+SHIFT during data entry only in a field that contains subfields. 
For example, a date contains three subfields; day, month, year. Press TAB+SHIFT to 
move the cursor back a position in the subfield.
END—By itself, END moves to the end of the entered data in a field. END can also be used 
to delete data to the end of field. To do this, hold CTRL down and press END. NUM LOCK 
must be off. CTRL+END erases the contents of both numerical and character fields, from 
the cursor position to the end of the field
BACKSPACE—BACKSPACE is on the upper right side of your keyboard. On some 
keyboards it says DEL or BKSPC. It may only have a left arrow on it. It deletes the 
character to the left of the cursor, usually replacing the character with a zero or a blank. 
ENTER/RETURN—ENTER (or RETURN) on most PC keyboards has a left arrow and is on 
the middle right of the keyboard. This key tells the computer to accept information you 
just keyed in. Other notations for ENTER are NL and CR.
INSERT—INSERT places characters in Alphameric fields only. Characters to the right of 
the cursor are moved over. On some keyboards this key is represented by INS.
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DELETE—DELETE (or DEL) removes the character at the cursor position. In an 
Alphameric field, the characters to the right are shifted to the left. In a numeric field, the 
digits to the right do not shift.
Alternate keys for Y(es) and N(o)—Many tasks require an answer of Y(es) or N(o). You 
can use the alternate keys:

• 1 = Y
• 0 = N

FUNCTION KEYS
On the left side of some PC keyboards and across the top of most PC keyboards are 
rows of function keys labeled F1 through F10. Function keys are used by the Classic 
Edition system for various tasks and generally have the purposes described below. 
However, some tasks may use a given function key differently and not all function keys 
are active for all tasks. Always check the second line of the screen for a list of the 
function keys active for your current task. These keys are used throughout the programs 
and tasks: F1, F2, and F4. Certain tasks use other function keys to perform certain 
functions. For example, F5 and F6 are used to duplicate fields. 
F1 Help Key—Press F1 to display help screens and information about the field where the 
cursor is positioned. If the field contains defined records, pressing F1 displays a list of 
valid items. If the field contains non-defined records, a brief note displays explaining 
what type of information should be entered.
F2 Skip Key—This key is used during data entry and can be used in place of ENTER. 
Press F2 for the system to accept the rest of the field as currently displayed. F2 is used 
throughout the systems to skip through multiple subfields instead of using ENTER 
multiple times. It is also used to select the entire range in a field for many tasks and 
reports.
F4 Paint—The repaint function key is used whenever the screen needs to be cleared of 
“garbage.” This can happen because of static discharge. By pressing F4, the screen is 
redrawn.
F5 Dupe—The duplicate (Dupe) function key is used to duplicate fields. The key will 
reproduce the last entry into the current field and immediately accept that entry. F5 is not 
active for all fields. If you need to edit the field, use F6 instead.
Function Keys 
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F6 Recall—The recall function key is used to copy and edit information from one detail 
field to the next. The key will reproduce the last entry into the current field and allow 
you to edit the field before you accept the entry. It is useful for entering new account 
numbers if you use long account number structures.
F7 Suspense Account—Press F7 during data entry to post a line item to a suspense, or 
intermediary account, defined in the journal to which the transaction is being posted.
F8 Program Information—Press F8 to display program information. This information 
may be needed by a Certified FundWare Reseller or someone at American Fundware, 
Inc. in a problem solving situation.

CONTROL KEY SEQUENCES
CTRL+HOME—This key combination deletes the entire field in which the cursor is 
located.
CTRL+END—This key combination deletes characters from the cursor position to the end 
of the field.
CTRL+BREAK—This key combination will abort a program or batch file process. Do not 
use this sequence to exit FundWare. Use this key sequence only when you wish to 
terminate a program or batch file.
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A P P E N D I X  C

FUNDWARE FILE MAINTENANCE

The FundWare file maintenance feature (Figure C.1) is intended to allow you to 
optimize your data files. This feature allows you to:

• Search for files within a directory,
• Backup files within a directory,
• Reorg files to a temporary directory,
• Copy the reorged files from the temporary directory to your data directory, and
• Create sequential files from selected Microfocus files.

Figure C.1—FundWare File Maintenance
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CREATE DIRECTORIES
To help us in our support of you and your use of FundWare, you should create three 
folders before you begin:

• Maintenance folder—Create a Maintenance folder.
• Backup folder—Within the Maintenance folder, create a Backup folder to 

store your backup files. 
• Results folder—Within the Maintenance folder, create a Results folder for 

temporary use during reorg. 

SEARCH
To complete any of the tasks in the File Maintenance feature (e.g., backup, reorg), you 
must identify the applicable files using the search option.

1.  Using Microsoft Explorer, locate the FundWare > 7.## > Bin directory (where 
## represents your version number) and double-click the FILEMAINT.EXE file 
to open. The FundWare File Maintenance feature displays (Figure C.2). 

Figure C.2—FundWare File Maintenance
Create Directories 
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2. Type the Data directory path in the Data directory text box, or click the ellipsis 
to search for the directory. (File Maintenance will enter a default directory 
based on your FundWare system.)

3. Enter an additional filter for the files: division or file name/mask (Figure C.3). 

Figure C.3—Filter Options

• Division—Select the Division radio button (the default) and the applicable 
division from the drop-down list.

• File name/mask—Select the File name/mask radio button and enter the file 
name or file mask (using * as a wildcard character) or click the ellipsis 
button to search for a file.

Division filter File name/mask filter
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4. Click Find. (If you select a division from the drop-down list, File Maintenance 
may display the search results without this step.) All files in the directory that 
meet the filter criteria display in the detail pane below (Figure C.4). 

Figure C.4—Example Search Results

Any files that cannot be addressed by the File Maintenance procedures will be 
highlighted with a pink row color. For example, if you filter on *.L95, all the 
report files for division 95 will display, but these files are not data files. 
Therefore, they are highlighted with pink and you will not be able to complete 
any of the File Maintenance tasks.

BACKUP FILES
Use the following steps to backup selected data files to a Backup directory.
Backup Files 
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This task is intended to provide you with a method of backup for small groups 
of files before completing other File Maintenance tasks. It is not intended to 
replace more secure methods of backing up your data (i.e., external system 
backup, Division Maintenance backup). You should not rely on this feature as 
your only method of preserving your data.

1.  Using Microsoft Explorer, locate the FundWare > 7.## > Bin directory (where 
## represents your version number) and double-click the FILEMAINT.EXE file 
to open. The FundWare File Maintenance feature displays.

2. Type the Data directory path in the Data directory text box, or click the ellipsis 
to search for the directory. (File Maintenance will enter a default directory 
based on your FundWare system.)

3. Specify the Data directory and Filter options. (See Search on page 330 for more 
information.)

4. Click Find. (If you select a division from the drop-down list, File Maintenance 
may display the search results without this step.) All files in the directory that 
meet the filter criteria display in the detail pane below.

5. Type the backup directory path in the Backup directory text box, or click the 
ellipsis to search for the directory.

If the directory does not exist, you will receive an error message. See 
Create Directories on page 330 for more information.

6. Click  on the toolbar or select Maintenance > Backup Files from the menu 
bar. A confirmation message displays. 

7. Click OK. Your files are backed up to the specified directory. 

RESTORE FROM BACKUP
Use the following steps if you need to restore your data files from the Backup directory 
to your Data directory. (You must have completed a backup at least once to be able to 
restore files.)

1.  Using Microsoft Explorer, locate the FundWare > 7.## > Bin directory (where 
## represents your version number) and double-click the FILEMAINT.EXE file 
to open. The FundWare File Maintenance feature displays.
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2. Type the Data directory path in the Data directory text box, or click the ellipsis 
to search for the directory. (File Maintenance will enter a default directory 
based on your FundWare system.)

3. Specify the Data directory and Filter options. (See Search on page 330 for more 
information.)

4. Click Find. (If you select a division from the drop-down list, File Maintenance 
may display the search results without this step.) All files in the directory that 
meet the filter criteria display in the detail pane below.

5. Type the backup directory path in the Backup directory text box, or click the 
ellipsis to search for the directory.

6. Click  on the toolbar or select Maintenance > Restore Files from the menu 
bar. A confirmation message displays. 

7. Click OK. Your files are restored from the Backup directory to your Data 
directory. 

REORG TO THE RESULTS DIRECTORY
The File Maintenance feature allows you to reorg your files (i.e., restructure the index to 
improve speed) to a “results” directory. This results directory acts as a temporary 
directory. From here, you can copy the results to your data directory.
Use this task to reorganize and rebuild data files, reclaiming unusable space from the 
file. This task also rebuilds a corrupted index portion of an MF-COBOL ISAM file pair 
from a valid data portion of the file pair. In addition, this task makes data files 
sequential, rebuilds and indexes the files, deletes unusable file records, and recovers 
disk space occupied by deleted files.

This is a precaution, allowing you to review the results of the reorg before you 
commit to changing your data files.

We strongly suggest that you complete a backup of your files before starting the 
reorg process.

1.  Using Microsoft Explorer, locate the FundWare > 7.## > Bin directory (where 
## represents your version number) and double-click the FILEMAINT.EXE file 
to open. The FundWare File Maintenance feature displays.
Reorg to the Results Directory 
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2. Type the Data directory path in the Data directory text box, or click the ellipsis 
to search for the directory. (File Maintenance will enter a default directory 
based on your FundWare system.)

3. Specify the Data directory and Filter options. (See Search on page 330 for more 
information.)

4. Click Find. (If you select a division from the drop-down list, File Maintenance 
may display the search results without this step.) All files in the directory that 
meet the filter criteria display in the detail pane below.

5. Type the results directory path in the Results directory text box, or click the 
ellipsis to search for the directory.

If the directory does not exist, you will receive an error message. See 
Create Directories on page 330 for more information.

6. Click on the toolbar or select Maintenance > Reorg to Results Directory 
from the menu bar. 

7. Review the results in the detail pane.

8. If the results of the reorg are correct, click  on the toolbar or select 
Maintenance > Copy Files From Results to Data Directory from the menu 
bar. You have completed the reorg process for the selected files.

CREATE SEQUENTIAL FILES FROM MICROFOCUS FILES
The File Maintenance feature allows you to create sequential files from your Microfocus 
files (MFtoSQ) to a “results” directory. This results directory acts as a temporary 
directory. From here, you can copy the results to your data directory.

This is a precaution, allowing you to review the results of the MFtoSQ before 
you commit to changing your data files.

We strongly suggest that you complete a backup of your files before converting 
them to sequential format.

1.  Using Microsoft Explorer, locate the FundWare > 7.## > Bin directory (where 
## represents your version number) and double-click the FILEMAINT.EXE file 
to open. The FundWare File Maintenance feature displays. 
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2. Type the Data directory path in the Data directory text box, or click the ellipsis 
to search for the directory. (File Maintenance will enter a default directory 
based on your FundWare system.)

3. Specify the Data directory and Filter options. (See Search on page 330 for more 
information.)

4. Click Find. (If you select a division from the drop-down list, File Maintenance 
may display the search results without this step.) All files in the directory that 
meet the filter criteria display in the detail pane below.

5. Click  on the toolbar or select Maintenance > MFtoSQ to Results 
Directory from the menu bar. New sequential files are created in the Results 
directory from the selected Microfocus files

6. Review the results in the detail pane.

7. If the results of the reorg are correct, click  on the toolbar or select 
Maintenance > Copy Files From Results to Data Directory from the menu 
bar. The new sequential files are copied to the Data directory. 

You must now rebuild the Microfocus files. See Rebuilding Files on page 336.

REBUILDING FILES

Use the following steps to rebuild your files after completing the MFtoSQ process.
1.  Go to your DOS prompt.

2. Type AFWRUN NWSRBLD1.

3. Press ENTER.
Create Sequential Files From Microfocus Files 
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DISPLAY OPTIONS
You can control the files that display by selecting Maintenance > Options from the 
menu bar. The Options window displays (Figure C.5). 

Figure C.5—File Display Options

Select the check box to hide (i.e., not display):
• Non-Microfocus files,
• Files with no records, and/or
• Files with errors.
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EXPORTING REPORT INFORMATION

General Ledger–Project/Grant reports, including standard reports, trace reports, even 
check files, are in ASCII format. ASCII is a generic format that most spreadsheet or 
work processing programs can read. You can bring any of your FundWare reports into 
your favorite work processor or spreadsheet and modify them there. 

1.  Create the report through Report Manager. 

2. Note the name and location of your report (i.e., the file name that you use to 
open the file through Print Manager). 

For example, the trial balance is called GLTRBAL.L02 for division 02. 
By default, this report is saved as an ASCII formatted file in your 
FundWare > Data folder. 

3. Using the secondary software program of your choice (e.g., Excel), select File > 
Open to open the FundWare report file.

4. The secondary software may display a “Wizard” to guide you through the 
process of importing and formatting the file. 
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A P P E N D I X  E

WORKING WITH TTY LINE NUMBERS

The Classic versions (e.g., 5.8, 5.9) of FundWare use a ‘TTY’ line number to identify 
the terminal that is being used to communicate with the server. (TTY is short for 
‘Teletype,’ the precursor to computer terminals.) This is a holdover from the days when 
FundWare was a mini-computer terminal-based system. 
This document discusses how and when the TTY line number is used in the current 
version of the software, how to modify the TTY line number, and how to solve issues 
with running Classic FundWare processes that are highly dependant on the TTY line 
number (e.g., such as login and imports). Also discussed are issues and solutions 
particular to the Windows Terminal Server and Citrix environments.

THE WINDOWS REGISTRY
This document is not intended to be a tutorial on the Windows registry, but a brief 
overview is valuable so that everyone is familiar with a few terms and concepts. The 
TTY line number is stored in a database called the registry. The Windows operating 
system, along with your application programs, such as FundWare, store their 
configuration information in the registry. The registry contains profiles for each user of 
the computer and information about system hardware, installed programs, and property 
settings. Windows continually references this information during its operation. Registry 
editors are available that enable you to inspect and modify the registry. However, you 
should not need to use one to work with the FundWare registry. FundWare provides a 
utility named SetTTY.exe, described later in this document that can be used to make 
modifications to the TTY numbers stored in the registry.
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It is strongly recommended that you do not edit registry settings yourself. Incorrectly 
editing the registry may severely damage your system. At the very least, you should 
back up the registry before making changes. If you do damage your system, you may be 
able to repair the registry or restore it from the backup copy.

KEYS AND HIVES

The registry is made up of a hierarchy of keys, or folders, much like the folders you see 
in Windows Explorer. The top-level keys are called root keys, or sometimes, hives. 
There are 5 root keys (hives) in the registry:

• HKey_Classes_Root
• HKey_Current_User
• HKey_Local_Machine
• HKey_Users
• HKey_Current_Config

Figure E.1 shows RegEdit open with the 5 hives collapsed. FundWare uses the 
HKey_Current_User (HKCU) and HKey_Local_Machine (HKLM) for storing TTY 
line number information. 

Figure E.1—RegEdit Showing Registry Hives

Each hive (or root key) can hold other keys and values. Figure E.2 shows the registry 
opened to the FundWare key. In the case of the FundWare key, there are a series of 
values, such as Customer Address and Customer CityStateZip. Each value is displayed 
in three columns: 

• Name—Contains the name of the particular value.
The Windows Registry 
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• Type—Contains the data type. In the case of the FundWare key, all the types are 
‘REG_SZ’, which basically means that the value holds string or text data. Other 
values can hold numbers, binary information or other types of data.

• Data—Holds the actual information. For instance, the Version value holds 7.40 
as the data. 

Figure E.2—RegEdit Opened to the FundWare Key

FundWare stores TTY line number information in three places, called entries, in the 
registry:

• 5X—
HKey_Local_Machine\Software\Micro 
Focus\NetExpress\2.0\COBOL\2.0\Environment\TTY

• 7X—HKey_Local_Machine\Software\Fundware\7.40\StationID
— For earlier or later versions of FundWare, substitute the correct version 

number in place of 7.40.
• Terminal Server TTY—HKey_Current_User\Software\Fundware\580\TTY

DETERMINING YOUR TTY NUMBER
Certain import programs require that you know the TTY number for your computer. Use 
the following instructions to determine this number.

1.  Select Run from the Start menu.
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2. Enter REGEDIT in the text box (Figure E.3). 

Figure E.3—Running RegEdit

3. Click OK. The Registry Editor displays (Figure E.4). 

Figure E.4—Registry Editor
Determining Your TTY Number 
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4. Navigate to the HKEY_LOCAL_MACHINE > Software > MicroFocus > 
NetExpress > 2.0 > COBOL > 2.0 > Environment folder (Figure E.5). 

Figure E.5—Example Settings for MicroFocus COBOL

5. Note the number listed in the Data column for the TTY entry (Figure E.6). 

Figure E.6—Example TTY Number

DETERMINING YOUR STATION ID
Certain import programs require that you know the Station ID number for your 
computer. Use the following instructions to determine this number.

1.  Select Run from the Start menu.
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2. Enter REGEDIT in the text box (Figure E.7). 

Figure E.7—Running RegEdit

3. Click OK. The Registry Editor displays (Figure E.8). 

Figure E.8—Registry Editor
Determining Your Station ID 
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4. Navigate to the HKEY_LOCAL_MACHINE > Software > FundWare > 7.40 > 
folder (Figure E.9). (The version number may differ for your machine if you are 
currently using a different version of FundWare.) 

Figure E.9—Example Settings for FundWare

5. Note the number listed in the Data column for the StationID entry (Figure 
E.10). 

Figure E.10—Example Station ID Number
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SETTING A TTY NUMBER OR STATION ID (SERVER/CLIENT)
You can manually set a TTY number or Station ID on your server/client system using 
the following instructions.

1.  Run SetTTY.exe from the Bin folder within your FundWare version folder (e.g., 
FundWare > 7.40 > Bin) (Figure E.18). 

Figure E.11—View/Set TTY

2. Enter the desired TTY number in the New TTY Value box.

3. Click Apply or OK.
Setting a TTY Number or Station ID (Server/Client) 
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4. The new TTY number will be written to the Registry Editor for the MicroFocus 
TTY number (Figure E.12) and FundWare Station ID (Figure E.13). 

Figure E.12—MicroFocus TTY Number 

Figure E.13—FundWare Station ID
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USING WINDOWS TERMINAL SERVER OR CITRIX
The Windows Terminal Server and Citrix environments bring their own set of issues that 
you must understand and address. In a client-server installation, each user has FundWare 
installed on their individual workstation. Each FundWare process reads and writes to the 
registry on that machine, as shown in Figure E.14. 

Figure E.14—Client-Server Registry Access

Under Terminal Server, FundWare is installed only on the server. Each user who runs 
FundWare initiates a Terminal Server session on their client machine. As shown in 
Figure E.15, the HKLM area of the registry is shared whereas each user has a private 
HKCU area. 

Figure E.15—The Registry Under Terminal Server

In a Terminal Server environment, the registry behaves much like it does for different 
users on a single machine: each user gets a unique HKCU registry area and has access to 
a shared HKLM registry area. When User A writes something to the HKLM area of the 
Using Windows Terminal Server or Citrix 
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registry, it is immediately visible to User B and visa versa. The challenge is that since 
FundWare processes use the HKLM area of the registry for storing the TTY line 
number, all users end up with the same TTY number. The solution to this problem is to 
use the SetTTY utility to manage unique TTY numbers in the Terminal Server 
environment.

SETTING UNIQUE TTY NUMBERS AND STATION IDS ON TERMINAL SERVER

As discussed above, FundWare stores the TTY number in three specific areas of the 
Windows registry. The SetTTY utility allows you to view and/or modify each of these. 
When you run SetTTY, the View/Set TTY Registry Key 2.0 displays (Figure E.16). 

Figure E.16—SetTTY User Interface

The SetTTY utility is located in the Bin folder within your FundWare version 
folder (e.g., FundWare > 7.40 > Bin).
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The registry path information can be displayed by hovering the mouse over each of the 
check boxes. A tooltip showing the registry path info is displayed as shown below in 
Figure E.17. 

Figure E.17—Registry Path Tool-Tip

Use the following instructions to set up unique TTY numbers for each FundWare user 
on a Terminal Server.

1.  Get a list of FundWare users.

2. Determine a unique TTY number for each user. Each TTY number should start 
with 0.

3. Log on to a Terminal Server session as a user in the list.

4. Run SetTTY.exe from the Bin folder within your FundWare version folder (e.g., 
FundWare > 7.40 > Bin).

5. Ensure that the Terminal Server check box is selected (Figure E.18). 

Figure E.18—View/Set TTY
Using Windows Terminal Server or Citrix 
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The Terminal Server TTY value may say “Not Found.” This is okay at 
this stage of the process.

6. Enter the desired TTY number in the New TTY Value box.

7. Click Apply or OK.

8. The new TTY number will be written to the Terminal Server entry.

9. Repeat step 3–step 8 for each remaining user.

IMPORT PROGRAMS
Import programs require a similar solution, but with a slightly different implementation. 
Most imports are run by FundWare customers via batch files or stand-alone. Some 
simple DOS batch commands can be used to run imports successfully in either case. The 
heart of the technique is to create a registry import file and run RegEdit in batch mode. 
Start by creating a reg file with the desired registry path and TTY number. You can 
create this file in Notepad directly or create it by exporting the TTY key from the 5X 
registry entry in RegEdit. The file you need is shown in Figure E.19. Note that the 
format of the file in Figure E.19 is specific to Windows 2000. If you have another 
version of Windows (e.g., NT 4) the format may differ. 

Figure E.19—Reg file for Creating a 5X TTY entry
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Give the file a name that is unique for each person that runs imports. You can put 
whatever unique TTY line number in that you want. Once you have this file, create a 
batch file as shown in Figure E.20. 

Figure E.20—Batch File for Importing Vendors

To run a vendor import, you would create JimImport.reg and JimImport.bat in the 
FundWare\Data directory and then name your import file OT0864.z. Typing JimImport 
at the DOS prompt in the data directory will launch the import with the unique TTY 
number. Be sure to use the /s switch with RegEdit.exe as this tells RegEdit to run in 
Silent mode, eliminating the message boxes that tell you the registry was updated 
successfully.
Alternatively, you can rename AFWRun.exe (e.g., AFWRun2.exe) and name your batch 
file AFWRun.bat. The registry file can be named to something non user-specific like 
TSReg.reg for example. The import file name can be passed into the batch file as a 
parameter, so upstream programs that expect to call AFWRun don’t need to be changed. 
An example of this is shown in Figure E.21. 

Figure E.21—Batch File for Replacing AFWRun.
Import Programs 
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DETERMINING YOUR STATION ID

Certain import programs require that you know the station ID for your computer. Use 
the following instructions to determine this number.

1.  Select Run from the Start menu.

2. Enter REGEDIT in the text box (Figure F.1). 

Figure F.1—Running RegEdit

3. Click OK. The Registry Editor displays (Figure F.2). 

Figure F.2—Registry Editor
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4. Navigate to the FundWare version folder (e.g., HKEY_LOCAL_MACHINE > 
Software > FundWare > 7.40) (Figure F.3). 

Figure F.3—Example Settings for FundWare 7.40

5. Note the number listed in the Data column for the StationID entry (Figure F.4). 

Figure F.4—Example Station ID Number
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PRINT MANAGER ADMINISTRATOR

The Print Manager Administrator is a new feature that FundWare is including with your 
Year-End 2001 Service Bulletin. The Administrator is designed to allow you to define 
and control access to certain Print Manager options, including mode, template locations, 
and default directories. You will be able to set the preferred defaults and lock these 
defaults from change by your employees, if you choose.

INSTALLING THE PRINT MANAGER ADMINISTRATOR
The Print Manager Administrator will be installed during the Year-End 2001 Service 
Bulletin installation. At any time, you can remove the Administrator executable file 
(PMAdmin.exe) from your computer, then re-install by copying the file from the service 
bulletin CD (PM Administrator directory) to your computer. 
PMAdmin.exe is installed to the FundWare\data and FundWare\7.x\Bin directories 
(where “7.x” represents your FundWare version number).

USING THE PRINT MANAGER ADMINISTRATOR
The following steps provide instructions for using the Print Manager Administrator.

1.  Because there is no Administrator icon for your desktop, you must browse to 
the appropriate directory to open the program. 
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2. Double-click or right-click and select Open from the pop-up menu. The Print 
Manager Administrator - Login screen displays (Figure G.1). 

Figure G.1—Print Manager Administrator - Login

3. Type the security password: pmguard

4. Click OK. The Print Manager Administrator displays (Figure G.2). 

Figure G.2—Print Manager Administrator
Using the Print Manager Administrator 
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Table G.1 provides an explanation of the options presented by the Administrator. 
Table G.1—Print Manager Administrator Functions

Option Impact to the User

Mode
• Classic
• Windows

Determines the default mode for Print Manager. You can access the same 
choices from the Mode menu in Print Manager.
You can lock your selection from change by the user through the Mode Limit 
option in the Security section (see below for more information).

Template Location
• Global
• Local

Determines the default template location for Print Manager. You can access the 
same choices from the Mode menu in Print Manager.
You can lock your selection from change by the user through the Mode Limit 
option in the Security section (see below for more information).

Default Directories
• Reports
• Local templates
• Global templates

Specify the default directories for the reports, local templates, and global 
templates.
You can lock your selections from change by the user through the Browse Limit 
option in the Security section (see below for more information).

Error Logging By selecting this option, you will enable the error logging option in Print 
Manager. Error logging causes Print Manager to save an error log file 
(PMErrLog.txt) in the Bin or Data directory. A message displays each time you 
open Print Manager when error logging is enabled.

Security
• Mode Limit
• Setup Limit
• Browse Limit

The security options allow you to limit the user’s ability to change the defaults 
set through the Print Manager Administrator. Activating the security options has 
the following impact:
• Mode Limit—If you select this option, the user will not be able to change the 

mode or template location defaults through the Mode menu in Print 
Manager.

• Setup Limit—If you select this option, the user will not be able to access the 
Setup Wizard through the Help menu in Print Manager.

• Browse Limit—If you select this option, the user will not be able to change the 
default directories specified in the Administrator through the File menu in 
Print Manager. 
Also, when the user selects File > Open from the Print Manager menu, the 
only directory available with be the default reports directory. The user will 
not be able to browse to any other directory. See Figure G.3 for further 
explanation.

Selection of a security option is indicated by a check mark. 
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Figure G.3—Print Manager Open File Dialog Box—Browse Limit Set

5. Once you have configured the Print Manager Administrator settings, click 
Apply to save the changes and remain in the Print Manager Administrator 
feature, or click OK to save the changes and close the Print Manager 
Administrator.

6. The next time you open Print Manager, these settings will be active. (If Print 
Manager is open while you are setting these options, you must close and reopen 
Print Manager to activate the Print Manager Administrator settings.)

SECURING THE PRINT MANAGER ADMINISTRATOR SETTINGS
The only way to ensure that your employees cannot change the Print Manager 
Administrator settings is to remove the Administrator executable file (PMAdmin.exe) 
from your computer.

If you need to change the settings, you must copy the file from the Year-End 2001 
Service Bulletin CD to your computer.
Remember, the PMAdmin.exe is installed to the FundWare\data and FundWare\7.x\Bin 
directories (where “7.x” represents your FundWare version number). 

In our example, note that the 
Data folder (set as the default) 
is the only directory that the 
user can access. The drop-
down arrow is disabled and no 
buttons for changing the 
directory are available.

Also, the File Name text box is 
disabled. 

The user can only select an 
existing file in the default 
Report directory, then click 
Open.
Securing the Print Manager Administrator Settings 



GLOSSARY

A
Audit Trail—The method of tracing an accounting entry through the system. A trace 
report is generated each time a transaction is posted to the General Ledger. Many 
standard reports include a transaction number (such as 161T), journal name, and date for 
entries, which also assist the auditor in tracking transactions through the system.

B
Backup—The frequent and regular process of saving the day's work on media external 
to the computer. This is done to protect your database in the event of computer 
malfunction, power failure, or human error.
Boot—Starting your computer.
Buffer—Computers temporarily store information in buffers, which are areas in 
memory. The information is being transferred between one device and another, for 
example, between the hard disk and the printer. Up to a point, increasing the number of 
buffers your computer uses increases the speed of its operation.
Business Date—The date used to post all transactions to the General Ledger. This date 
is entered as part of the sign-on procedure. It always displays in the upper right corner of 
the screen while in the FundWare system.
Bytes—Amount of space needed to store a single character, such as a number, a letter, 
or a space. 1024 bytes equals one kilobyte (KB).

C
Clearing Accounts—Clearing accounts record transactions between the funds. The 
clearing fund is commonly in the operating fund and contains the checking accounts for 
payables and payroll, the control accounts for all modules, and the payroll liability 
accounts.
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Clearing Entries—Clearing entries are created using clearing accounts, whenever a 
transaction is entered which crosses funds. To automatically make clearing entries, you 
must set up automatic balancing and “Due to/from Accounts” for each journal in the 
Define Journal Control task. These entries ensure that all transactions posted to the 
General Ledger are in balance at a fund level. A transaction cannot be posted to the 
General Ledger which leaves any fund out of balance.
Clearing Funds—The fund or funds designated to record transactions between funds. 
The clearing fund is commonly the operating fund and contains the checking accounts 
for payables and payroll, the control accounts for all systems, and the payroll liability 
accounts.
Control Accounts—Control accounts are defined to handle the balancing entries for 
transactions entered through the system.
CPU—The central processing unit of your computer.
Cursor—A marker on the screen that indicates where on the screen your next action 
will take place. Depending upon the operating system, the cursor may appear as a box or 
a line. In some cases it may be blinking.

D
Data—Information stored on a computer system. FundWare programs store your 
accounting records in data files. Data is organized into files, each a collection of records. 
Each record is a group of individual fields.
Date Table—The date table contains the fiscal-period ending dates for each year.
Default—Predetermined information, setting, or device used by your computer if no 
other value is given. For example, your computer will always load programs from disk 
drive A unless you specify drive B.
Demonstration Data—Demonstration data can be found by accessing the Model City 
Division.
Directory—A directory is used to organize files on disks much the same as organizing 
files in a file cabinet. For example, FundWare uses separate directories to organize files 
in groups. All data files are in one directory, all programs in another, and all utility 
commands in a third.
Disk Drive—A physical device that reads and writes information from magnetic disks.
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Division—A single entity's accounting records are maintained in a single division. (An 
entity can be an organization or municipality.) Accounting records of up to 99 entities 
can be maintained simultaneously in up to 99 divisions.

E
Error Messages—Messages appearing on your screen indicating a problem with some 
part of your computer system.
External Media—Disks or tapes not attached to your computer used to store a current 
copy of your data.

F
Fields—Within data records, fields store discrete items of information. For example, a 
name is in one field, an address in another. Most reports can be sorted on any field. 
Fields can also be used to select which records to include in a task or report.
Files—All information stored in a computer system is organized into files. A file 
contains a set of related information, and is similar to a paper file in a file cabinet. 
Examples in FundWare are vendor files, employee master files, meter files, and journal 
files. You set up some of these files upon implementation and the system continually 
updates them as you work. Other files are automatically generated by the system. Files 
are made up of groups of records.
Fiscal Period—A period of time (usually a month) used for managing financial 
transactions, and for producing financial reports. Fiscal periods are defined as part of a 
date table during implementation.
Fund—An independent fiscal and accounting entity with a self-balancing set of 
accounts recording cash and/or other resources together with all related liabilities, 
obligations, revenues, and equities. Funds are segregated for the purpose of carrying on 
specific activities or attaining certain objectives in accordance with special regulations, 
restrictions, or limitations.
Definition from: National Committee on Governmental Accounting, Municipal Finance 
Officers Association of the United States and Canada, “Governmental Accounting, 
Auditing, and Financial Reporting.” (Chicago, 1968), pp 6-7.
Fund Accounting—A method of accounting which allows a single entity (organization) 
to have multiple funds, each requiring separate financial reports.
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Fund Balance—A fund balance account maintains the current equity for the fund. Each 
fund is required to have a fund balance account which is updated at year-end when the 
fund's revenue and expense accounts are closed into it.

H
Hard Disk—A physical device (a disk) used to store information permanently for 
access by your computer. Also referred to as a storage disk or a fixed disk. Information 
is not erased from the hard disk when the power is turned off.
Hardware—The physical components of your computer system such as the printer, 
computer, disk drives, monitor and modem.

I
Input—Communication to your computer, for example, anything typed on the 
keyboard.

J
Journals—Journals are books of original entry, used to group like transactions together 
prior to posting to the appropriate ledger.
Journal Control—Journal controls are used to grant access to a journal and the General 
Ledger. Journal controls must be defined before any transactions can be posted to the 
General Ledger. Journal controls contain the mask used to create fund balancing entries 
for transactions which cross funds.

L
Ledger—Transactions are posted into ledgers from the journals. FundWare systems use 
three ledgers:
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• The General Ledger—All journals except the budget and encumbrance journals 
post to the general ledger. The general ledger maintains actual amounts for 
asset, liability, equity, revenue, and expense accounts.

• Budget Ledger—This ledger maintains budgeted amounts for revenue and 
expense accounts. Entries to the budget ledger are posted from the General 
Ledger module using one or more budget journals.

• Encumbrance Ledger—This ledger maintains encumbered amounts for expense 
accounts. Entries are posted from the Accounts Payable module using an 
encumbrance journal, or from the General Ledger module using a journal set up 
to post encumbrances.

M
Mask—Masks allow the system to create entries for like accounts. A mask uses a 
variable (X) in the place of an actual number within an account format. The system then 
extracts all accounts which match the actual digits in the account format indicated, 
regardless of the digits in the positions indicated by the 'X'.

Example: 01 XX-XX 6000

In the above example, the system would extract all the GLAs with the number 6000 for 
fund 01, regardless of the department number.
Memory—The working space or temporary storage used during the execution of any 
program. Memory is erased when the power is turned off.

O
Online—The ability to access all data at any time including historical information. 
FundWare systems are on-line systems updating all relevant files whenever a transaction 
is entered.
This also refers to a peripheral device, such as a printer being ready to receive 
information from the computer. The printer can be turned on, but not on-line.
Operating System—A set of instructions which acts as the interface between the 
computer and an application.
Blackbaud, Inc. 365



Blackbaud FundWare System Administration Guide

366
Operator's Log—A daily log of all activity on the computer, including the transaction 
codes and description of all transactions posted to the General Ledger, as well as 
notations of all errors or unusual occurrences. The date, time, and media of all backups 
is also noted.
Option List— display across the top of the screen indicating to the operator the options 
available for the task.
Output—Communications from your computer. For example: display of information 
on the screen, reports printed on the printer, or information sent to the hard disk for 
storage.

P
Posting Task—A FundWare system task that updates one or more files at once by 
entering transaction data to the files' records. Most posting tasks update more than one 
file at a time, and generate a trace report.
Program—A set of instructions which allows a computer to perform a specific task or 
function. If you purchased all of FundWare’s programs, your program library would 
contain more than 800 programs.

Q
Queue—A temporary staging area used by the computer to set up several print jobs to 
print consecutively.

R
Reboot—Restart the computer, usually without turning it off. Also known as a “warm 
boot”.
Record—Within a file, specific information is stored as a record. For example, with the 
Vendor Master File, each vendor's information is stored as a record.
Record Key—Each record within a data file is identified by a key. This key is usually a 
number. Keys may not be changed; numbers such as vendor numbers cannot be 
changed.
 



Glossary
Restore—The process of reloading files, previously backed up on external media, onto 
the hard disk.

S
Scrolling—Displaying a list or a document that is longer than may be entirely displayed 
on the screen.
Shortcut Menu—Menu displayed when you click the right mouse button (i.e., right-
click).
Software—A series of machine instructions that manipulate your computer hardware to 
perform specific jobs. The operating system you are using is one type of software. 
FundWare is an application software.
Support—American Fundware, Inc. provides customer support. The definition and 
scope of this support is found in the American Fundware, Inc. Support Policy and in this 
guide.
System Parameters—FundWare system has a parameter record which must be defined 
prior to entering transactions for that system. The parameter record contains data 
specific to the organization, such as account numbers to be used for control entries.

T
Task—A specific function chosen from a FundWare menu. Tasks allow you to initially 
set up your files, make changes to existing records, enter transactions, produce reports, 
and otherwise manage the financial information for your organization. 
Trace Report—A report created automatically each time a transaction is posted to the 
General Ledger module. Detail and/or summary reports are available. The type of report 
desired is indicated in the journal control record for each journal. This is your audit trail 
for activity in the General Ledger. Each transaction posted is assigned a number. The 
system then uses this number to name the filed trace report. For example, a transaction 
assigned number 121 will have a trace report filed with the name CS00121.
The trace report contains the journal used to post the transaction, the date, the accounts 
and amounts posted, descriptive information, and the user ID number of the operator 
who posted the entry.
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Transaction—A group of related accounting entries posted to the General Ledger 
through a journal. They affect a net change to the files maintained by the system. 
Transaction tasks post information to files created by you as well as to files created by 
the system. The system creates special transaction files which are “invisible” to you 
except that the information from these files appears on transaction reports. Information 
which has been posted is permanent and requires a new transaction to change it.
Some transaction tasks create entries which are posted to the General Ledger. These 
tasks are called “posting tasks”. The entries are posted automatically to the General 
Ledger and require a reversing entry if the information is posted incorrectly or with the 
wrong date. The sign-on date (business date) is used to post these entries.
Dates in FundWare are organized into fiscal periods which are maintained by various 
modules. Fiscal periods may be marked as closed. If the date with which you signed on 
is in a closed period, you will not be able to select a posting task anywhere in the 
program.

U
Utility—A special program which performs management functions of a computer 
system. For example, utility programs are used to handle printing, backing up, and file 
recovery processes.
 



INDEX

Symbols
"Error log exists" . . . . . . . . . . . . . . . . 31

A
Access

From keyboard  . . . . . . . . . . . . . . 12
Shortcut menus  . . . . . . . . . . . . . . 12

Accounts
Importing . . . . . . . . . . . . . . . . . . 108
Synchronizing . . . . . . . . . . . . . . . 93

Accounts Payable  . . . . . . . . . . . . . . . . 1
Clear flags . . . . . . . . . . . . . . . . . . 94
Export obligations . . . . . . . . . . . 152

Accounts Receivable . . . . . . . . . . . . . . 2
Acronyms

Menu . . . . . . . . . . . . . . . . . . . . . . 13
Adding

Columns to detail pane  . . . . . . . . 16
Division . . . . . . . . . . . . . . . . . . . . 77
Users . . . . . . . . . . . . . . . . . . . . . . 53
Workgroups . . . . . . . . . . . . . . . . . 39

Administrator . . . . . . . . . . . . . 36, 37, 73
Administrator level  . . . . . . . . . . . . . . 36
Advanced Financial Reporting  . . . . . . 2
Advanced Security . . . . . . . . . . . . . . . . 2
Aging

Disabling . . . . . . . . . . . . . . . . . . . 23
Aging passwords . . . . . . . . . . . . . . . . 22
Allocation Management  . . . . . . . . . . . 2
Allow all  . . . . . . . . . . . . . . . . . . . . . . 45
ALT key . . . . . . . . . . . . . . . . . . . . . . . 12
AP

Clear flags . . . . . . . . . . . . . . . . . . 94

ASCII . . . . . . . . . . . . . . . . . . . . . . . . 339
Assigning

Users to multiple workgroups . . . 63
Users to workgroups  . . . .47, 56, 62

Asterisks . . . . . . . . . . . . . . . . . . . . . . . . 5
Audit process . . . . . . . . . . . . . . . . . . . 27
Audit trail

Defined  . . . . . . . . . . . . . . . . . . . 361
Trace reports  . . . . . . . . . . . . . . . 367

B
Backup . . . . . . . . . . . . . . . . . . . . . . . 323

Defined  . . . . . . . . . . . . . . . . . . . 361
Division . . . . . . . . . . . . . . . . . . . . 80
File maintenance . . . . . . . . . . . . 332
Responsibility for  . . . . . . . . . . . 323

Backup and restore considerations  . 323
Bank Reconciliation . . . . . . . . . . . . . . . 2
Bank reconciliation

Import payroll reconciliation . . . 181
Basic security . . . . . . . . . . . . . . . . . . . 56
Batches

Deleting imported  . . . . . . . . . . . 141
Restoring imported  . . . . . . . . . . 141

Bold  . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Boot

Defined  . . . . . . . . . . . . . . . . . . . 361
Budget Control . . . . . . . . . . . . . . . . . . . 2
Budget Forecasting  . . . . . . . . . . . . . . . 2
Budget ledger

Defined  . . . . . . . . . . . . . . . . . . . 365
Budget Preparation  . . . . . . . . . . . . . . . 3
Buffer
Blackbaud, Inc. 369



Blackbaud FundWare System Administration Guide

370
Defined  . . . . . . . . . . . . . . . . . . .361
Business date

Defaults  . . . . . . . . . . . . . . . . . . . . .5
Defined  . . . . . . . . . . . . . . . . . . .361
Opening multiple . . . . . . . . . . . . . .8

Business Office  . . . . . . . . . . . . . . . . .19
Business rules

Importing customer data  . .191, 289
Bytes

Defined  . . . . . . . . . . . . . . . . . . .361

C
Capital letters . . . . . . . . . . . . . . . . . . .19
Cash Receipts . . . . . . . . . . . . . . . . . . . .3
Caution . . . . . . . . . . . . . . . . . . . . . . . .19
Changing

Default security settings  . . . . . . .57
Passwords  . . . . . . . . . . . . . . . . . .73
Users  . . . . . . . . . . . . . . . . . . . . . .66
Workgroups . . . . . . . . . . . . . . . . .47

Checks
Import reconciliation . . . . . . . . .179

Clear
AP flags . . . . . . . . . . . . . . . . . . . .94

Clearing accounts
Defined  . . . . . . . . . . . . . . . . . . .361

Clearing entries
Defined  . . . . . . . . . . . . . . . . . . .362

Clearing funds
Defined  . . . . . . . . . . . . . . . . . . .362

Columns
Adding to detail pane . . . . . . . . . .16
Removing from detail pane . . . . .16
Re-ordering in detail pane . . . . . .16
Resizing in detail pane . . . . . . . . .17
Sorting in detail pane . . . . . . . . . .17

Consulting services  . . . . . . . . . . . . . .18
Contacting FundWare  . . . . . . . . . . . .25

Control accounts
Defined . . . . . . . . . . . . . . . . . . . 362

Copying
Division  . . . . . . . . . . . . . . . . . . . 88
Users Duplicating

Users . . . . . . . . . . . . . . . . . . 68
Workgroups . . . . . . . . . . . . . . . . 50

CPU
Defined . . . . . . . . . . . . . . . . . . . 362

Creating
Division  . . . . . . . . . . . . . . . . . . . 77
Users  . . . . . . . . . . . . . . . . . . . . . 53
Workgroups . . . . . . . . . . . . . . . . 39

CSXLOG  . . . . . . . . . . . . . . . . . . . . 128
Cursor

Defined . . . . . . . . . . . . . . . . . . . 362
CUSAR10 . . . . . . . . . . . . . . . . . . . . 236
CUSAR15 . . . . . . . . . . . . . . . . . . . . 273
CUSAR16 . . . . . . . . . . . . . . . . . . . . 276
CUSAR20 . . . . . . . . . . . . . . . . . . . . 244
CUSAR25 . . . . . . . . . . . . . . . . . . . . 252
CUSAR31 . . . . . . . . . . . . . . . . . . . . 264
CUSAR32 . . . . . . . . . . . . . . . . . . . . 258
CUSAR40 . . . . . . . . . . . . . . . . . . . . 270
CUSCR08 . . . . . . . . . . . . . . . . . . . . 297
CUSCR20 . . . . . . . . . . . . . . . . . . . . 303
CUSCR28 . . . . . . . . . . . . . . . . . . . . 307
CUSCS10 . . . . . . . . . . . . . . . . . . . . 111
CUSFX08 . . . . . . . . . . . . . . . . . . . . 311
CUSFX20 . . . . . . . . . . . . . . . . . . . . 318
CUSGL10 . . . . . . . . . . . . . . . . . . . . 118
CUSOT10 . . . . . . . . . . . . . . . . . . . . 145
CUSOT20 . . . . . . . . . . . . . . . . . . . . 139
CUSOT30 . . . . . . . . . . . . . . . . . . . . 153
CUSPY06 . . . . . . . . . . . . . . . . . . . . 172
CUSPY08 . . . . . . . . . . . . . . . . . . . . 159
CUSPY20 . . . . . . . . . . . . . . . . 164, 178
Customer data
 



Index
Import business rules  . . . . 191, 289
Import errors . . . . . . . . . . . 195, 293
Import requirements  . . . . . 188, 285
Importing . . . . . . . . . . . . . . . . . . 285
Steps for importing . . . . . . 192, 290
Tips for importing . . . . . . . 194, 292

Customizing
Display  . . . . . . . . . . . . . . . . . . . . 15
User security . . . . . . . . . . . . . . . . 57

D
Data

Defined  . . . . . . . . . . . . . . . . . . . 362
Sample . . . . . . . . . . . . . . . . . . . . . 90

Database information . . . . . . . . . . . . . 34
Date Table

Defined  . . . . . . . . . . . . . . . . . . . 362
Default

Defined  . . . . . . . . . . . . . . . . . . . 362
Default user . . . . . . . . . . . . . . . . . . . . 36
Defaults

Business date . . . . . . . . . . . . . . . . . 5
Changing security settings  . . . . . 57
Division . . . . . . . . . . . . . . . . . . . . . 5
HomePage . . . . . . . . . . . . . . . . . . . 5
Password . . . . . . . . . . . . . . . . . . . . 4
System Administration  . . . . . . . . . 5
User name . . . . . . . . . . . . . . . . . . . 4

Defining
Users . . . . . . . . . . . . . . . . . . . . . . 53
Workgroups . . . . . . . . . . . . . . . . . 39

Deleting
Divisions . . . . . . . . . . . . . . . . . . . 89
Imported batches . . . . . . . . . . . . 141
Users . . . . . . . . . . . . . . . . . . . . . . 70
Workgroups . . . . . . . . . . . . . . . . . 51

Demo user  . . . . . . . . . . . . . . . . . . . . . 36

Demonstration Data
Defined  . . . . . . . . . . . . . . . . . . . 362

Deny all  . . . . . . . . . . . . . . . . . . . . . . . 45
Detail pane

Adding columns  . . . . . . . . . . . . . 16
Removing columns  . . . . . . . . . . . 16
Re-ordering columns . . . . . . . . . . 16
Resizing columns  . . . . . . . . . . . . 17
Sorting data . . . . . . . . . . . . . . . . . 17

Directory
Defined  . . . . . . . . . . . . . . . . . . . 362

Disabled menu items  . . . . . . . . . . . . . 13
Disk drive

Defined  . . . . . . . . . . . . . . . . . . . 362
Display

Customizing  . . . . . . . . . . . . . . . . 15
Display type . . . . . . . . . . . . . . . . . . . . 39
Division

Defaults . . . . . . . . . . . . . . . . . . . . . 5
Defined  . . . . . . . . . . . . . . . . . . . 363

Division 95 . . . . . . . . . . . . . . . . . . . . . 90
Division 96 . . . . . . . . . . . . . . . . . . . . . 90
Division maintenance

Adding . . . . . . . . . . . . . . . . . . . . . 77
Division range  . . . . . . . . . . . . . . . . . . 38
Divisions

Backup . . . . . . . . . . . . . . . . . . . . . 80
Copying . . . . . . . . . . . . . . . . . . . . 88
Deleting . . . . . . . . . . . . . . . . . . . . 89
Editing . . . . . . . . . . . . . . . . . . . . . 90
Opening multiple . . . . . . . . . . . . . . 8
Restore as  . . . . . . . . . . . . . . . . . . 85
Restoring . . . . . . . . . . . . . . . . . . . 82
Sample . . . . . . . . . . . . . . . . . . . . . 90

Drop-down lists  . . . . . . . . . . . . . . . . . 12
Duplicating

Workgroups . . . . . . . . . . . . . . . . . 50
Blackbaud, Inc. 371



Blackbaud FundWare System Administration Guide

372
E
Editing

Division information . . . . . . . . . .90
Menu bar  . . . . . . . . . . . . . . . . . . .13
Users  . . . . . . . . . . . . . . . . . . . . . .66
Workgroups . . . . . . . . . . . . . . . . .47

Encumbrance ledger
Defined  . . . . . . . . . . . . . . . . . . .365

ERRLOG.WS . . . . . . . . . . . . . . . . . . .31
Error logs  . . . . . . . . . . . . . . . . . . .31, 98
Error messages

FundWare  . . . . . . . . . . . . . . . . .100
Errors

Importing customer data  . .195, 293
Importing transaction data . . . . .225

Example . . . . . . . . . . . . . . . . . . . . . . .19
Transaction data import setup . .210

Excel . . . . . . . . . . . . . . . . . . . . . . . . .339
Execute programs . . . . . . . . . . . . . . . .33
Expiration

Passwords  . . . . . . . . . . . . . . . . . .22
Exporting

GL transactions  . . . . . . . . . . . . .117
P/G transactions . . . . . . . . . . . . .117
To other programs . . . . . . . . . . .339

External media
Defined  . . . . . . . . . . . . . . . . . . .363

F
F1 . . . . . . . . . . . . . . . . . . . . . . . . . . . .17
F10 . . . . . . . . . . . . . . . . . . . . . . . . . . .12
Fields

Defined  . . . . . . . . . . . . . . . . . . .363
File information  . . . . . . . . . . . . . . . . .25
File maintenance  . . . . . . . . . . . . . . .329

Backup files . . . . . . . . . . . . . . . .332
Copy Reorg  . . . . . . . . . . . .335, 336
Reorg files . . . . . . . . . . . . . . . . .334

Restore files . . . . . . . . . . . . . . . 333
Search . . . . . . . . . . . . . . . . . . . . 330
Sequential files . . . . . . . . . . . . . 335

File wildcard . . . . . . . . . . . . . . . . . . . 27
Files

Defined . . . . . . . . . . . . . . . . . . . 363
Sequential . . . . . . . . . . . . . . . . . 335

Financial Institutions  . . . . . . . . . . . . . 3
Fiscal period

Defined . . . . . . . . . . . . . . . . . . . 363
Fixed Assets . . . . . . . . . . . . . . . . . . . . 3
Flags

Clear AP . . . . . . . . . . . . . . . . . . . 94
Forms

Customizing . . . . . . . . . . . . . . . . 15
Full name  . . . . . . . . . . . . . . . . . . . . . 55
Function keys . . . . . . . . . . . . . . . . . 326
Fund

Defined . . . . . . . . . . . . . . . . . . . 363
Fund accounting

Defined . . . . . . . . . . . . . . . . . . . 363
Fund balance

Defined . . . . . . . . . . . . . . . . . . . 364
FundWare

Modules . . . . . . . . . . . . . . . . . . . . 1
FundWare error messages  . . . . . . . 100

G
General Ledger

Importing accounts  . . . . . . . . . 108
Importing transactions . . . . . . . 112

General ledger
Defined . . . . . . . . . . . . . . . . . . . 365

General Ledger–Project/Grant . . . . . . 3
Getting  . . . . . . . . . . . . . . . . . . . . . . . 19
GLS018  . . . . . . . . . . . . . . . . . . . . . 115
Guides . . . . . . . . . . . . . . . . . . . . . . . . 17
 



Index
H
Hard disk

Defined  . . . . . . . . . . . . . . . . . . . 364
Hardware

Defined  . . . . . . . . . . . . . . . . . . . 364
Help . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Problem report  . . . . . . . . . . . . . 103
Who to call  . . . . . . . . . . . . . . . . 103

HomePage  . . . . . . . . . . . . . . . . . . . . . 22
Defaults . . . . . . . . . . . . . . . . . . . . . 5

I
iData  . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Import

Obligations  . . . . . . . . . . . . . . . . 130
Import payroll information 157, 187, 285, 
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 295
Imported batches

Deleting . . . . . . . . . . . . . . . . . . . 141
Restoring . . . . . . . . . . . . . . . . . . 141

Importing
Account information . . . . . . . . . 108
Check reconciliation . . . . . . . . . 179
Customer data . . . . . . . . . . . . . . 285
Customer data business rules  . 191, 

289
Customer data errors . . . . . 195, 293
Customer data requirements 188, 285
Customer data tips . . . . . . . 194, 292
Payroll reconciliation  . . . . . . . . 181
Steps for customer data . . . 192, 290
Steps for transaction data  . . . . . 221
Transaction data  . . . . . . . . . . . . 196
Transaction data errors  . . . . . . . 225
Transaction data example setup 210
Transaction data requirements  . 198
Transaction data tips . . . . . . . . . 224
Transactions  . . . . . . . . . . . . . . . 112

Inactive users . . . . . . . . . . . . . . . . . . . 71
Information

Organization  . . . . . . . . . . . . . . . . 28
Input

Defined  . . . . . . . . . . . . . . . . . . . 364
Instances . . . . . . . . . . . . . . . . . . . . . . . . 8

From the desktop . . . . . . . . . . . . . . 9
From the program  . . . . . . . . . . . . . 9
From the Start menu  . . . . . . . . . . . 9

Introduction  . . . . . . . . . . . . . . . . . . . . . 1
Italics  . . . . . . . . . . . . . . . . . . . . . . . . . 19

J
Journal control

Defined  . . . . . . . . . . . . . . . . . . . 364
Journals

Defined  . . . . . . . . . . . . . . . . . . . 364

K
Keyboard

Right-click menus . . . . . . . . . . . . 12
Keyboard access  . . . . . . . . . . . . . . . . 12
Keys

0 for no  . . . . . . . . . . . . . . . . . . . 326
1 for yes . . . . . . . . . . . . . . . . . . . 326
Abort program . . . . . . . . . . . . . . 327
Aternate for yes, no . . . . . . . . . . 326
Caps lock . . . . . . . . . . . . . . . . . . 325
CR  . . . . . . . . . . . . . . . . . . . . . . . 325
CTRL, BREAK . . . . . . . . . . . . . 327
CTRL, END  . . . . . . . . . . . . . . . 327
CTRL, HOME . . . . . . . . . . . . . . 327
DEL . . . . . . . . . . . . . . . . . . . . . . 326
Delete  . . . . . . . . . . . . . . . . . . . . 326
Delete characters . . . . . . . . . . . . 327
Delete fields . . . . . . . . . . . . . . . . 327
Duplicate fields . . . . . . . . . . . . . 326
Enter  . . . . . . . . . . . . . . . . . . . . . 325
Blackbaud, Inc. 373



Blackbaud FundWare System Administration Guide

374
F1 . . . . . . . . . . . . . . . . . . . . . . . .326
F2 . . . . . . . . . . . . . . . . . . . . . . . .326
F4 . . . . . . . . . . . . . . . . . . . . . . . .326
F5 . . . . . . . . . . . . . . . . . . . . . . . .326
F6 . . . . . . . . . . . . . . . . . . . . . . . .327
F7 . . . . . . . . . . . . . . . . . . . . . . . .327
F8 . . . . . . . . . . . . . . . . . . . . . . . .327
Function . . . . . . . . . . . . . . . . . . .326
Help . . . . . . . . . . . . . . . . . . . . . .326
INS . . . . . . . . . . . . . . . . . . . . . . .325
Insert  . . . . . . . . . . . . . . . . . . . . .325
NL  . . . . . . . . . . . . . . . . . . . . . . .325
Num lock . . . . . . . . . . . . . . . . . .325
Program information . . . . . . . . .327
Recall field . . . . . . . . . . . . . . . . .327
Repaint screen . . . . . . . . . . . . . .326
Return  . . . . . . . . . . . . . . . . . . . .325
Select range . . . . . . . . . . . . . . . .326
Skip  . . . . . . . . . . . . . . . . . . . . . .326
Suspense account . . . . . . . . . . . .327
Tab, shifted  . . . . . . . . . . . . . . . .325
Tab, unshifted  . . . . . . . . . . . . . .325

L
Ledger

Budget  . . . . . . . . . . . . . . . . . . . .364
Defined  . . . . . . . . . . . . . . . . . . .364
Encumbrance . . . . . . . . . . . . . . .364
General  . . . . . . . . . . . . . . . . . . .364

Level 1  . . . . . . . . . . . . . . . . . . . . . . . .37
Level 2  . . . . . . . . . . . . . . . . . . . . . . . .37
Levels . . . . . . . . . . . . . . . . . . . . . .36, 39
License information . . . . . . . . . . . . . .22
License number  . . . . . . . . . . . . . .28, 33
Links . . . . . . . . . . . . . . . . . . . . . . . . . .25
Logged in users  . . . . . . . . . . . . . . . . .24
Login  . . . . . . . . . . . . . . . . . . . . . . . . .55
Logs  . . . . . . . . . . . . . . . . . . . . . . . . . .31

M
Maintenance

Backup files . . . . . . . . . . . . . . . 332
Copy Reorg  . . . . . . . . . . . 335, 336
File maintenance  . . . . . . . . . . . 329
Reorg files  . . . . . . . . . . . . . . . . 334
Restore files . . . . . . . . . . . . . . . 333
Search . . . . . . . . . . . . . . . . . . . . 330
Sequential files . . . . . . . . . . . . . 335

Manuals  . . . . . . . . . . . . . . . . . . . . . . 17
Mask

Defined . . . . . . . . . . . . . . . . . . . 365
Memory

Defined . . . . . . . . . . . . . . . . . . . 365
Menu acronyms  . . . . . . . . . . . . . . . . 13
Menu bar . . . . . . . . . . . . . . . . . . . . . . 12

Editing  . . . . . . . . . . . . . . . . . . . . 13
Menu key  . . . . . . . . . . . . . . . . . . . . . 12
Menus

Keyboard access  . . . . . . . . . . . . 12
Security  . . . . . . . . . . . . . . . . . . . 13

Microfocus
Create sequential files  . . . . . . . 335

Modify
Registration  . . . . . . . . . . . . . . . . 29

Modifying
Users  . . . . . . . . . . . . . . . . . . . . . 66
Workgroups . . . . . . . . . . . . . . . . 47

Module Navigator . . . . . . . . . . . . . . . 13
Module navigator

Security  . . . . . . . . . . . . . . . . . . . 15
Modules

Change registration  . . . . . . . . . . 29
Multiple

Business dates  . . . . . . . . . . . . . . . 8
Divisions  . . . . . . . . . . . . . . . . . . . 8
 



Index
N
Name  . . . . . . . . . . . . . . . . . . . . . . . . . 38
Navigator bar . . . . . . . . . . . . . . . . . . . 13
New

Division . . . . . . . . . . . . . . . . . . . . 77

O
Obligations

Import  . . . . . . . . . . . . . . . . . . . . 130
OCW048  . . . . . . . . . . . . . . . . . . . . . 148
On-line

Defined  . . . . . . . . . . . . . . . . . . . 365
Online help  . . . . . . . . . . . . . . . . . . . . 17
Open Windows Navigator . . . . . . . . . 15
Open windows navigator

Security . . . . . . . . . . . . . . . . . . . . 15
Opening

From the desktop . . . . . . . . . . . . . . 9
From the program . . . . . . . . . . . . . 9
From the Start menu  . . . . . . . . . . . 9

Operating system
Defined  . . . . . . . . . . . . . . . . . . . 365

Operator’s log
Defined  . . . . . . . . . . . . . . . . . . . 366

Option list
Defined  . . . . . . . . . . . . . . . . . . . 366

Organization information  . . . . . . . . . 28
Organization name . . . . . . . . . . . . . . . 33
Output

Defined  . . . . . . . . . . . . . . . . . . . 366

P
Password  . . . . . . . . . . . . . . . . . . . 38, 55

Asterisks  . . . . . . . . . . . . . . . . . . . . 5
Defaults . . . . . . . . . . . . . . . . . . . . . 4

Passwords
Aging . . . . . . . . . . . . . . . . . . . . . . 22
Changing . . . . . . . . . . . . . . . . . . . 73

Disabling aging . . . . . . . . . . . . . . 23
Payroll information, import . . 157, 187, 
285,  . . . . . . . . . . . . . . . . . . . . . . . . . 295
Payroll reconciliation

Importing . . . . . . . . . . . . . . . . . . 181
Payroll/Personnel . . . . . . . . . . . . . . . . . 3

File format for importing employee 
time cards . . . . . . . . . . . 171

PGS018  . . . . . . . . . . . . . . . . . . . . . . 115
Posting task

Defined  . . . . . . . . . . . . . . . . . . . 366
Print

User settings  . . . . . . . . . . . . . . . . 61
Workgroup settings . . . . . . . .45, 46

Printing
Security information  . . . . . . . . . . 73

Problem report
Help . . . . . . . . . . . . . . . . . . . . . . 103

Processing error logs  . . . . . . . . . . . . . 31
Program

CUSAR10  . . . . . . . . . . . . . . . . . 236
CUSAR15  . . . . . . . . . . . . . . . . . 273
CUSAR16  . . . . . . . . . . . . . . . . . 276
CUSAR20  . . . . . . . . . . . . . . . . . 244
CUSAR25  . . . . . . . . . . . . . . . . . 252
CUSAR31  . . . . . . . . . . . . . . . . . 264
CUSAR32  . . . . . . . . . . . . . . . . . 258
CUSAR40  . . . . . . . . . . . . . . . . . 270
CUSCR08  . . . . . . . . . . . . . . . . . 297
CUSCR20  . . . . . . . . . . . . . . . . . 303
CUSCR28  . . . . . . . . . . . . . . . . . 307
CUSCS10  . . . . . . . . . . . . . . . . . 111
CUSFX08  . . . . . . . . . . . . . . . . . 311
CUSFX20  . . . . . . . . . . . . . . . . . 318
CUSGL10  . . . . . . . . . . . . . . . . . 118
CUSOT10  . . . . . . . . . . . . . . . . . 145
CUSOT20  . . . . . . . . . . . . . . . . . 139
CUSOT30  . . . . . . . . . . . . . . . . . 153
Blackbaud, Inc. 375



Blackbaud FundWare System Administration Guide

376
CUSPY06  . . . . . . . . . . . . . . . . .172
CUSPY08  . . . . . . . . . . . . . . . . .159
CUSPY20  . . . . . . . . . . . . .164, 178
Defined  . . . . . . . . . . . . . . . . . . .366
GLS018  . . . . . . . . . . . . . . . . . . .115
OCW048  . . . . . . . . . . . . . . . . . .148
PGS018  . . . . . . . . . . . . . . . . . . .115

Project/Grant
Importing accounts  . . . . . . . . . .108
Importing transactions . . . . . . . .112

Q
Queue

Defined  . . . . . . . . . . . . . . . . . . .366

R
Reboot

Defined  . . . . . . . . . . . . . . . . . . .366
Reconciliation

Import  . . . . . . . . . . . . . . . . . . . .179
Record

Defined  . . . . . . . . . . . . . . . . . . .366
Record key

Defined  . . . . . . . . . . . . . . . . . . .366
Registration  . . . . . . . . . . . . . . . . . . . .29
Registration key . . . . . . . . . . . . . .29, 33
Registration management . . . . . . . . . .28

Organization  . . . . . . . . . . . . . . . .28
Registration  . . . . . . . . . . . . . . . . .29

Removing
Columns from detail pane . . . . . .16
Users  . . . . . . . . . . . . . . . . . . . . . .70
Workgroups . . . . . . . . . . . . . . . . .51

Re-ordering
Columns in detail pane  . . . . . . . .16

Reorg
Copy results . . . . . . . . . . . .335, 336
File maintenance  . . . . . . . . . . . .334

Report
Problem  . . . . . . . . . . . . . . . . . . 103

Report path . . . . . . . . . . . . . . . . . . . . 55
Reports

ASCII . . . . . . . . . . . . . . . . . . . . 339
Error . . . . . . . . . . . . . . . . . . . . . . 98
Exporting . . . . . . . . . . . . . . . . . 339

Requirements
Importing customer data  . 188, 285
Importing transaction data . . . . 198

Reset
AP flags  . . . . . . . . . . . . . . . . . . . 94

Resizing
Columns in detail pane  . . . . . . . 17

Restore
Defined . . . . . . . . . . . . . . . . . . . 367
File maintenance  . . . . . . . . . . . 333

Restore as . . . . . . . . . . . . . . . . . . . . . 85
Restoring

Divisions  . . . . . . . . . . . . . . . . . . 82
Imported batches  . . . . . . . . . . . 141

Restoring data
Considerations . . . . . . . . . . . . . 323

Right-click menus . . . . . . . . . . . . . . . 12

S
Sample divisions . . . . . . . . . . . . . . . . 90
Scrolling

Defined . . . . . . . . . . . . . . . . . . . 367
Search

File maintenance  . . . . . . . . . . . 330
Security

Customizing . . . . . . . . . . . . . . . . 57
Full name . . . . . . . . . . . . . . . . . . 55
Levels . . . . . . . . . . . . . . . . . . . . . 37
Login  . . . . . . . . . . . . . . . . . . . . . 55
Menus . . . . . . . . . . . . . . . . . . . . . 13
Navigator bar . . . . . . . . . . . . . . . 15
 



Index
Password . . . . . . . . . . . . . . . . . . . 55
Report path  . . . . . . . . . . . . . . . . . 55
Task . . . . . . . . . . . . . . . . . . . . . . . 35
User ID  . . . . . . . . . . . . . . . . . . . . 54
User status . . . . . . . . . . . . . . . . . . 55

Security level . . . . . . . . . . . . . . . . . . . 39
Security levels . . . . . . . . . . . . . . . . . . 36
Sequential files

File maintenance . . . . . . . . . . . . 335
Setup

Example transaction data import 210
Shortcut keys . . . . . . . . . . . . . . . . . . . 12
Shortcut menu  . . . . . . . . . . . . . . . . . 367
Shortcut menus  . . . . . . . . . . . . . . . . . 12
Software

Defined  . . . . . . . . . . . . . . . . . . . 367
Sorting

Data in detail pane  . . . . . . . . . . . 17
Special processing

Error logs  . . . . . . . . . . . . . . . . . . 98
Status

Inactive  . . . . . . . . . . . . . . . . . . . . 71
User . . . . . . . . . . . . . . . . . . . . . . . 55

Support
Defined  . . . . . . . . . . . . . . . . . . . 367
Department  . . . . . . . . . . . . . . . . 103

Synchronizing
Accounts . . . . . . . . . . . . . . . . . . . 93

System Administration
Defaults . . . . . . . . . . . . . . . . . . . . . 5

System Administration HomePage  . . 22
System parameters

Defined  . . . . . . . . . . . . . . . . . . . 367
System user  . . . . . . . . . . . . . . . . . . . . 36
System Utilities

File information  . . . . . . . . . . . . . 25

T
Task  . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Defined  . . . . . . . . . . . . . . . . . . . 367
Technical support . . . . . . . . . . . . . . . . 19
Testing procedures . . . . . . . . . . . . . . . 90
Tips

Importing customer data  . .194, 292
Importing transaction data . . . . . 224

Trace report
Defined  . . . . . . . . . . . . . . . . . . . 367

Training  . . . . . . . . . . . . . . . . .18, 20, 90
Transaction

Defined  . . . . . . . . . . . . . . . . . . . 368
Transaction data

Example import setup  . . . . . . . . 210
Import errors  . . . . . . . . . . . . . . . 225
Import requirements  . . . . . . . . . 198
Importing . . . . . . . . . . . . . . . . . . 196
Steps for importing  . . . . . . . . . . 221
Tips for importing . . . . . . . . . . . 224

Transactions
Exporting GL . . . . . . . . . . . . . . . 117
Exporting P/G  . . . . . . . . . . . . . . 117
Importing . . . . . . . . . . . . . . . . . . 112

U
User  . . . . . . . . . . . . . . . . . . . . . . . . . . 37

Demo user . . . . . . . . . . . . . . . . . . 36
Full name . . . . . . . . . . . . . . . . . . . 55
ID . . . . . . . . . . . . . . . . . . . . . . . . . 54
Login . . . . . . . . . . . . . . . . . . . . . . 55
Password  . . . . . . . . . . . . . . . . . . . 55
Report path  . . . . . . . . . . . . . . . . . 55
Status . . . . . . . . . . . . . . . . . . . . . . 55

User guides  . . . . . . . . . . . . . . . . . . . . 17
User ID . . . . . . . . . . . . . . . . . . . . . . . . 54
User level . . . . . . . . . . . . . . . . . . . . . . 36
User name
Blackbaud, Inc. 377



Blackbaud FundWare System Administration Guide

378
Defaults  . . . . . . . . . . . . . . . . . . . . .4
Users

Adding . . . . . . . . . . . . . . . . . . . . .53
Assigning to workgroups 47, 56, 62
Copying . . . . . . . . . . . . . . . . . . . .68
Customizing security . . . . . . . . . .57
Deleting . . . . . . . . . . . . . . . . . . . .70
Editing . . . . . . . . . . . . . . . . . . . . .66
Inactive status  . . . . . . . . . . . . . . .71
Logged in . . . . . . . . . . . . . . . . . . .24
Multiple workgroups . . . . . . . . . .63
Printing  . . . . . . . . . . . . . . . . . . . .73

Using this document . . . . . . . . . . . . . .18
Using Your System

Overview . . . . . . . . . . . . . . . . . . . .1
Utility

Defined  . . . . . . . . . . . . . . . . . . .368

V
Version information . . . . . . . . . . 22, 33
Viewing

File information . . . . . . . . . . . . . 25
Logged in users  . . . . . . . . . . . . . 24

W
Warning  . . . . . . . . . . . . . . . . . . . . . . 19
Workgroups

Adding . . . . . . . . . . . . . . . . . . . . 39
Administrator . . . . . . . . . . . . . . . 36
Assigning users  . . . . . . . 47, 56, 62
Assigning users to multiple  . . . . 63
Copying  . . . . . . . . . . . . . . . . . . . 50
Definition . . . . . . . . . . . . . . . . . . 35
Deleting  . . . . . . . . . . . . . . . . . . . 51
Editing  . . . . . . . . . . . . . . . . . . . . 47
Printing . . . . . . . . . . . . . . . . . . . . 73
 


	Blackbaud FundWare System Administration Guide
	Introduction
	The BLackbaud FundWare Suite of Products
	Understanding the Database Structure
	Support Files
	Some FundWare Basics
	Opening FundWare
	Changing Your Password During Login

	Opening FundWare Multiple Times
	Opening Additional Instances-From the Desktop/Start Menu
	Opening Additional Instances-From the Program

	Changing the Business Date
	Changing Your Password From the Software
	Using the Menu Bar
	Keyboard Navigation
	Is Your Menu Bar Too Crowded?
	How Your Security Rights Impact the Menu Bar

	Using the Navigator Bar
	Module Navigator
	Open Windows Navigator
	How Your Security Rights Impact the Navigator Bar

	Customizing Your Display
	Hiding and Displaying Columns
	Re-Ordering the Columns
	Resizing the Columns
	Sorting the Entries in a Form

	Help
	Training and Consulting Services
	Using This Document
	Conventions

	Getting Support


	Blackbaud FundWare System Administration
	System Administration HomePage
	FundWare License and Version Information
	Password Aging
	Disabling the Password Aging Feature

	Logged in Users
	Useful Links

	Viewing File Information
	Maintaining Your Blackbaud FundWare Registration
	Your Organization Information
	Your Registration Information

	System Utilities Tasks
	Processing Error Logs
	Executing Programs

	License and Database Information

	Defining User Security
	What Are Workgroups?
	Administrator Workgroups

	What Are Users?
	Demo User

	What Are Security Levels?
	Changing a User’s Security Level

	Adding Workgroups
	Editing Workgroups
	Business Rules for Editing Workgroups

	Copying Workgroups
	Deleting Workgroups
	Business Rules for Deleting Workgroups


	Adding Users
	Customizing User Security
	Assigning Users to Workgroups
	Assigning Users From the Workgroup Summary
	Assigning a User to Multiple Workgroups

	Editing Users
	Copying Users
	Deleting Users
	Setting Users to “Inactive”

	Viewing the User Summary

	Printing Security Information
	Changing Passwords

	Maintaining Your Divisions
	Adding a Division
	Backing Up a Division
	Restoring a Division
	Deleting a Backup

	Restoring One Division to Another Division
	Copying a Division
	Deleting a Division
	Editing Division Information
	Accessing the Sample Divisions

	Synchronizing Accounts
	Clearing AP Obligation Flags

	Warning and Error Messages
	Error or System Messages-What to Do
	FundWare Warning and Error Messages
	Warning Messages
	Message: “Error Log Exists”

	Error Messages
	Example Warning and Error Messages

	Operating System Error Messages
	Contacting FundWare Support
	Support Agreements
	Completing a Problem/Trouble Report
	Computer System Configuration Data Sheet


	Importing/Exporting GL-P/G Information
	General Instructions for Importing Files
	Importing New or Modified Account Information
	Importing Account Information-Import File Format
	Keyword Record

	Importing Account Information-Import File Field Definitions
	Importing Account Information-Import File Example 1
	Importing Account Information-Import File Example 2
	Importing Account Information-Import File Name
	Importing Account Information-Importing the File
	Importing Account Information-Import File Errors

	Importing Transactions
	Importing Transactions-Import File Format
	Keyword Record

	Importing Transactions-Import File Field Definitions
	Importing Transactions-Import File Example 1
	Importing Transactions-Import File Example 2
	Importing Transactions-GL and P/G Import File Name
	Importing Transactions-Importing the File
	Importing Transactions-Import File Errors
	Avoiding Errors


	Exporting Net Transactions
	Exporting Net Transactions-Export File Name

	Exporting Detail Transactions
	Defining the Export Parameter
	Viewing the Export Parameter
	Exporting Transactions
	Export File Name
	Export File Format

	Displaying the Export Log
	Printing the Export Log


	Importing/Exporting AP Information
	General Instructions for Importing Files
	Importing Obligations
	Importing Obligations-Import File Format
	Keyword Record

	Importing Obligations-Import Field Definitions
	Importing Obligations-Record Type 0
	Example Record Type 0

	Importing Obligations-Record Type 1
	Example Record Type 1

	Importing Obligations-Record Type 2
	Example Record Type 2

	Importing Obligations-Record Type 3
	Example Record Type 3

	Importing Obligations-Record Type 4
	Example Record Type 4

	Importing Obligations-Record Type 5
	Example Record Type 5

	Importing Obligations-Import File Example
	Importing Obligations-Business Rules
	Importing Obligations-Import File Name
	Importing Obligations-Importing the File
	Importing Obligations-Import File Errors
	Importing Obligations-Viewing an Imported Batch
	Importing Obligations-Restoring an Imported Batch
	Importing Obligations-Deleting an Imported Batch

	Importing Vendors
	Importing Vendors-Import File Format
	Keyword Record

	Importing Vendors-Import File Format
	Importing Vendors-Field Definitions
	Importing Vendors-Import File Example
	Importing Vendors-Import File Name
	Importing Vendors-Importing the File
	Importing Vendors-Import File Errors

	Importing Check Reconciliation Files
	Importing Check Reconciliations-Import File Format
	Keyword Record

	Importing Check Reconciliations-Import Field Definitions
	Importing Check Reconciliations-Import File Example
	Importing Check Reconciliations-Import File Name
	Importing Check Reconciliations-Importing the File
	Importing Check Reconciliations-Import File Errors

	Screen Messages for AP Import Tasks
	Report Messages for AP Import Tasks
	Exporting Obligations
	Exporting Obligations-Requirements and Cautions
	Exporting Obligations-Creating the File
	Exporting Obligations-Export File Name


	Importing Payroll Information
	Importing Employee Information
	The Import Format
	Creating the Import Format
	Creating Your Import Text File
	Keyword Record

	Import File Name
	Importing Your Employee Information
	Import File Errors
	Importing the Employee Master Record-What Can You Import?
	Example Employee Master Record Import

	Importing the Employee Direct Deposit File-What Can You Import?
	Example Employee Direct Deposit File

	Importing the Employee History File-What Can You Import?
	Example Employee History Import File
	Employee History Register


	Employee Timesheet File Formats
	Creating the Timesheet Import Format
	Creating Your Import Text File
	Keyword Record

	Example Timesheet Import File
	Import File Name
	Importing Your Employee Timesheets

	Importing Check Reconciliations
	Import File Format
	Keyword Record

	Import Field Definitions
	Import File Example
	Import File Name
	Importing Payroll Reconciliation Files
	Import File Errors
	Filed Report Name

	Import Screen Error Messages
	Report Error Messages

	Importing AR Information (7.40 Customers)
	Before You Import Your Customer Data
	Data Requirements for Customer Imports
	Business Rules for Customer Imports
	Importing Your Customer Data
	Tips for Importing Your Customer Data
	Correcting Errors in Your Customer Data
	Importing Transaction Data
	Before You Import Your Transaction Data
	Data Requirements for Transaction Imports
	Example Transaction Import Setup
	General Setup
	Customers
	Revenue Codes
	Invoices
	Spreadsheets

	Importing Your Transaction Data
	Tips for Importing Your Transaction Data
	Correcting Errors in Your Transaction Data

	Importing/Exporting AR Information (5.8/5.9 Customers)
	The Import Format
	General Instructions for Importing Files
	Importing Customer Records-What Can You Import?
	Importing Customer Records-Creating the Import Format
	Importing Customer Records-Creating Your Import Text File
	Keyword Record

	Importing Customer Records-Import File Example
	Importing Customer Records-Import File Name
	Importing Customer Records-Importing the File
	Importing Customer Records-Import File Errors
	Importing Customer Records-Error Messages

	Import Transactions
	Importing Transactions-Import File Format
	Keyword Record
	Batch Total Record
	Transaction Record

	Importing Transactions-Field Definitions
	Importing Transactions-Import File Example
	Importing Transactions-Import File Name
	Importing Transactions-Importing the File
	Importing Transactions-Import File Errors
	Importing Transactions-Error Messages

	Importing Orders
	Importing Orders-Import File Format
	Keyword Record
	Batch Header Record-Record Type 0
	Order Header Record-Record Type 1
	Order Detail Record-Record Type 2

	Importing Orders-Import File Example
	Importing Orders-Import File Name
	Importing Orders-Importing the File
	Importing Orders-Import File Errors
	Importing Orders-Error Messages

	Importing Meter Transactions
	Importing Meter Transactions-Import File Format
	Keyword Record
	Batch Header Record-Record Type 1
	Meter Reading Record-Record Type 2

	Importing Meter Transactions-Import File Example
	Importing Meter Transactions-Import File Name
	Importing Meter Transactions-Importing the File
	Importing Meter Transactions-Import Report
	Importing Meter Transactions-Import File Errors
	Importing Meter Transactions-Error Messages

	Importing Meter Maintenance
	Importing Meter Maintenance-Requirements and Cautions
	Importing Meter Maintenance-Import File Name
	Importing Meter Maintenance-Import File Format
	Keyword Record
	Meter Records

	Importing Meter Maintenance-Import File Example
	Importing Meter Maintenance-Importing the File
	Importing Meter Transactions-Import Report
	Importing Meter Maintenance-Import File Errors
	Importing Meter Maintenance-Error Messages

	Importing Repetitive Billing
	Importing Repetitive Billing-Requirements and Cautions
	Importing Repetitive Billing-Import File Name
	Importing Repetitive Billing-Import File Format
	Keyword Record
	Repetitive Charge Records

	Importing Repetitive Billing-Import File Example
	Importing Repetitive Billing-Importing the File
	Importing Repetitive Billing-Import Report
	Importing Repetitive Billing-Import File Errors
	Importing Repetitive Billing-Error Messages

	Exporting Allocation Aging
	Exporting Allocation Aging-Requirements and Cautions
	Exporting Allocation Aging-Export File Name
	Exporting Allocation Aging-Exporting the File
	Exporting Allocation Aging-Export File Field Definitions
	Exporting Allocation Aging-Export File Example

	Exporting Customer Records
	Exporting Customer Records-Requirements and Cautions
	Exporting Customer Records-Export File Name
	Exporting Customer Records-Exporting the File
	Exporting Customer Records-Export File Field Definitions
	Exporting Customer Records-Export File Example

	Exporting Customer Meters
	Exporting Customer Meters-Requirements and Cautions
	Exporting Customer Meters-Exporting the File
	Exporting Customer Meters-Export File Name
	Exporting Customer Meters-Field Definitions
	Meter Header Record
	Meter location
	Meter Readings

	Exporting Customer Meters-Export File Example


	Importing CR Information (7.40 Customers)
	Before You Import Your Customer Data
	Data Requirements for Customer Imports
	Business Rules for Customer Imports
	Importing Your Customer Data
	Tips for Importing Your Customer Data
	Correcting Errors in Your Customer Data

	Importing CR Information (5.8/5.9 Customers)
	Importing Customer Records
	Importing Customer Records-Requirements and Cautions
	Importing Customer Records-The Import Format
	Importing Customer Records-Creating the Import Format
	Importing Customer Records-Import File Format
	Keyword Record

	Importing Customer Records-Import File Example
	Importing Customer Records-Import File Name
	Importing Customer Records-Importing the File
	Importing Customer Records-Import File Errors
	Importing Customer Records-Error Messages

	Importing CR Types
	Importing CR Types-Requirements and Cautions
	Importing CR Types-Import File Name
	Importing CR Types-Importing the File
	Importing CR Types-Import File Errors
	Importing CR Types-Error Messages


	Importing Fixed Assets Information
	The Import Format
	Creating the Import Format
	Import File Format
	Keyword Record

	Import Field Definitions
	Import File Example
	Import File Name
	Importing the File
	Error File Name
	Error Messages

	Backup Considerations
	Purge/Save Fiscal Year

	Special Keys in the Classic Edition
	Data Entry Keys
	Function Keys
	Control Key Sequences

	FundWare File Maintenance
	Create Directories
	Search
	Backup Files
	Restore From Backup
	Reorg to the Results Directory
	Create Sequential Files From Microfocus Files
	Rebuilding Files

	Display Options

	Exporting Report Information
	Working With TTY Line Numbers
	The Windows Registry
	Keys and Hives

	Determining Your TTY Number
	Determining Your Station ID
	Setting a TTY Number or Station ID (Server/Client)
	Using Windows Terminal Server or Citrix
	Setting Unique TTY Numbers and Station IDs on Terminal Server

	Import Programs

	Determining Your Station ID
	Print Manager Administrator
	Installing the Print Manager Administrator
	Using the Print Manager Administrator
	Securing the Print Manager Administrator Settings

	Glossary
	Index
	Search the guide

